
Welcome
Welcome
What Is 

PhotoImpact?
Reading this Help

Welcome to PhotoImpact help. In addition to this 
introduction, this document contains these sections to help 
you learn.

Using PhotoImpact Offers instruction on completing single 
tasks. 

Understanding Explains PhotoImpact editing concepts.

Reference Describes menu commands, the workspace, and
dialog boxes. It also has an advice section.

Imaging Essentials Presents valuable background 
information about computer graphics. 

Contacting Ulead How to contact Ulead Systems when you
need advice or have comments.

Imaging Essentials
Overview
Computer graphics
Images
Color

This section contains information about graphics and 
computers, introducing the technology behind this product. 
Most of the topics in this section are longer than those in 
other parts of this help and are intended to help you better 
understand the concepts upon which Ulead programs are 
based.

File Menu
Workspace
Menu commands
Dialog boxes
Advice

The File menu contains these commands. Click below for 
more information.

    New     Acquire commands
    Open     Print Preview



    Restore     Print 
    Close     Send 
    Save     Preferences 
    Save As     Recently Opened Files 
    Place     Exit

Click Menu commands on the left for help on other 
PhotoImpact menus.

Format Menu
Workspace
Menu commands
Dialog boxes
Advice

The Format Menu contains commands for applying filters 
and making other changes. It contains these commands. 
Click below for more information.

    Auto Process     Level 
    Style     Dimensions
    Brightness & Contrast     Resolution
    Color Balance     Frame & Shadow
    Hue & Saturation     Data Type
    Focus     Color Table
    Tone Map     Windows Wallpaper 
    Invert

Click Menu commands on the left for help on other 
PhotoImpact menus.

View Menu
Workspace
Menu commands
Dialog boxes
Advice

The View menu contains these commands for how the 
workspace appears and obtaining information. Click below 
for more information.

    Add a View     Full Screen
    Actual View     Remove Menu Bar
    Zoom In     Photo Properties
    Zoom Out     System Properties
    Fit in Window     Toolbars & Panels 
    Fit in Window by     Ruler

Click Menu commands on the left for help on other 
PhotoImpact menus.

File Menu dialog boxes
Workspace
Menu commands
Dialog boxes
Advice

    New     Acquire:Select Source
    Open     Print Preview
    Save     Print
    Save As     Send
    Place     Preferences
    Acquire:Acquire Image

Click Dialog boxes on the left for help on other PhotoImpact
dialog boxes.



Advice
Workspace
Menu commands
Dialog boxes
Advice

Here are tips, techniques, and other tidbits to help you 
understand and use PhotoImpact better.

    Switching tools 
    Drag and drop editing 
    Quick zooming 
    Who needs the standard menus? 
    Quick cropping 
    Creating a grayscale mask from a color image 
      Why Group Objects?   
      Dimensions or Resolution...You decide   
      Choosing the right resolution   
      Why calibrate my display?   
      Why manage memory?   
      Why convert data types?   

General
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

      Creating a new image   
    Opening images 
    Changing modes 
    Dragging and Dropping  
    Obtaining information
    Repeating actions on multiple images 
      Using the clipboard   
      Deleting data   
      Copying   
    Cropping an image 
      Duplicating   
      Recovering from mistakes   
    Printing 
    Quitting PhotoImpact 

File management
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing

    Opening images 
      Finding files   
      Saving images   
      Converting images   
      Converting to CMYK   
    Converting from CMYK 
    Changing the desktop wallpaper 



File management
Configuring

           Standard toolbar  
Attribute toolbars (Click below)
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           Tool panel   
    Color panel
    

 
.                

    Global Viewer
    Status bar
    Quick Command panel



Reading this Help
Welcome
What Is 

PhotoImpact?
Reading this    Help

This help contains several aids to make navigating through 
topics easier.

Jumps to the shown topic.

Pops up extra information to enhance understanding.

Jumps to a topic describing the listed nested dialog box.

Pops up tips or advice to help you work more efficiently.

Returns you to the top of a page after scrolling in a main 
window.

Jumps down in the same topic to related information.

What is PhotoImpact?
Welcome
What Is 

PhotoImpact?
Reading this Help

PhotoImpact is a versatile object-oriented image editing 
program that is easy and fun to use. Until you accept a 
change, each one you make is preserved as an independent
item (object) that you can further modify without affecting 
any other part of the image. This offers better control of your
finished project because you can decide at any time when to
accept changes.

PhotoImpact offers a variety of special effects and other 
intuitive tools to make editing easier. A fun collection of 
special filters with real-world descriptions of how they work 
makes putting the finishing touch on your project a one-two-
three process. When you have found a setting you 
particularly like, the customizable "My Gallery" allows you to 
save it for future use on other images.

Edit and View Menu dialog boxes
Workspace
Menu commands
Dialog boxes
Advice

Edit Menu
    Fill
    Stitch

View Menu
    Photo Properties 
    System Properties
    Toolbars & Panels

Click Dialog boxes on the left for help on other PhotoImpact 
dialog boxes.

Format Menu dialog boxes
Workspace     Auto Process:Batch     Level 



Menu commands
Dialog boxes
Advice

    Style     Dimensions
    Brightness & Contrast     Resolution
    Color Balance     Frame & Shadow
    Hue & Saturation     Data Type
    Focus     Color Table 
    Tone Map 

Click Dialog boxes on the left for help on other PhotoImpact
dialog boxes.

Effect Menu dialog boxes
Workspace
Menu commands
Dialog boxes
Advice

    Blur & Sharpen submenu 
    Noise submenu 
    Camera Lens submenu 
    2D submenu 
    3D submenu
    Natural Painting submenu 
    Special submenu
    Warping
    Custom Filter 
    Custom Effect

Click Dialog boxes on the left for help on other PhotoImpact
dialog boxes.

    Average 
    Blur 
    Emphasize Edges 
    Gaussian Blur 
    Sharpen 
    Unsharp Mask 



    Add Noise 



    Cool 
    Facet 
    Warm 
    Mosaic 
    Motion Blur 
    Fat 
    Thin 



    Ripple 
    Whirlpool 



    Pinch 
    Punch 
    Sphere 



    Watercolor 



    Emboss
    Puzzle 
    Tile 
    Wind 
    Blast 
    Stagger 



    Convert to Black & White 
    Convert to Grayscale 
    Convert to Indexed 16-Color 
    Convert to Indexed 256-Color
    Combine CMYK Channels to True Color



Edit Menu
Workspace
Menu commands
Dialog boxes
Advice

The Edit menu contains these commands. Click below for 
more information.

    Undo Before     Crop    
    Redo To     Duplicate commands 
    Clear Undo/Redo Hist.     Fill
    Cut       Rotate/Flip commands  
    Copy       Select commands  
    Paste commands     Object commands
    Clear     Stitch 
    Clipboard commands 

Click Menu commands on the left for help on other 
PhotoImpact menus.

Effect Menu
Workspace
Menu commands
Dialog boxes
Advice

The Effect menu contains commands for changing and 
distorting images. Click below for more information.

    All     Special
    Blur & Sharpen     Video
    Noise     Warping 
    Camera Lens     Custom Filter
    2D     Custom Effect
    3D       Paint on Edges   
    Natural Painting

Click Menu commands on the left for help on other 
PhotoImpact menus.

Window Menu
Workspace
Menu commands
Dialog boxes
Advice

The Window menu contains commands for arranging the 
workspace and desktop. Click below for more information.

    Cascade
    Tile Horizontally
    Tile Vertically 
    Arrange Icons 
    Batch Manager
    Tile with Album 
    Tile EasyPalette
    PhotoImpact Explorer 
    PhotoImpact CD Browser 
    Currently Open Images

Click Menu commands on the left for help on other 
PhotoImpact menus.

    File Menu
    Edit Menu 



    View Menu 
    Format Menu 
    Effect Menu 
    Nested (A - M)
    Nested (N - Z)



Nested dialog boxes (A - M )
Workspace
Menu commands
Dialog boxes
Advice

    Add Shadow 
    Add to My Gallery     Eyedropper    
    Batch Manager
    BMP Save Options       Group Properties  
    Border
    Browse     Insert into Album
    Color     JPEG Save Options
      Create Group      Layout Options 
    EasyPalette Description     Magic Texture
    Effects Visual Sample     Modify

Click Dialog boxes on the left for help on other PhotoImpact
dialog boxes.

Nested dialog boxes (N - Z )
Workspace
Menu commands
Dialog boxes
Advice

    New Album       Similar  
    Obj. Lib. Properties     Soften
      Object Properties        Text Entry  
    Photo CD       Texture Library  
    PIC Open Options     TGA Save Options
    PNG Save Options     Thumbnail
    Preview     TIF Save Options
    Printer Options     Title
    PSD Save Options     UFO Save Options
      Quick Samples      Ulead Color Picker 

Click Dialog boxes on the left for help on other PhotoImpact
dialog boxes.

Configuring
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Setting PhotoImpact defaults 
    Adding third party plug-ins 
      Showing and hiding the ruler   
      Placing the toolbars   
      Arranging the workspace   
      Managing memory   
      Calibrating the display   
      Changing the desktop wallpaper   



Enhancing
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Applying filters and effects 
      Editing by eye   
      Adjusting color on-screen   
      Stylizing your images   
      Basing one image on another   
      Fixing the color balance   
      Using the true color spectrum most effectively   
      Changing indexed image colors   

Objects
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Creating objects 
      Creating a grayscale mask   
      Moving objects   
      Managing objects basics   
      Editing objects   
      Grouping and ungrouping objects   
      Hiding and showing objects   
      Finding objects   
      Creating smooth edges for blending   
    Merging objects to the base image 
      Object Library basics   
      Adding images to the Object Library   
      Adding selections to the Object Library   
      Placing objects from the Object Library into images   

Selections
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Rectangular and elliptical selections 
      Freehand selections   
      Selecting by color   
    Precision selecting 
      Moving a selection   
    Creating a grayscale mask 



Object & Layer Manager Menu
Workspace
Menu commands
Dialog boxes
Advice

Access the Object menu by right clicking on an object or 
clicking the menu button for the Layer Manager in the 
EasyPalette. 

    Sort by Depth     Duplicate
    Sort by Name     Copy to Object Library
    Sort by Group     Group
    Edit Text     Ungroup
    Undo     Delete
    Select Base Image     Add Shadow
    Select Prev. Selection     Revert
    Merge     Properties
    Merge All

Click Menu commands on the left for help on other 
PhotoImpact menus.

Sort by Depth Duplicate
Sort by Name Copy to Object Library
Sort by Group Group
Edit Text Ungroup
Undo Delete
Select Base Image Add Shadow
Select Prev. Selection Revert
Merge Properties
Merge All



Viewing
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

      Zooming in or out   
    Finding part of an image 
    Finding objects 
    Hiding and showing objects 
    Obtaining information 

Transforming
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

      Transforming images   
      Straightening images   
    Reshaping images 
    Instant rotating and flipping 
    Rotating with the mouse 
    Rotating by degree 
    Curving text 
    Resizing images 

Adding
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Adding borders 
      Creating a border on a selection   
      Creating frames and shadows   
      Color fills   
      Pattern fills   
    Adding text  
      Merging objects to the base image   
      Joining two images   
      Creating smooth edges for blending   
      Blending images   
      Adding images to the Object Library   
      Adding third party plug-ins   



EasyPalette
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    EasyPalette basics 
      Object Library basics   
      Managing objects basics   
      Placing objects in the Object Library into images   
      Adding images to the Object Library   
      Adding selections to the Object Library   
    Modifying "My Gallery." 
      Finding objects   

Quick
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Six steps to sensational images 
    Automatic fixes 
      Adjusting color on-screen   
      Editing by eye   
      Replacing the base image   
      Instant rotating and flipping   

Painting
General
Quick
Selections
Objects
Painting
Adding
Enhancing
Transforming
EasyPalette
Viewing
File management
Configuring

    Painting 
      Cloning   
      Painting an effect   
      Painting as an object  



Object Library Menu
Workspace
Menu commands
Dialog boxes
Advice

The Object Library Menu contains these commands. Click 
below for more information.

    Create Group 
    Delete Group 
    Import Group 
    Delete Object 
    Properties 
      Read Only (For Sharing)   
    Copy Object to Image
      Store Image   
      Store Selection   
      Store Image as Selection  
    Drag-and-Drop in PhotoImpact Only 

Click Menu commands on the left for help on other 
PhotoImpact menus.

Create Group 
Delete Group 
Import Group 
Delete Object 
Object Information 
Set as Read Only for Sharing 
Store Image 
Store Mask 
Store Image as Mask 



EasyPalette Menu
Workspace
Menu commands
Dialog boxes
Advice

The EasyPalette menu may show some or all of the 
following commands when a gallery is selected.

    Apply
    Modify Properties and Apply
    Properties
    Description
    Use Image as Thumbnail
    Reset Thumbnails
    Delete Thumbnails

Click Menu commands on the left for help on other 
PhotoImpact menus.

Other
Workspace
Menu commands
Dialog boxes
Advice

    Quick Command Menu
Click the top left corner of the Quick Command Panel to 
access the Quick Command Menu.

    Color Picker
Right click on color squares in the color panel, selected 
dialog boxes, and attribute panels to change the currently 
selected colors.
Click Menu commands on the left for help on other 
PhotoImpact menus.

    Instant rotating and flipping 
    Straightening images 
    Rotating with the mouse 
    Rotating by degree 



Batch Manager
Allows you to select several open images and apply the 
same command to all of them. This saves you the trouble of 
activating each individually and repeating a command. 
Some commands you can perform are "Close", "Close 
Quickly", "Minimize", "Print", "Resolution", "Select", "Save", 
and "Save to Album".

Repeating actions on multiple items

Blur & Sharpen
Shows a submenu offering filters that blur or sharpen 
images.

Applying Filters

Average
Softens the image by comparing all pixels in the selected 
area and changing their values to make them more similar.

Applying Filters

Blur
Makes an image appear out of focus.

Applying Filters

Emphasize Edges
Increases the contrast between adjacent pixels in the image.
This makes edges or borders appear more distinct.

Applying Filters

Find Edges
Finds sections in the image where adjacent pixels are very 
different and creates outlines in those areas.

Applying Filters

Gaussian Blur
Blurs an image based upon the number of pixels containing 
similar values.

Applying Filters



Sharpen
Makes an image area appear more crisp.

Applying Filters

Noise
Shows a submenu offering filters that add or remove 
patterns from images.

Applying Filters

Camera Lens
Shows a submenu offering filters similar to those produced 
by special camera lenses. 

Applying Filters

2D
Shows a submenu offering filters that distort images in two 
dimensions.

Applying Filters

3D
Shows a submenu offering filters that appear to distort 
images in three dimensions.

Applying Filters

Natural Painting
Shows a submenu offering filters that produce effects as if 
images were hand drawn or painted.

Applying Filters

Special
Shows a submenu offering miscellaneous filters.

Applying Filters

Add Noise



Produces a speckled effect in the image.

Applying Filters

Despeckle
"Cleans" the image if it seems to have randomly distributed 
dots in it.

Applying Filters

Remove Moiré
Smoothes the image if it contains patterns due to dithering 
or scanning from printed material such as newspapers or 
magazines.

Applying Filters

Cool / Warm
Cool applies a blue or cyan tint to the image.
Warm applies a red or yellow tint to the image.

Applying Filters

Facet
Creates an effect of viewing the image through cut glass.

Applying Filters

Mosaic
Breaks the image into tiles and uses the average color value
for the pixels in each tile for all pixels in that tile.

Applying Filters

Motion Blur
Makes the image appear out of focus due to camera or 
subject motion.

Applying Filters

Fat / Thin
Fat stretches the center of the image towards the 

left and right edges, squeezing the outer area.



Thin stretches the left and right edges of the image
towards the middle, squeezing the inner area.

Applying Filters

Ripple
Produces an effect so that the image appears to be under a 
stream of water.

Applying Filters

Whirlpool
Swirls the image into a whirlpool pattern

Applying Filters

Pinch / Punch
Pinch squeezes the corners of the image towards 

the center.
Punch expands the center of the image towards 

the corners. 

Applying Filters

Sphere
Produces an effect as if the image were placed upon the 
surface of a sphere.

Applying Filters

Watercolor
Makes the image appear as if it were painted using 
watercolors.

Applying Filters

Emboss
Makes the image appear as if it were stamped or imprinted 
on a solid surface.

Applying Filters

Puzzle



Breaks the image into tiles with borders. Each tile is 
repositioned to make the image appear like an unsolved 
slide-puzzle. (PhotoImpact uses the current background 
color for the borders.)

Applying Filters

Tile
Breaks the image into square tiles with background colored 
borders. You may choose to separate the squares,    creating
an appearance of the image breaking apart.

Applying Filters

Wind / Blast / Stagger
These three filter commands produce a wind-blown effect.

Wind creates an effect similar to that of a strong 
wind blowing the image. Wind trails gradually fade away.

Blast creates an effect of a stronger wind. Wind 
trails do not fade away.

Stagger distorts the image horizontally, shifting 
pixels alternately to the right or left. This is similar to the 
effect of viewing something through rising heat waves.

Applying Filters

Warping
Places a grid over the image allowing you to create custom 
and localized distortions on parts of an image leaving other 
areas unchanged.

Applying Filters

Custom Filter
Allows you to create your own unique filters that work by 
adjusting pixel values relative to neighboring pixels. 
Examples of the types of filters you can create are blur and 
sharpen. The Custom Filter dialog box offers you hints on 
how to get started designing the filter you want.

Applying Filters

Custom Effect
Allows you to create your own unique effects that work by 
adjusting pixel positions. Examples of the types of effects 
you can create are Sphere and Ripple. The Custom Effect 
dialog box offers you hints on how to get started designing 



the effect you want.

Warps and distorts an image by changing the relative 
position of pixels.

Applying Filters
Understanding Pixel Mapping 

Video
Corrects the colors in the image so that they are within the 
acceptable range for displaying on standard video or 
television screens.

Adjust for NTSC This is the standard for the 
United States.

Adjust for PAL This is the standard for much of 
Europe and the Commonwealth.

Windows Wallpaper
Shows a submenu where you may choose to tile or center 
the current image as the standard Windows wallpaper for 
your system. 

Tile places duplicate copies of the image side-by-
side until the entire desktop is filled.

Center places the image in the center of the 
windows desktop.

Changing the desktop wallpaper

Auto-Process
Shows a submenu allowing you to automatically adjust the 
brightness, contrast, and focus of an image, or crop or 
straighten it based on current characteristics. 

The last submenu command, "Batch," accesses the Auto-
Process dialog box where you may combine the above 
adjustments plus two more, (Remove Moiré and Color 
Balance) into one step.
(Hot Key for Auto-Process:Brightness -- F9)

Automatic fixes

Auto-Process/Batch    
Opens the Auto-Process dialog box for specifying which of 
seven automatic adjustments to make to an image. How 
these adjustments affect the outcome depends in part on 
the order in which you select them. The adjustments offered 
in the Auto Adjust dialog box are:

    Straighten     Brightness 
    Crop     Contrast



    Remove Moiré     Balance
    Focus

Automatic fixes

Brightness & Contrast    
Allows you to fine tune the brightness and contrast in an 
image. The Brightness and Contrast dialog box offers visual 
and slider controls for fine tuning the image to perfection.
(Hot Key -- Ctrl+B)

Applying filters and effects 

Hue & Saturation
Allows you to adjust shift the colors in an image. Changing 
the hue affects color. Changing the saturation makes the 
colors more intense or washed out.

Applying Filters

Style
Opens a dialog box with two tabs:

Predefined Allows you to choose from a list of 
preset tints or create your own to create a mood. Some 
examples for using this include making a gray sky blue or 
enriching the green in a grassy field.

Custom Changes the color or shading of an image
according to the characteristics of another. The main reason
for doing this is to make two similar images appear more 
consistent to each other. But it can also produce some wild 
effects when the reference image is very different from the 
current one. (For example try a very dark reference image 
for a brightly colored image.)

Stylizing your images 
 Basing one image on another 

Focus
Allows you to make the image appear sharper or more 
blurry.
(Hot Key -- F7)

Applying Filters

Tone Map
Allows you to adjust the colors in an image based on the 
current distribution of colors in the image. 



Highlight Midtone Shadow Expand or compress 
the range of colors in the image. 

Map Create a custom shift in the color distribution. 
For example, you may want to map all the lighter and darker
colors in the image to light shades, and map the mid-tones 
to dark shades to create a unique effect.
(Hot Key -- F8)

Using the true color spectrum most effectively
Understanding color mapping 

Invert
Changes the image to display each pixel's complimentary 
color. This is similar to what you might see when looking at a
photograph negative.

Level
Allows you to change the number of color divisions for the 
image. This may be useful for trying to create a Pop-Art like 
appearance from a true color image.

Applying Filters

Dimensions
Resizes an image by changing the total number of pixels.

Note: Resizing using this command changes image 
information. When reducing size, data is discarded and the 
file shrinks in size. When enlarging, new information is 
added and the file size increases. Another way of changing 
image size that does not change data or file size is the 
Resolution command.
(Hot Key -- Ctrl+G)

Resizing images

Resolution
Changes the physical size of an image. Increasing 
resolution makes the image smaller; reducing makes it 
larger.

Notes: 
Changing the resolution does not affect file size.
The results of using this command are not immediately 
apparent on screen. You will see them when you print the 
image or display it in another program.

Resizing images



Frame & Shadow    
Allows you to add a frame, shadow, and background to the 
image. You can also use this command to make an image 
bigger changing existing base image data.

 Creating Frames and Shadows 

Data Type    
Shows a submenu for changing the selected image to a 
different data type. Depending on the current image format, 
you may convert to any of the following data types:

    Black and White     Indexed 256-Color
    Grayscale     True Color
    Indexed 16-Color     CMYK

 Converting images 

Black & White
Converts the selected image to black and white.

 Converting images 

Grayscale
Converts the selected image to grayscale.

 Converting images 

Indexed 16-Color
Converts the selected image to indexed 16-Color. Selecting 
"Optimized Indexed 16-Color" bypasses the Convert to 16-
Color dialog box, automatically selecting an optimized 
palette with no dithering.

 Converting images 

Indexed 256-Color
Converts the selected image to indexed 256-Color. 

Optimized Indexed 256-Color Bypasses the 
Convert to 256-Color dialog box, automatically selecting an 
optimized palette with no dithering.

WWW Browser Optimized Bypasses the Convert 
to 256-Color dialog box, automatically selecting the standard
6-6-6 palette with dithering.

 Converting images 



True Color
Converts the selected image to True Color.

 Converting images 

Create a New Image
When checked, creates a new window containing a new 
image from the converted one. When unchecked, the 
converted image replaces the original.

Split to CMYK
Creates four grayscale images from the current image, one 
for each channel in the CMYK color model. This is useful for 
preparing completed images for post-process printing. To 
distinguish images, PhotoImpact names each new image 
with the original image name and adds a code identifying 
which color channel it represents.

Note: This command is only available when the selected 
image is a True Color image.

 Converting to CMYK 

Combine from CMYK
Combines four grayscale images, one for each CMYK color 
channel, to create a True Color Image.

 Converting from CMYK 

None
Deselects all selected areas in the image.

 Creating objects 

All
Selects the entire image.

 Creating objects 

Invert
Selects all unselected areas while deselecting all selected 
areas in the image.



 Creating objects 

Border
Creates a border around the current selected area and 
makes it the new selected area.

 Creating objects 
 Creating a border 

Similar
Selects other pixels whose values fall within a range of 
those already selected. Depending on the Similar dialog box
settings, this can extend to the entire image or only adjacent
pixels.

 Creating objects 
 Selecting by color 

Soften
Gradually fades the edges around a selection enabling it to 
blend more smoothly with the background.

 Blending images 

Convert to Object
Creates an new object from the current selection.

 Creating objects 

Load Selection
Allows you to use a grayscale image as the basis for 
creating a selected area. As the shades of gray in the mask 
approach black, the mask becomes less transparent.

 Creating a grayscale mask 

Save Selection
Saves a selection as a grayscale image for use as a mask.

 Creating a grayscale mask 

Delete
Removes the selected object from the image.



 Managing objects basics 

Group
Combines all selected objects so that they behave as a 
single one. That way you can move them or apply the same 
command to all of them at one time.

Grouping and ungrouping objects 

Ungroup
Separates a previously grouped set of objects back into 
individual objects.

Grouping and ungrouping objects 

Add Shadow
Creates a new object shadowing the selected object. 
PhotoImpact automatically groups the two objects together 
so if you change one the other is also affected.

 Creating Frames and Shadows 

Merge
Merge makes the selected object part of the base 

image.
Merge All makes all objects in the image part of 

the base image.

 Merging objects to the base image 

Revert
Returns the object to the condition it was in when you first 
created it.

 Creating objects 

Standard toolbar
Workspace
Menu commands
Dialog boxes
Advice



The Standard toolbar contains frequently needed 
commands and tools to make working with PhotoImpact 
faster and easier. You may dock it along any edge of the 
PhotoImpact workspace, or drag it anywhere on your 
desktop as a floating toolbar. Click above to find out more 
about each button.

Tool panel
Workspace
Menu commands
Dialog boxes
Advice

The Tool Panel provides all the editing tools you need to 
work on images. By selecting the right tool, you achieve 
better control for selecting, drawing, transforming, and 
touching up images. Each tool has its own Attribute toolbar 
Click above for more information about each tool and its 
Attribute toolbar.

Note: You can only select one tool at a time.

           Switching tools   
Creating objects 

Magic Wand tool
Workspace
Menu commands
Dialog boxes
Advice

The Magic Wand tool allows you to instantly select areas 
based upon color. The Attribute toolbar contains tools for 
determining how to create the selection area and how to 
manipulate selections once created. Click below to learn 
more about each item in the magic wand Attribute toolbar.

Note: As soon as you make a change to a selection, it 
becomes an object.

Creating objects

Lasso tool
Workspace
Menu commands
Dialog boxes
Advice

The Lasso tool allows you to create freehand selections. 
The Attribute toolbar contains tools for determining how to 
create the selection area and how to manipulate selections 
once created. Click below to learn more about each item in 
the lasso Attribute toolbar.

Note: As soon as you make a change to a selection, it 
becomes an object.



 

Creating objects

Standard Selection tool
Workspace
Menu commands
Dialog boxes
Advice

The Standard Selection tool allows you to create rectangular
or elliptical selections. The Attribute toolbar contains tools 
for determining how to create the selection area and how to 
manipulate selections once created. Click below to learn 
more about each item in the shape Attribute toolbar.

Note: As soon as you make a change to a selection, it 
becomes an object.

 

Creating objects

Mask Brush tool
Workspace
Menu commands
Dialog boxes
Advice

The Mask Brush tool allows you to fine tune your selections 
by enabling you to "paint" the selection. When you choose 
this tool, all unselected portions of the image are covered by
a transparent tint. By "painting" over the image, you can add
to or remove from the selection. Click below to learn more 
about each item in the mask brush Attribute toolbar.

Note: This tool is only available for grayscale and true color 
images.

Precision selecting

Eyedropper tool
Workspace
Menu commands
Dialog boxes
Advice

The Eyedropper tool allows you to select drawing colors 
visually by clicking on a color in an open image. The 
Attribute toolbar contains eight color squares that you may 



assign colors to. The color square with a border around it is 
the one that will be changed when you click on a color in the
image. It will also be the color for the brush when you 
activate a painting tool. Click below to learn more about 
each item in the eyedropper Attribute toolbar.

Zoom tool
Workspace
Menu commands
Dialog boxes
Advice

The Zoom tool allows you to change the magnification for 
the active image. Click below to learn more about each item 
in the Zoom Attribute toolbar.

Quick Zooming
           Zooming in or out   

Transform tool
Workspace
Menu commands
Dialog boxes
Advice

The Transform tool allows you to resize, rotate, and deform 
images. The Attribute toolbar contains several items to help 
control the way you change the image dimensions. Click 
below to learn more about each item in the Reshape 
Attribute toolbar.      

Rotating 
Reshaping images 

Retouch tool
Workspace
Menu commands
Dialog boxes
Advice

The Retouch tool has five modes that enable you to add 
quick finishing touches to images. Clicking the lower right 
corner of a tool button reveals these choices:

    Dodge     Burn     Blur
    Sharpen      Smudge

Click above or scroll down to learn more about each item.
    Dodge



Makes the pixels brighter. Use this to put a glint in 
someone's eyes, give someone a brighter, whiter, smile, or 
enhance an image against a dark background.

    Burn

Makes pixels darker. Use this to create make pale colors 
darker or add depth to an image.

    Blur

Reduces the contrast between pixels. Use this to make 
edges blend into each other more smoothly.

    Sharpen

Enhances dissimilar pixels. Use this to make edges stand 
out.

    Smudge

Makes the image appear less sharp. This is similar to what 
would happen if you rubbed your moistened finger over a 
pencil drawing. Use this to produce a softer feeling.

Paint tool
Workspace
Menu commands
Dialog boxes
Advice

The Paint tool consists of six tools for adding colored lines 
and shapes to images. The Attribute toolbar contains 
controls for changing brush size, color density, and how to 
draw the shapes. Click below to learn more about each tool 
and the paint tool Attribute toolbar.

    Brush     Airbrush     Crayon      
    Charcoal     Chalk     Highlight Marker      

    Brush

This is the standard painting tool. It applies color to images 
much as if it were painted with a paintbrush.

    Airbrush
Applies color as if an airbrush was used. Move the brush 



across the image quickly to apply a more dispersed and 
thinner layer. Move slowly to apply a thick, heavy coat.

    Crayon
Applies color as if it were drawn with a wax crayon. By 
changing the pressure, distribution, and spacing settings, 
you can make the crayon lighter or darker and affect how 
transparent it is.
Note: You cannot use the color white with the crayon tool. 
Also, the crayon tool cannot draw on a black background.

    Charcoal
Applies color as if it were drawn using charcoal. By 
changing the pressure, distribution, and spacing settings, 
you can make the effect lighter or darker and affect the 
density of the pixels.

    Chalk
Applies color as if it were drawn using chalk. By changing 
the pressure, distribution, and spacing settings, you can 
make the effect lighter or darker and affect the density of the
pixels.
Note: You cannot use the color white with the chalk tool. 
Also, the chalk tool cannot draw on a black background.

    Highlight Marker
Applies color as if it were drawn using a highlight marker. By
changing the pressure, distribution, and spacing settings, 
you can make the marker lighter or darker and affect how 
transparent it is.
Note: You cannot use the color white with the highlight 
marker tool. Also, the highlight marker cannot draw on a 
black background.

Clone tool
Workspace



Menu commands
Dialog boxes
Advice

The Clone allows you to use one part of an image as a 
reference for painting into another image or another location
of the same image. Click below to learn more about the tool 
and its Attribute toolbar.

Text tool
Workspace
Menu commands
Dialog boxes
Advice

The Text tool allows you to create blocks of text to insert into
an image. Click below to learn about each item in the Text 
Attribute toolbar.

Color panel
Workspace
Menu commands
Dialog boxes
Advice

The color panel consists of three sections to let you select 
paintbrush colors, the background color, and make quick 
color, brightness, and contrast adjustments to selected 
areas. Click on the left for more details.

Status bar



Workspace
Menu commands
Dialog boxes
Advice

Depending on the mouse location in the PhotoImpact 
workspace, the Status bar offers different information. Some
examples of what you might see in it are the x and y 
positions of the mouse in the active image, brief descriptions
of menu commands and workspace items, and the status of 
a task. The right side of the Status bar has icons for 
converting data types and changing the standard unit of 
measurement in PhotoImpact. Click on the Status bar above
to learn more about each item in the Status bar.

Global Viewer
Workspace
Menu commands
Dialog boxes
Advice

The Global Viewer allows you to quickly find a spot in an 
image that is bigger than the window displaying it. It 
becomes available when the displayed image is larger than 
its window. To activate the Global Viewer, click on its icon in 
the bottom right corner of the active window. By dragging 
the global viewer frame about the miniature image, you shift 
the focus of the main window.

Click Workspace on the left for help on other workspace 
items.

Eraser tool
Workspace
Menu commands
Dialog boxes
Advice

The Eraser tool offers two ways to erase parts of an image. 
Scroll down or click below to find out more about each 
eraser type and its associated Attribute toolbar.

    Standard Eraser        Color Eraser 
    Standard Eraser

Erases everything under the pointer as you drag it over the 
image, replacing the erased information with the color 
shown in the Attribute toolbar.

    Color Eraser
Erases all colors that are within the range of selected colors 
in the Attribute toolbar as you drag the mouse over the 
image, replacing the erased data with the shown 



replacement color. Any colors in the image outside the range
of selected colors for erasing are untouched.



Color Similarity

Determines the range of colors to include in the selection or 
fill. For example, if you set the similarity to 32, and click on a
pixel with a value of 128,0,128 (dark magenta), all pixels 
with values in the range of    96,0,96 to 160,32,160 will be 
included in the resulting selection or fill. 

Note: PhotoImpact discards values below 0 or above 255.

Select by:
Line Select similar colors to those you drag the 

mouse over in the image and the Similarity value setting in 
the Attribute toolbar.

Closed Area Select colors based on similarity to all
pixels enclosed by the shape created when dragging the 
mouse over the image and the Similarity value setting in the 
Attribute toolbar.

Selection Options
Draw from Center Check to create a selection 

area starting at the center and moving out. (Only available 
for the Standard Selection tool.) Clear to create a selection 
from a corner.

Preserve Base Image Check to leave the base 
image unchanged when moving the selection. Clear to 
replace the space vacated when moving a selection with the
background color.

Anti-aliasing Check to smooth out the edges of a 
moved selection or object.

Move Selection Marquee Check to move the 
selection shape without any image data.

Select Mode

Determines what happens to the selection area when you 
drag or click the mouse over the base image.

New Creates a new selection area.
Add Adds to the current selection area.
Subtract Removes part of the current selection 

area.

Anti-Alias

Smoothes the edges of a selection or object.

Select Icons

The Select icons are only available when no objects are 
selected.

Select All creates a selection area out of the entire
image.

Select None deselects any currently selected 
areas in the image.



Select Invert selects all unselected areas while 
deselecting all selected areas in the image.

Object Icons

The Object icons are only available when the selection 
consists of objects

Up moves the selected object closer to the top 
level by one increment. 

Down moves the selected object closer to the 
bottom level by one increment.

Top moves the selected object to the top level.
Bottom moves the selected object to the bottom 

level. 

Snap to Edges and Sensitivity

Check to have PhotoImpact help you trace the edge of a 
selection by finding differences in pixel color    values.    Set 
the sensitivity to determine how far from the mouse position 
PhotoImpact looks for an edge. A high setting gives 
PhotoImpact more freedom to create the best selection 
area.

Shape
Rectangle Creates a rectangular selection area.
Square Creates a square selection area.
Ellipse Creates an oval selection area.
Circle Creates a circular selection area.

Start from
Pressed Creates the selection area starting from 

the center.
Up Creates the selection area starting at a corner.

Equal Sides
Pressed Creates a perfect square or circular 

selection.
Up Creates rectangular or oval selection areas.

Fixed Size
Check to create selection areas of predefined sizes

as defined by the entry boxes to the right of the check box. 
Clear to drag your mouse to create a selection 

area.

Fixed Size width

Defines the width of a fixed size selection.



Fixed Size height

Defines the height of a fixed size selection.

Colors

Currently assigned brush colors. The block with a border 
shows the currently selected brush. Click a square to select 
its color. Right click on it to access the Color Picker menu to 
change the color. You may also click anywhere in the current
palette to select a new color for the selected block

Note: With the Eyedropper tool active, you may also click on
a color in an image change the current block's color.

RGB Values

The RGB values for the pixel that the mouse is over.

HSB Values

The HSB values for the pixel that the mouse is over.

View Options
Actual View Restores the image to 1x view. (Only 

available if the entire image will fit in a window at 1x.)
Fit in Window Resizes the window so that it is 

exactly the right size for the current image magnification. 
(Only available if the entire image can fit in a window at the 
current magnification,)

Zoom Level

Move the slider to select the desired magnification for the 
image.

Resize

Drag the control points around the selected area or object to
resize it. Press the Shift key to maintain length and height 
relationship while resizing.

Slant

Drag the control points at the corners of the selected area or
object to horizontally or vertically reshape the image.

Distort

Drag the control points at the corners of the selected area or
object to distort the image.



Perspective

Drag the control points at the corners of the selected area or
object to distort make the image appear as if it is coming out
of or going into the image.

Rotate to Line

Drag the ends of the a control line along a strong horizontal 
or vertical feature in the image to define a horizontal or 
vertical    plane. Double-click    on either end of the control 
line to rotate the image.

Horizontal Uses the line as the basis for the 
horizontal plane.

Vertical Uses the line as the basis for the vertical 
plane.

Rotate Freely

Drag the control points around the image until the desired 
rotation is achieved.

Rotate by Degree

Rotate the image by a set value. Enter the degree of rotation
in the entry box and then click one of the buttons:

Right By Rotates the image clockwise by the 
specified amount.

Left By Rotates the image counterclockwise by the
specified amount.

Brush Size

Determines the size of the paintbrush, (in pixels), for 
painting colors or effects.

Brush Shape

Allows you to choose the shape for the brush you use to 
paint colors or effects. These shapes are available:

    Square     Circle
    Horizontal Line     Vertical Line
    Left Diagonal     Right Diagonal

Note: You cannot change brush shapes for the Crayon, 
Charcoal, and Chalk tools.

Level Slider

Determines the strength of the applied effect. A level of one 
means the effect is small. A level of five means the stroke 
never fades out.

Transparency

Determines how much of the underlying image should 



appear through colors you paint. A setting of zero means the
color is solid, a level of 99 is the same as making the color 
completely clear.

Spacing

Sets the distance (as a percentage of the brush size 
diameter) between the centers of each brush stroke painted 
onto the image. As the percentage increases, each stroke is 
further apart.

Soft Edge

Controls how drawn edges blend into the background. A 
setting of 0 has no affect. Increasing the setting makes the 
edges blend more smoothly into the background.

Line Options
Freehand Allows you to paint freely onto the 

image.
Straight Lines Paints a straight line onto the 

image. Press the Shift key to restrict line directions to 
0,45,90,135,180,225,270,and 315 degrees.

Connected Lines Allows you to paint a sequence 
of connected lines. Double-click when you are finished 
drawing to close the shape. (Closing the shape does not fill 
it.)

Add

Adds the current tool settings to the My Gallery. Later, by 
dragging it from the My Gallery to an image, you instantly 
recall the tool and its settings.

Eraser Color

Determines the color that replaces anything you erase. Click
it to access the Ulead Color Picker; right click for the Color 
Picker menu.

Font and Size

Determines which font and what size to apply to the image.

Style

Shows a submenu for choosing how to align the text, any 
character enhancements, (such as bold or italics), and 
whether to anti-alias the text.

Path

Allows you to edit vector paths created by the Text tool.



Note: This is a better way to reshape text than using the 
reshaping tools. The reshaping tools alter data and cause a 
text object to lose its identity with the font. Using the Text 
Path tool, you may come back and edit the text as long as it 
has not been merged.

Mode
Object Fills the text and adds the text item to the 

Layer Manager.
Path Creates an outline of the text that you can 

reshape with the Text tool.
Selection Creates a selection area of the text.

Note: As long as you don't merge a text object to the base 
image, you may come back to edit it as text.

Text Color

Sets the color for the text. Click it to access the Ulead Color 
Picker; right click for the Color picker menu

EasyPalette
Workspace
Menu commands
Dialog boxes
Advice

The EasyPalette contains visual aids to help you edit 
images quickly. Select the desired gallery or palette from the
drop-down list at the top make a wide range of textures, 
special effects, preset filters, and object managing tools 
instantly available. Then, taking advantage of the galleries 
and palettes is a simple drag-and drop operation.
For more information about each palette, click above.

Effect Gallery
Workspace
Menu commands
Dialog boxes
Advice

The Effect Gallery offers a visual alternative to choosing 
effects available from the Effect menu. It separates them 
into tabs corresponding to the submenus the filters belong to
in the Effect menu. Additionally, an "All" tab shows all effects
at one time.
To apply a gradient to an image:

Double click on the desired effect or drag it to the 
image. The effect is applied using the default settings.

Right click on the desired effect and choose 
"Apply." The effect is applied using the default settings.

Right click on the desired effect and choose 
"Modify Properties and Apply." A dialog box opens where 
you can customize the effect settings. 

Style Gallery



Workspace
Menu commands
Dialog boxes
Advice

The Style Gallery contains a variety of preset filters to 
change the mood of an image. These filters were designed 
to enable you to make quick enhancements without 
requiring careful thought about the mechanics of image 
processing.
To apply a filter to an image:

Double click on the desired filter or drag it to the 
image. The effect is applied using the default settings.

Right click on the desired filter and choose "Apply." 
The effect is applied using the default settings.

Right click on the desired filter and choose "Modify 
Properties and Apply ." The Style dialog box opens where 
you can customize the settings. 

My Gallery
Workspace
Menu commands
Dialog boxes
Advice

This gallery contains settings for color palettes, filters, 
effects, and tools that you saved using the Add button in 
dialog boxes or the Attribute toolbar. They are organized into
tabs for easy finding.
To apply an item in the My Gallery to an image:

Double click on the item or drag it to the image. 
The effect is applied using the default settings.

Right click on the item and choose "Apply." The 
effect is applied using the default settings.

Right click on the item and choose "Modify 
Properties and Apply ." You may then change the settings 
before applying them to the image. 

Texture Gallery
Workspace
Menu commands
Dialog boxes
Advice

The Texture Gallery contains patterns you may want to use 
as backgrounds in your images. Three tabs group the 
patterns into categories:
Magic contains random colored patterns. These apparently 
random shapes add a mysterious or abstract feel to you 
images.
Nature contains patterns that imitate commonly used 
backgrounds. For example, you may want a wood-tone 
background, or textured paper.
Custom Magic contains other patterns you may create in 
the Texture Library dialog box.

To apply a texture to an image:
Double click on the desired texture or drag it to the 

image. The effect is applied using the default settings.
Right click on the desired texture and choose 

"Apply." The effect is applied using the default settings.
Right click on the desired texture and choose 



"Modify Properties and Apply ." The Magic Gradient dialog 
box opens where you can customize the gradient settings. 

Layer Manager
Workspace
Menu commands
Dialog boxes
Advice

 
As your projects become more detailed, you may find it 
difficult to keep track of all the objects you have. That's why 
PhotoImpact has the Layer Manager. It keeps track of all the
objects in the active image showing thumbnails of each. You
may rearrange the objects to display them by level, name, or
groups. And to select an object for editing in the image, just 
click on it in the Layer Manager. This may be especially 
useful if one object is hidden or covered by another.

Object-based Image Editing
Working with objects

Object Library
Workspace
Menu commands
Dialog boxes
Advice

 
The Object Library contains a collection of masks and 
images you may want to use in several different images. By 
storing them here you save memory and time by visually 
selecting them and dragging them into an image. You can 
create new tabs in the object library to group and classify 
images and filters according to your needs.

Add a View
Opens and links a new window of the active image at the 
highest magnification that will fit in the current workspace. 
Any changes made in one window are shown 
simultaneously in both. This is useful for working at high 
magnifications on an image and simultaneously seeing the 
overall results without requiring you to switch windows.
(Hot Key -- Ctrl+I)

Note: You may add up to eight views of the same image.
 

Color Balance    
Takes all the colors in an image and then balances them so 
they appear more equalized. The Adjust balance dialog box 
has two tabs for correcting the color balance:

Manual Allows you to shift the balance according 
to thumbnail images.

Smart Allows you to select a neutral gray feature in
the image and balances all other colors on the basis of that 
selection.. 
(Hot Key -- Ctrl+L)



 Fixing the color balance    

Dimensions dialog box
Resizes an image based upon the number of pixels it contains. Changing image size through this dialog box alters 
data. Making images smaller results in lost information and smaller file sizes. Making them bigger causes information 
to be added and the file size to increase.

Active image Shows the current image size.
New image Choose the desired size for the image.
Apply to Choose Entire image to resample the base image. Choose Selected object to resample objects in 

the image but leave the base image untouched.
Print preview Shows how the image will appear on a printed page.
Current printer Shows the currently selected printing device for outputting images.
Printer Click to change or configure the printing device.
Memory used shows required memory for the new image.



Resolution dialog box
Change the size of an image by changing the size and distance between the centers of the pixels. Unlike resampling,
changing the resolution always affects the entire image and no image data changes so the file size remains the 
same.

Current resolution Shows the current resolution for the image.
New resolution Choose a new resolution for the image. You can quickly change the image to match your 

current display or printer settings by checking their respective options. Or enter a custom size in the User defined text
box.

Current printer Identifies the currently selected printer for printing from PhotoImpact.
Print preview Shows how the image will appear on a printed page.
Printer Click to change or configure the printing device.



Stitch dialog box
Append one image to another.

Stitch with Select the image to append to the current one.
Overlap area transparency Make the image selected in the Select with option transparent where it 

overlaps. This may be useful for helping you find the best place to stitch. Set a higher value to allow more of the 
current image to show through areas covered by the selected image.

 Manually Check to stitch images based upon reference points you place in each image. In general, 
checking Auto fine-tune produces best results.

Note: You may also drag-and-drop the selected image to its desired location.
Fully auto stitch Check to have PhotoImpact determine the best stitch possible.    (PhotoImpact compares 

images finding the areas of greatest similarity and stitches along those edges.) Set an overlap range to define the 
general region in the selected image where the original can be joined. Set the tolerance to determine how far 
PhotoImpact can shift the image to find the best match.

Test Click to preview the results in the working area before accepting.
Switch Positions (top / bottom) Place the images one over the other or switch the top image with the 

bottom.
Switch Positions (left / right) Place the side by side or switch the left image with the right.

 Deskew buttons Click horizontal ( 
 )to correct any misalignment for the stitched images horizontally, Click vertical ( 
 )to align them vertically. 

Zoom in Zoom in to obtain a clearer view of a small portion of the stitched images.
Zoom out Zoom out to gain a better view of all of both images.
Actual view Change the view so that both images appear at    their actual sizes.
Fit in window Scale both images so that they both appear in the working area at the largest possible 

magnification.
Work area Position the two images by dragging them where you want.



Select Source dialog box
Select a TWAIN compatible source for collecting images into the PhotoImpact workspace from the drop-down list. If 
the list is empty, or the desired source is not shown, check your hardware setup to make sure the device exists and is
installed properly.



Acquire Image dialog box
    Destination
    Calibration

    Post Process

Choose where to send scanned images. You are not required to open them in PhotoImpact.
New image Check to open the image in a new window.
File Check to automatically save the image as a file. Click File Name to assign a name and location.
Printer Check to printout the image immediately after scanning. Click Setup to configure the printer.
Fax / Mail Check to send the image an e-mail message. Click Setup to configure the mail handler 

accordingly. Note: this option is only available Microsoft Exchange is installed.



Acquire Image dialog box
    Destination

    Calibration

    Post Process

Automatically correct the scanned image for brightness, contrast, and other imperfections.
Apply calibration scheme Check to enable the calibration settings.
Scheme Choose a scheme from the drop-down list.
Add Select a tone map created and saved in the Map tab of the Adjust Tone Map dialog box to add to the 

list.
Delete Remove a scheme from the list.
Acquire Start scanning.



Acquire Image dialog box
    Destination

    Calibration

    Post Processing

Automatically correct the scanned image for common problems that occur during the scan.
Auto straighten Correct the image if it appears slanted by using predominant horizontal or vertical lines in 

the image as references.
Auto crop Remove apparently unnecessary space from the outer edges of the image.
Auto-remove moiré Smooth out patterns in solid colored areas of the image to produce a more uniform 

look.
Adjust brightness and contrast Automatically adjust the image to use the full range of available colors.
Add frame Add a border, shadow, and background to the scanned image. Click Attributes to determine the 

characteristics.
Acquire Start scanning.



Print dialog box
Determine how images appear when printed.

Printer Identifies the currently selected printer.
Copies Set how many copies to print.
Scale to fit the page Check to resize the image to fill the page according to the printer's horizontal or 

vertical margins.
Center image horizontally Print the image with equal amounts of white space on the left and right.
Center image vertically    Print the image with equal amounts of white space above and below it.
Title Enter a caption to print with the image.
Preview Click to switch to preview mode. In preview mode you can get a rough idea of how the printout will 

look before printing.
 Options Click to customize the color map and dithering characteristics for the printer.

Printer Click to access the Windows Print Setup dialog box.



Preferences dialog box
    PhotoImpact

    Associate

    Memory
    Display

    Photo CD

Optimize how Windows manages system memory while running Ulead programs.
Temp Folders Choose folders (directories) for storing temporary files while running Ulead programs. 

(Windows automatically determines the first folder.)
Hard disk Select the drive you wish to assign a temp directory to.
Limit hard disk usage to: Check this and specify a value to have Ulead programs manage disk usage 

while running. This might be useful for preserving disk space for other files.
Limit RAM usage to: Check this and specify a value to have Ulead programs manage system memory 

while running. This might be useful if you run several different programs at once.



Preferences dialog box
    PhotoImpact

    Associate

    Memory

    Display
    Photo CD

Control how Ulead programs display graphics.
High color dithering Check this if your display mode is High Color and you want True Color images to look 

their best on screen.
View images with a common palette Check this if you are working in 256-color mode and want to open 

grayscale and color images at the same time or when to compare 256-color images with each other.
Ignore background quality Check this to devote most system resources to viewing the active image. When

selected, inactive images may appear discolored.
Monitor Gamma Check this to correct your display for manufacturers' differences and the environment. 

When checked, set the gamma value so that the calibration square appears to be a single color.



Preferences dialog box
    PhotoImpact

    Associate
    Memory

    Display

    Photo CD

Choose the file formats to associate with Ulead programs. This enables you to open Ulead programs directly from 
Windows Explorer or other Windows resources by clicking on an associated file.

Add Ulead Quick Viewer to Explorer Check to access Viewer directly from the Windows Explorer with the 
right mouse button.



Preferences dialog box
    PhotoImpact

    Associate

    Memory

    Display

    Photo CD

Choose the data type and resolution for viewing PCD images.
Resolution Choose the image resolution for opening PCD files.
Data type Choose the data type for opening or viewing PCD files.



Photo CD images can be displayed at the following resolutions (pixels):
64 x 96
128 x 192
256 x 384
512 x 768
1024 x 1536
2048 x 3072
4096 x 6144



Photo CD images can be displayed using the following data types:
True Color
Indexed 256-Color
Grayscale



Make sure each of your temporary directories is on a different drive or partition.



Black and White

Grayscale

Indexed 16-Color

Indexed 256-Color



This does not affect the actual data, it just affects appearance when not active.



Color Table dialog box
Define new color assignments for indexed color palettes.

Color squares click on a color square to change its color. The Cell color dialog box opens offering you color
choices.

Load Choose a previously saved color palette.
Save Save the current palette for future use with other images.
Add Add the settings for this dialog box to the My Gallery.
Index Shows the square assignment for the color under the mouse pointer.
Color Values Shows the RGB and HSB values for the color square under the mouse pointer.



Toolbars & Panels dialog box
Determines how various PhotoImpact items appear in the workspace. Check each item you want to appear in 
PhotoImpact's workspace. Clear each item you want to hide or disable.



Color dialog box
Select colors for the background or indexed color table entries.

Basic Colors Choose a color to use from the standard Windows color palette.
Custom Colors Choose a color you created and saved from the Custom Colors area.
Define Custom Colors Create a color from a palette showing all available options for your computer.



Batch Manager dialog box
Quickly repeat the same command on several open images with in a single action.

Operation Choose the command you wish to repeat from the drop-down list. Note: Close Quickly closes all 
selected images without saving. PhotoImpact does not provide any sort of warning prior to doing so.

Images Choose the images you wish to repeat the command on by clicking on their names or thumbnails. 
Drag your mouse or use the Ctrl and Shift keys to select multiple images.

Select All Choose all open images in the workspace.
Deselect All Deselect any selected images.

Note: Double-click anywhere in the workspace to open the Batch Manager dialog box.



Convert to Black & White dialog box
Define the image characteristics for capturing or converting to black and white images.

 Resolution Choose the desired resolution from the preset choices or define your own. When choosing a 
resolution, consider what you will use the image for. If displaying on-screen, do not exceed the maximum resolution of
the display. For printing, use the printer's resolution.

Halftone Screen:
Shape Choose a dithering option or a halftone screen shape. Here are some guidelines to help you decide 

which to choose:
None No dithering or patterns are used for the image. All lighter colored pixels are changed to white and all 

darker ones to black.
Dispersed and Diffusion Surrounding pixels are considered when determining whether to apply a black or 

white pixel. These options usually produce the best results.
Shapes Shades are created by arranging black and white pixels in patterns according to the chosen shape. 

Choosing a shape usually results in moiré-like patterns. Note: When you choose a shape, the Frequency and Angle 
settings become available.

Frequency Choose a higher frequency for smaller dots. As the frequency increases, the pattern becomes 
less noticeable.

Angle Choose the relationship of one pattern to the next. 0 degrees means the patterns are arranged 
horizontally across the image.



Convert to Grayscale dialog box
Determine how many shades of gray to use when converting a black and white image to grayscale.

Cell size For line-art images, where contrast and distinct lines are important, choose 1. For photos or other 
images where you wish to introduce finer shading, choose higher settings. 

Scale down Reduce the physical size of the image according to this setting. This may be useful for minimizing a 
"mosaic-like" effect that often results from conversions using large cell sizes.



Convert to Indexed 16-Color dialog box
The Convert to Indexed 16-Color dialog box offers options for creating Indexed 16-color images. Depending on the 
format of the source, it may contain some or all of the following items:

Palette Specify the colors to include in a new image.
Standard Choose standard to use the default 16-color palette shared by most windows programs. This is 

most useful when you plan to use multiple images in the same program and you want them all to appear consistently.
Optimized Choose optimized to have PhotoImpact use the 16 most needed colors in the image it creates. 

This usually results in a much more accurate reproduction, but can cause compatibility and consistency problems 
with other programs.

Reserve entries Make sure that certain colors remain available regardless of the ones PhotoImpact 
chooses for the image. 

Black and White Check Black and White to create a 14-color palette and then add Black and 
White to make a total of 16 colors.

8 primary colors Check 8 Primary Colors to create an 8-color palette and then add Black, White, 
Red, Green, Blue, Cyan, Magenta, and Yellow to make up the rest of the palette.

From file Use a previously saved 16-color palette as the basis for the new image. Click the Load button to 
search your system for the desired palette.

Dither Choose a dithering option to create the most accurate reproduction. The best choice depends on the 
source material.

None Choose None when the image is composed almost entirely of a few large single-colored areas.
Pattern Choose Pattern when most of the image contains large single-color images but with a wide variety 

of colors.
Diffusion Choose Diffusion when the image has multi-colored patterns, shading, and other fine points. 

While you can't avoid losing some detail, this usually produces the most pleasing results.



Convert to Indexed 256-Color dialog box
The Convert to Indexed 256-Color dialog box offers options for creating Indexed 256-color images. Depending on the
format of the source, it may contain some or all of the following items:

Palette Specify the colors to include in a new image.
Standard Choose standard to use the default 256-color palette shared by most windows programs. This is 

most useful when you plan to use multiple images in the same program and you want them all to appear consistently.
3-3-2 bits Choose 3-3-2 Bits to assign a unique color to every spot in the color palette. This offers the widest

range of colors, but may introduce some inconsistencies when displayed by programs that do not recognize the 
unique palette. 

6-7-6 levels Choose 6-7-6 Levels to fill 252 assignments in the color palette. This is more than the number 
of assigned colors in the standard palette, but may introduce some inconsistencies when displayed by programs that 
do not recognize the unique palette. 

Optimized Choose optimized to have PhotoImpact use the 256 most needed colors in the image it creates. 
This usually results in a much more accurate reproduction, but can cause compatibility and consistency problems 
with other programs.

Start index Prevent colors with values below a certain level from being included in the image by identifying 
a starting index level.

Max number of colors Limit the number of colors to include in the palette here. This can be useful if you 
wish to add your own custom colors to the palette after the image is created without affecting any existing 
pixels in the image.

From file Use a previously saved 256-color palette as the basis for the new image. Click the Load button to 
search your system for the desired palette.

Dither Choose a dithering option to create the most accurate reproduction. The best choice depends on the 
source material.

None Choose None when the image is composed almost entirely of    large single-colored areas.
Pattern Choose Pattern if choosing None results in blotchy images and Dither results in too much "noise". 

The Pattern result may offer a pleasing alternative.
Diffusion Choose Diffusion when the image has multi-colored patterns, shading, and other fine points. 

While you can't avoid losing some detail, this usually produces the most pleasing results.



Photo Properties dialog box
Obtain statistical information about the image in the active window.

Attributes tells the data type, dimensions, resolution, and file size when open.
File tells the name, format, and saved file size.
Album Info If the image has been placed into an album, click this to see Album information, including Album

name, key words, and other field data.



Print Preview Mode
This is not so much a dialog box as a sub window in PhotoImpact. It provides you with tools and a visual reference for
ensuring printed images appear as desired.

The toolbar contains these items:
Print Print the image.
Setup Choose a different printer or configure the current one.
Resize Resize the image. After pressing this button, drag the control points until the image reaches the 

desired size on the page.
Copies Set how many copies to print.
Start From Assign the location of the top left corner of the image on the page.
Title Assign a title to print with the image. ("&F"    tells PhotoImpact to use the file name.)

Options Shows a menu with commands for placing and sizing the image.

View Shows a menu with commands for examining the image.
Close Click to return to the PhotoImpact workspace without printing.

Note: You can also position the image on a page by dragging it to the desired location.



Save

Saves the current tool settings to the My Gallery. By 
dragging from the My Gallery to an image, you can instantly 
recall the tool and its saved settings.

File dialog boxes
This class of dialog box allows you to decide the names, locations, and characteristics for files when opening or 
saving them. They may contain some or all of the following choices:

Look In/Save In Find the desired folder.
View the contents of the next higher directory or folder in your system.
Create a new directory or folder.
View files as icons.
View files by names with statistics.
File Name Identify the file(s) selected for saving, opening, or loading.
Files of    Type Select a particular file format for opening or saving to.
File Information See the data-type, size, resolution, and other file statistics.
Preview View a thumbnail picture of the selected image. (Images with preview information automatically 

appear.)
Browse Search for files or folders.
Options Define format specific save options for the selected format. (Not all file formats have options.)
Network Allows you to access shared folders on other connected computers running Windows.
Save to Album, Saves a thumbnail image of the file to the listed album.
Album Button Select or create an album for the thumbnail images.



TIFF Save Options dialog box
Format Choose to save the file for use on an IBM PC- compatible or Apple Macintosh system.
Compression Choose the compression method to apply to the file.
Strip Size Try the default setting of 8 first. If you need a smaller file, increasing the strip size may help.
Tile Size If varying the strip size still does not produce adequate compression, try varying the tile size.
Horizontal Differentiation If your image contains large solid-colored areas, (not dithered), horizontal 

differentiation can improve the compression. If the image is mostly random or widely dispersed colors the advantage 
is minimal.

Include Preview Saving a preview makes the file a little bigger offers some programs the ability to display 
the image without actually opening it.



PSD, TGA, & UFO Save Options dialog box
Choose Run Length Encoding (RLE) for a smaller file size. If you have problems save it again without compression.



JPEG Save Options dialog box
Quality Lower quality results in smaller files at the cost of image quality. The default setting offers good 

compression without significantly affecting the image appearance.
Progressive compression Check to enable the file to open progressively. This also places preview 

information in the file which enables some programs to view the file without actually opening it.



BMP Save Options dialog box
Choose whether to save the file as an MS-Windows or OS/2 bitmap.



Browse dialog box
File Name Defines the search criteria for finding files. You may use the * and ? wildcards to find files with 

similar names.
Files Found Shows all files found matching the search criteria in the File Name text box.
Folders Select the folder to start the search from.
Drives Select the drive where the folder you want to search is located.
Sort Files Select the sorting order and whether to start from first to last (ascending), or last to first, 

(descending).
Scan Expand the search to include any folders inside the selected folder.
Delete Permanently remove selected files in the Found list from the hard disk.
Rename Change the name of selected files in the Found list from the hard disk.
Network Access shared folders on other connected computers running Windows.



System Properties dialog box
    Memory
    Disc

    Display

    Plug-ins

Provides information about the operating system and available memory.
Version Identifies the version of Windows currently running.
Processor Identifies the type of CPU in the system.
Physical Memory Shows the total RAM available for the system.



System Properties dialog box
    Memory

    Disc

    Display

    Plug-ins

Provides information about permanent storage facilities on your system.
Current Folder Identifies the folder the program will automatically access when opening or saving files.
Drives Scroll to find out the size and available space for all drives connected to your system.



System Properties dialog box
    Memory

    Disc

    Display
    Plug-ins

Provides information on current display settings.
Width Shows the horizontal size in pixels for the display.
Height Shows the vertical size in pixels for the display.
Resolution Shows how many pixels are shown in a square inch block on your display.
Bits per pixel Shows how much memory each pixel requires.
Number of planes Shows how many layers the display uses to show color.
Can be captured? Indicates whether a screen capture utility can accurately copy and reproduce the 

information shown on screen.



System Properties dialog box
    Memory

    Disc

    Display

    Plug-ins

Shows the total number of Plug-ins used by Ulead programs and the folder where they are stored.



When converting black and white to grayscale, the cell size determines the size of each square used to determine 
shades. A cell size of one determines shading pixel by pixel, so only black or white is possible.    A cell size of 8 
results in samples consisting of 64-pixel squares, so 65 shades are possible. The downside to large cell sizes is that 
contrast and accuracy in reproducing distinct shapes suffers. One way to make this less obvious this is to reduce the 
size of your image as you increase the cell size. Do this by increasing the Scale down setting.



Some file formats do not offer any save options. In this case, the Options button is disabled.



The benefit of choosing this option depends on the image. 



This is most useful for images you are preparing for the WWW or other on-line services. It enables viewers to see a 
representation of the image faster, thus allowing them to decide faster whether to wait to download the entire image 
for viewing. It is also useful if you wish to automatically see a preview thumbnail in the Open Image dialog boxes for 
Ulead and other programs that support preview information.



When using compression, larger strip sizes offer higher compression ratios. However, some programs may not be 
able to read TIFF files with large strip sizes.



New dialog box
Determines the size, color model, and data type of a new image created in PhotoImpact.

Data Type Press the button identifying the desired color characteristics for the new image.

    Black and White

    Grayscale

    16-Color

    256-Color

    True Color
Image Size Set the size for the image.    
Resolution Set the density of pixels for the image.



If the image size is user defined and the unit of measure is pixels, this affects the overall size of the image when 
printed.



Photo CD dialog box
Allows you to choose the default data type and image size for opening a Kodak Photo CD image in PhotoImpact.

Resolution Choose the image resolution for opening PCD files.
Data Type Choose the data type for opening or viewing PCD files.



Options dialog box
    Calibration
    Halftone

Redistributes the color distribution in the image to correct for the printer's idiosyncrasies.
Use printer's default Check to have the printer determine how to print colors and shades.    This disables all

other options in the dialog box.
Map Drag the curve to remap the color distribution according to your needs. The horizontal axis represents 

the current image color values and the vertical axis represents the final values. The line shows the equivalent new 
value for each existing one.

Channel Choose which channel to edit. Master mainly affects brightness and contrast. The other channels 
specific colors.

Show control points Check to add handles to the mapping curve. This may make it easier for you to 
reassign color values.

Accumulatively Check to have each change you make to the mapping curve add on to previous changes.
Smooth Check to smooth the mapping curve after you create a freehand map. This may make the change 

to the image more natural.
Load Use a previously saved map file to remap the colors.
Save Save the current map settings to a file for future use in another image.
Enhance function Choose from a list of pre-defined mapping curves or functions.



Options dialog box
    Calibration

    Halftone

Configures the printer to print halftone images.
Use printer's default Check to have the printer determine how to print colors and shades.    This disables all

other options in the dialog box.
Shape Choose a desired shape for each pixel in the image.
Optimized screen Correct range of colors in the image for the best printout.
Frequency Set the desired distance between the centers of each halftone dot.
Angle Set the angle for printing the dots.
Default Click to reset all the custom settings to the printer defaults.



Border dialog box
Change the selection to become a closed line around the current selection.

Border width Set the size in pixels for the border.
Soft edge Set a higher value to have the border blend more smoothly into the background. Make sure the 

setting does not exceed the width or height of the entire area enclosed by the border.
Preview Click to see how the current settings affect the selection before accepting them.



Similar dialog box
Expand the current selection to include other areas containing colors similar to those already selected.

Color similarity Set the range of similar pixel values to add. Higher values include more colors in the 
selection.

Expand from current selection Check to include all pixels in the current image that meet the similarity 
settings. Clear to limit expanding the selection to only those pixels already in contact with selected ones.

Soft edge Set a higher value to have the border blend more smoothly into the background. Make sure the 
setting does not exceed the width or height of the entire area enclosed by the border.

Preview Click to see how the current settings affect the selection before accepting them.



Soften dialog box
Fades the edges of the selection to allowing it to blend into another image when moved.

Soften edge width by: Set a higher value to create a smoother blend. Make sure that the width does not 
exceed the width or height of the selection.



Properties
Opens the Object properties dialog box for reviewing and 
changing the properties for the selected object such as 
name, transparency, and edge blending as well as hiding 
the object to prevent it from appearing in the image.

 Editing Objects 

Duplicate
Copies the selected object and inserts the copy into the 
same image. This differs from using "Copy" and "Paste" 
commands because clipboard data does not change.

 Duplicating 

As the value increases, the blend starts closer to the center of the selection. Higher values cause more of the 
selection to fade into the background.



Combine CMYK Channels to True Color dialog box
Select grayscale images for combining to create a true color image. Choose an image for each channel from the 
drop-down lists.

Note: You may only select grayscale images that are open in the workspace and are the same size as the current 
image.



Add Shadow dialog box
Define the properties of a shadow object to group with the currently selected object.

Direction Choose the direction for the shadow to fall.
X and Y offset Set the size in pixels for the shadow.
Transparency Set a high value to allow more of the base image to show through the shadow.
Edge blending Set a higher value to blend the shadow more smoothly into the background. Make sure that 

the width does not exceed the width or height of the object group.
Color Click the color square to choose a color for the shadow.
Preview Click to see how the shadow appears before applying it to the object.



Show / Hide EasyPalette    
When pressed, opens the EasyPalette to make tracking 
objects easier and allowing you to drag and drop filters, 
effects, and textures into images. When up, hides the 
EasyPalette making the workspace and desktop less 
cluttered.

 Editing by Eye 

Add / Subtract

Change the mask to cover more or less of the image. 
Add Increases the area protected by the mask.
Subtract Reduces the area protected by the mask.

Notes: 
1. Dragging over the image with the right mouse button 

pressed causes the opposite results.
2. Pressing "A" and the left mouse button while dragging 

always adds to the selection. Pressing "S" and the left 
mouse button always subtracts. The right mouse button 
does not work when you press "A" or "S."

Mask Color

The color to use when modifying the selection. Click it to 
access the Ulead Color Picker; right click for the Color 
picker menu. 

Soft edge

Fade the edges for blending into another image. Set a 
higher value for a smoother blend.

Merge factor

Choose how PhotoImpact blurs or sharpens the image:
Always PhotoImpact blurs or sharpens no matter 

what the pixel values are.
If lighter PhotoImpact only blurs or sharpens the 

image if the pixels under the pointer are lighter than the 
adjacent ones.

If darker PhotoImpact only blurs or sharpens the 
image if the pixels under the pointer are darker than the 
adjacent ones.

Spacing

Set the distance between the center of each stroke. If the 
spacing is smaller than the stroke size, PhotoImpact creates
a continuous line.

Pressure



Set a higher value to make the color darker and stronger.

Distribution

Set a higher value to reduce the density of color when 
painting. More of the underlying image appears between the
painted pixels.

Global Viewer
Accesses the Global Viewer which helps you focus on a 
particular area when the image is larger than its window.

Focusing on part of an image

EasyPalette Menu Button
If the current selection in the EasyPalette has associated 
menu commands, click this button to access them.

Unit
Change the unit of measure for PhotoImpact. This is most 
useful when the ruler is showing to provide an accurate idea
of the actual size of the image when printed.

 Showing and hiding the ruler 

Change Color From

Shows the color to erase from the image. Click it to access 
the Ulead Color Picker; right click for the Color picker menu.

Switch Color Palette Display

When working in true color, click this to switch the color 
palette between showing the complete spectrum and color 
blocks that group similar colors for easy selection. 

Background Color

Shows the background color for the image. Click it to access
the Ulead Color Picker; right click for the Color picker menu.

Current Palette

Shows all available colors for the current image. Clicking on 
the palette changes the currently selected foreground color 
to the color under the pointer. Right clicking changes the 
background color. If the image is a true color image, click on
the button below the palette for a condensed palette.



Quick Samples dialog box
Select the thumbnail showing the desired result. If none of the thumbnails offer the results you want, click the Options
button to open the associated effect dialog box where you may fine tune the settings.

Note: If you do not wish to use the Quick Sample dialog box to apply effects, check the Don't show these quick 
samples next time. You can re-enable the dialog box in the PhotoImpact tab of the Preferences dialog box.



Object Properties dialog box
Allows you to review and change the characteristics of the selected object.

Name Change the name of the object so that you can easily identify it.
Merge Determine which color characteristics of the object you want to apply to the base image.
Transparency Set a higher value to make the object more transparent. This allows other images below the 

object to show through more clearly.
Edge blending  Set a higher value to blend the object more smoothly with the background. Make sure that 

the width does not exceed the width or height of the selection. Note: Do not perform Edge Blending until the object is 
in its final position and the base image surrounding the object is not expected to change.

Transparent color Check to limit the transparency of the object to a single or range of colors. Right click on 
the color square to access the color picking tools for selecting the base color.

Similarity If Transparent color is checked, set a range of similar colors to make transparent.
Show Check to keep the object visible in the image. Clear to hide the object. When hidden, the PhotoImpact

erases the object when merging.
Preview Click to see how the changes will affect the actual object before applying them.



Select Tools
The select tools allow you to create selection areas and 
select or move objects. They consist of the following buttons
on the Tool panel:

Standard Selection Create a rectangular or 
circular selection.

Lasso Draw your own selection.
Magic Wand Select by color.
Mask Brush Applies a transparent colored mask 

over the image so you can see and "paint" a selection.

 Creating objects 
 Tool Panel -- General 

Painting Tools
PhotoImpact offers a wide array of tools for adding and 
enhancing colors and patterns to images:

Paintbrush The standard, no frills painting tool.
Airbrush Applies dispersed color depending on the

rate the brush passes over the image.
Crayon Applies color as if you were using a wax 

crayon.
Charcoal Applies color as if you were using 

charcoal or pastels.
Chalk Applies color as if you were using chalk.
Highlight Marker Applies color as if you were 

using a marking pen. Depending on the settings, it can be a 
dark pen that covers the base image, or a transparent color 
similar to that of a highlighter.

Clone Tool Paints over an image using portions of 
the original or a different image.

 Tool Panel -- General 

Enhancing Tools
Similar to painting tools, these tools alter the image with 
special effects:

Burn Make the image darker.
Dodge Make the image lighter.
Sharpen Make the image more distinct.
Blur Make the image hazier
Smudge Smear the image.
Erase Remove data from the image.
Erase Color Remove only a specific color or range

of colors.

 Tool Panel -- General 



Object Library Group Commands
The Group commands allow you to organize the Object 
Library tabs to make recalling objects easier:

Create Group Adds a new empty tab to the Object 
Library.

Delete Group Removes the current tab, deleting 
all objects it contains.

Import Group Adds a tab consisting of a group 
created on another machine. (The Object Group File must 
be in a folder in your computer or the network.)

 Object Library basics 

Properties
Shows information about the tabs in the Object Library. A 
dialog box opens allowing you to select the tab you want 
information about. Once selected, you can see how many 
images and masks are in the tab, the tab file name, and 
where it is stored on your system.

Read Only (For Sharing)
Check this command to prohibit deleting or adding objects to
the current tab. Clear to allow others to change the objects 
in the tab.

Store Commands
The store commands determine what form an object takes 
when you add it to the Object Library.

Store Image Place the actual image data into the 
Object Library.

Store Selection Place a selection area the same 
shape and size as the object in the Object Library.

Store Image as a Selection Only available for a 
grayscale object, it creates a selection from the image data 
with the gray value of each pixel determining the 
transparency. (White pixels are completely transparent; 
black opaque.)

Sort Commands
The sort commands arrange objects in the Object Library 
according to your preferences:

Sort by Depth places the object that is on top in 
the top left corner of the Object Library and arranges the 
rest according to their layers across and down.

Sort by Name Arranges the objects numerically 
and alphabetically by name.



Sort by Group Arranges objects by layers except 
all grouped objects appear together. (The object closest to 
the top determines location.

Description
Shows the name and any associated menu command 
associated with the selected item in the EasyPalette. (You 
may change the item's name if you wish.)

Apply Commands
The Apply commands modify the current object or image 
according to the selected item in the EasyPalette:

Apply Applies the change according to the current 
EasyPalette settings.

Modify Properties and Apply Opens a dialog box 
allowing you to change the settings before applying.

Delete
Removes the selected item from the My Gallery or Object 
Library.

Properties
Allows you to change the current settings for the selected 
item in the EasyPalette.

Note: This command is disabled for Items that do not have 
customizable settings. 

 Modifying the My Gallery 

Reset Thumbnails
Returns the original image to the thumbnail in the My 
Gallery or Effect Gallery if you changed it with the "Use 
Image as Thumbnail" command or the Try! button.

Use Image as Thumbnail
Replaces the selected thumbnails with the current image or 
object.

Note: Some items do not allow their thumbnails to be 
changed.

 Modifying the My Gallery 



Show / Hide Workspace Items
Check to show this item in the workspace; clear to remove 
it.

Standard toolbar Color panel
Tool panel EasyPalette
Attribute toolbar Quick Command

Quick Command panel
Workspace
Menu commands
Dialog boxes
Advice

The Quick Command window places the commands you 
use the most in one location for quick access. It has two 
sections for storing commands:

Custom This section contains commands you want
to always have available. To add and remove commands 
from this section, from the Quick Command Menu choose 
Modify. Then add commands to the Custom Set.

Cache This section contains the most recently 
used commands. Its contents change each time you use 
another command. To determine how many commands 
appear in this section, from the Quick Command Menu 
choose Layout Options. Then set the number of commands 
for the Cache.

There are three ways you can lose data while saving images in PhotoImpact:
Images with objects Only the UFO format allows you to retain objects in images you are editing. If you 

save an image with objects that you plan to edit again, make sure you save it as a UFO file.
Lossy file formats Lossy formats discard image data when saving. Usually the changes to the image 

cannot be detected by the human eye. Nevertheless, if you edit an image saved to a lossy format, you can quickly 
compound the problem and eventually the degradation will become obvious. To prevent this, save to a lossy format 
only when you are sure you have completed your edits.

Saving selections When saving a selection, PhotoImpact only remembers the shape and size. If the 
selection does not start from the upper right corner of the image, the physical location will be lost. To recall the 
physical location, place the selection in the Object Library.



When creating a grayscale mask, the white pixels in the image are completely transparent and the black ones are 
opaque.    All shades in between are more or less transparent depending on their relationship to white and black.



Edit Text
Allows you to change the text in a text object. This command
is only available when a text object exists and the Text tool is
selected.

           Painting text   

Retrieve Image as Thumbnail
Click to return the original thumbnail images to the 
EasyPalette after substituting them with your own image.

Note: PhotoImpact automatically restores thumbnails each 
time it starts.

Quick Command Menu
Besides the standard windows commands for window 
management, the Quick Command Menu contains these 
commands:

Layout Options Determine how many commands 
occupy the Quick Command Panel in each section.

Modify Add and remove commands from the 
Custom section.

Load Load a previously saved Quick Command 
Panel into the workspace.

Save As Save the current Quick Command Panel 
for future use.

Recent files Shows Quick command files you have
opened previously according to the settings in the Layout 
Options dialog box.

Fill dialog box
Fills the selected image or mask with a pattern or image according to the following choices:

Selected color Select to fill the selection with a color of your choice. Click the color square you showing the 
desired fill color. Right click a color square to change its color.

Background color Select to fill the selection with the current background color.
Clipboard data Select to fill the selection with the current clipboard data. (Only available if the clipboard 

contains image data.)
Black Select to fill the selection with black.
White Select to fill the selection with white.
Magic texture Select to fill the selection with the shown magic texture. Click Library to select a different one.
Natural texture Select to fill the selection with the shown nature texture. Click Library to select a different 

one.
Merge Determine which color characteristics of the fill you want to apply.
Transparency Set a higher value to make the fill more transparent. This allows the underlying image to 

show through more clearly.
Preview See how the changes will affect the actual image before applying them.





Eyedropper dialog box
Select a color based on an existing pixel in the selected image.

Sample image Click in this image to select a new color
Red value Enter a new value for the red channel here if you don't want to use the eyedropper.
Green value Enter a new value for the green channel here if you don't want to use the eyedropper.
Red value Enter a new value for the blue channel here if you don't want to use the eyedropper.
Zoom in Increase the magnification of the sample image by 1.
Zoom out Reduce the magnification of the image by one
1x Change the magnification of the image to the actual size.
Fit Change the magnification to the largest that will fit in the Sample Image area.
Before / After block The left side shows the color under the mouse pointer. The right side shows the color 

defined by the red, green, and blue value boxes. When you click on the image, both colors become the same.



Description dialog box
This dialog box shows the name and function associated with the selected item in the EasyPalette. Some items allow 
you to change the assigned name by entering a new one in the Label text box.



Create Group dialog box
Create a new group for storing related objects in the Object Library.

Name Assign a name for the group to show in its tab.
Folder Assign a folder for storing the group information in.
Free space Shows how much space is available in the assigned folder for adding group information.



Group dialog box
Shows the names of all groups in the Object Library along with information about their contents:

Object groups Select the group you want more information about.
Image objects Shows how many images are in the selected group.
Selection objects Shows how many masks are in the selected group.
Group filename Shows the name of the group as it is stored on your computer.
Folder Shows the location of the selected group file on your computer.



Magic Texture dialog box
Select a texture to add to the image.

Sample tiles The center tile shows the currently selected texture. Click a bordering tile to shift the texture 
accordingly. You may repeat this action several times until you find the texture you want.

Random Change the center tile to a randomly selected other texture.
Add Add the settings for this dialog box to the My Gallery.



Texture Library dialog box
Click on the texture you want to place in the image.

Options Click to access the Magic Texture dialog box where you can create your own magic textures.



Unsharp Mask
Sharpens the image by subtracting a value for a determined 
by the average pixel values in a specified cell size from each
pixel in that cell.

Other Tools
Eyedropper Change the foreground and 

background colors by clicking on the image when this tool is 
selected.

Zoom Zoom in and out on the image using the 
mouse to zero in on the area you want to see.

Transform Distort and rotate images and objects.
Fill Fill a large area with a solid color.
Linear Gradient Fills Fill a large area with a range

of colors starting at one point and moving outward in two 
directions.

Rectangular Gradient Fills Fill a large area with a 
range of colors in four directions from the center to the 
edges.

Elliptical Gradient Fills Fill a large area with a 
range of colors in a circular pattern from the center to the 
edges.

Text Adds a text object to the image.

 Tool Panel -- General 

Send dialog box
Prepare a message to send along with an image from PhotoImpact.

Send Files Click on the information to send. Check the options on what files to send and how to handle 
them.

Message Text Enter a subject and message to include with the image(s).
OK Accesses the Choose Profile for addressing the message. 

Note: You may send messages without images and vice versa.



Text Entry dialog box
Enter text for painting into the image.

Text Window Enter the desired text. To add a carriage return, press Ctrl+Enter.
Update Show an outline of the text in the image without closing the Text Entry dialog box.



Open File

Select a file containing an image or objects you wish to paint
into the current image.

Clear Clips

Remove currently installed objects from the list of objects to 
paint into the current image.

Keep Size
Pressed Resample the objects as they are 

inserted to the new image based upon differences in image 
resolutions.

Up Place the new objects pixel-for-pixel in the new 
image.

Clone Options
Image

Freehand Paints a freehand line.
Straight Lines Paints a straight line into the image.

Press Shift key to restrict line directions to 45 degree 
multiples.

Connected Lines Paints connected lines. Double-
click to close the shape. (Closing does not fill it.)

Clone Continuously When checked, remembers 
the position of the clone reference mark when you stop 
painting. When you continue, the clone tool picks up from 
where you left.

Background color

Currently assigned background color. Right click on it to 
access the Color picker menu for changing colors.

Foreground or Paint Color

Currently assigned foreground or paint tool color. Click it to 
access the Ulead Color Picker; right click for the Color 
picker menu. 

Quick Color Controls

Adjust the colors for the image on-screen as you would on 
your television.

Adjusts the red channel.
Adjusts the green channel.
Adjusts the blue channel.
Adjusts the brightness.
Adjusts the contrast.



Fill Color

Currently assigned fill color. Click it to access the Ulead 
Color Picker; right click for the Color picker menu.

Fill Start Color

Currently assigned starting color for the fill. Click it to access
the Ulead Color Picker; right click for the Color picker menu.

Fill End Color

Currently assigned ending color for the fill. Click it to access 
the Ulead Color Picker; right click for the Color picker menu.

Fill Merge Factor

Determines how the fill affects the selected area.
Always completely replaces the original data with 

the selected color.
Color Only bases the blend on the color and 

richness of the color.
Hue Only bases the blend on the nature of the 

color only, retaining the brightness and saturation levels of 
the original data.

Anti-aliasing

Smoothes the edges of the fill so that they do not look 
pixelated.

Color Ramp

Determines how the colors change in the gradient fill.
RGB follows the colors found in a straight line 

connecting the start and end colors in the RGB cube.
HSB Clockwise Follows the colors found in a 

continuous arc going clockwise around the HSB cone from 
the start to the end color.

HSB Counterclockwise Follows the colors found 
in a continuous arc going counterclockwise around the HSB 
cone from the start to the end color.

Ulead Color Picker dialog box
Choose colors visually from a color palette. 

 Note: If the current image is an indexed-color image, the color picker dialog box is the same as the Color 
Table dialog box except you cannot load or save a palette.

First color tab Shows the full color spectrum. Click on a color close to the one you want, then drag the 
cursor on the resulting brightness and contrast bar to the perfect shade.

Other color tabs Show 88 color blocks, each containing related colors. Click the on the color block you 
want and then fine tune it manually changing the RGB values.

Red value Enter a new value for the red channel here if you don't want to use the eyedropper.
Green value Enter a new value for the green channel here if you don't want to use the eyedropper.



Blue value Enter a new value for the blue channel here if you don't want to use the eyedropper.
Before / After block The left side shows the color under the mouse pointer. The right side shows the color 

defined by the red, green, and blue value boxes. When you click on the image, both colors become the same.



Insert Thumbnails into Album dialog box
Places thumbnails of newly saved image files into an existing album.

Album Choose the album to insert the thumbnail into from the drop-down list.
Thumbnail Information Shows the filename and description information for the thumbnail.
New Album Click to create a new album to hold the thumbnail.
Description Click to add a description for the thumbnail.
Apply to all Click to use the same description for all thumbnails.



New Album dialog box
    General
    Fields 

    Advanced 

Determines the name location, and size characteristics for a new album.
Title Enter the title for the album.
Create Album file in Folder Initially displays the current folder. Enter the desired folder or click Browse.
Browse Click to search for other folders.
Thumbnails attributes list Enter the size, compression, and color for the thumbnails in the new album.
Description box Displays default image description. Enter new description,    add new fields, or use the 

default.



New Album dialog box
    General

    Fields
    Advanced 

Assigns fields for thumbnails in the album.
Field name Enter the field name to add or modify.
Field type Select the data types for each thumbnail. Add/modify/delete from the user-defined list. Note: 

Certain field types can be modified provided that the field name is not computer default field by clicking on the Edit 
button. 

Add button Click to add new field name to the fields list.
Change Click to change the selected field name's current field type.
Remove Click to remove field name from the fields list.
Total fields Displays the total number of fields in the album.
Fields list Displays the field names and their field types in the album.



New Album dialog box
    General 

    Fields 

    Advanced

Determines sharing and folder monitoring behavior for a new album.
Folder Enter the folder for monitoring.
Browse Click to search for other folders.
File types Enter the file format to monitor or select from the file formats drop-down list.
File formats list Select the file format to monitor.
Enable folder monitoring Check to monitor defined folder.
Password Enter a password for access security.
Verify Enter the password again for verification.



Choose JPEG compression for the smallest Album file size.



Thumbnail Description dialog box
Enter a description for the thumbnail being inserted into an album.



PIC Open Options dialog box
Pen Select the pen you want to assign a color to.
Color Select a color for the currently selected pen.
Width Set the desired width in pixels for the image.
Height Set the desired height in pixels for the image.
Default Click to restore the Width and Height settings to 400 and 300 pixels respectively.



Drawing Mode
Pressed Change the locations of existing control 

points in a vector object.
Up Draw a new vector object.

Photo CD Open Options dialog box
Resolution Choose the image resolution for opening PCD files.
Data Type Choose the data type for opening or viewing PCD files.



Change Selection Commands
Switch the currently selected object to another without losing
an existing static selection.

Select Base Image Makes the base image active   
when the current selection is an object or static selection.

Select Previous Selection Reselects a static 
selection after you select an object or use the Activate Base 
Image command to deselect it.

           Selection Procedures Contents   



Layout Commands    
Allows you to control which PhotoImpact tools remain visible
in the workspace.

Basic Mode Only the Standard toolbar appears. 
This mode is useful for quick fix-ups on recently scanned 
images.

Intermediate Mode Adds the Tool Panel and 
Attribute toolbar to the workspace. You can complete most 
editing tasks in this mode, but may lack some of the fine 
tuning ease.

Advanced Mode Shows all PhotoImpact items 
except the Quick Command palette. This allows you to 
control color, filters, and special effects with greater ease.

You may also select individual workspace items 
individually and access the toolbars and Panels dialog box 
to control tooltips and button appearance from this menu.

Gradient Gallery
Workspace
Menu commands
Dialog boxes
Advice

The Effect Gallery offers a visual alternative to magic gradients 
from the Magic Gradient dialog box. By choosing gradients from 
the Gradient Gallery, you can save time trying to find the right 
colors or patterns. Even if you don't find the perfect pattern and 
color scheme, you will probably find one that needs only minor 
adjustments.
To apply a gradient to an image:

Double click on the desired gradient or drag it to the 
image. The effect is applied using the default settings.

Right click on the desired gradient and choose "Apply." 
The effect is applied using the default settings.

Right click on the desired gradient and choose "Modify 
Properties and Apply ." The Magic Gradient dialog box opens 
where you can customize the gradient settings. 

Adding plug-ins

Try! Button
Click to substitute a thumbnail image of the current image in 
each sample in the EasyPalette. As long as the EasyPalette 
remains open, this image remains in every thumbnail

Effect Gallery 
Style Gallery 
Texture Gallery 
Gradient Gallery 
My Gallery
Layer Manager 
Object Library 





Layer Manager Menu button

Accesses the Layer Manager menu with commands for 
managing objects in the current image.

Object Menu Contents

Object Library Menu button

Accesses the Object Library menu with commands for 
managing objects in the Object Library.

Object Library Menu Contents

All
Opens a submenu showing all filters and effects that are 
available. If plug-in modules are loaded, they also appear in 
the submenu

Applying Filters



If you don't have Ulead plug-ins on your system, 
contact your dealer or Ulead for information about
upgrading.



Layout Options dialog box
Allows you to set the maximum size for the Quick Command panel.

Number of Custom commands kept Set the maximum number of commands you can assign to the 
Custom (upper) area of the Quick Command panel.

Number of Cache commands kept Set the maximum number of commands that can appear in the Cache 
(lower) area of the Quick Command panel. When the maximum number is reached, the oldest command will scroll 
out of the cache area as a new one is added.

Number of file names kept Set the maximum number of Quick Command Files to list at the bottom of the 
Quick Command panel.



To add commands to the custom area, from the Quick Command menu, choose Modify



Modify dialog box
Allows you to assign commands to the Custom area of the Quick Command panel.

Menu Select the menu that contains a command you wish to add.
Commands list Select the commands you wish to add. Drag or user the Ctrl or Shift keys to select several 

commands at one time.
Add Place all selected commands in the Commands list into the Added list.
Remove Remove all selected commands in the Added list from the list.
Remove All Empty the Added list with one click.
Up & Down Change the order of the selected command in the Added list.
Alias Assign your own name to the command fur use when displayed in the Quick Command panel.
Added list Shows all commands currently installed in the Quick Command panel. Select the ones you want 

to modify.



Description
Opens the Description dialog box showing the name for the 
selected item in the EasyPalette and its menu command 
equivalent. If accessed from the My Gallery, you may 
change the name to make it easier to remember.

Copy to Object Library
Allows you to add the selected object to the Object Library 
without dragging your mouse or opening the EasyPalette.

Copy Object to Image
Copies the selected object in the Object Library to the 
current image without requiring you to drag and drop or 
rearrange the workspace.

 

Magic
If Ulead magic plug-ins are installed, this command opens a 
submenu listing them for you to choose.

If you don't have Ulead plug-ins on your system, contact 
your dealer or Ulead for information about upgrading.

 

When you click the Library button, a menu appears offering these commands:
Standard Opens the Texture Library dialog box showing the textures that came with the program.
Custom Opens the Texture Library dialog box showing textures you created and saved to the My Gallery.
Options Opens the Magic Texture dialog box where you can create a new texture.



 Setting a higher number of undos allows you to recover from mistakes more effectively, but can result in slower 
performance and use more memory.



Copy Selection to Object Library
Allows you to add the selection shape, (no image data), to 
the Object Library without dragging your mouse or opening 
the EasyPalette.

Drag-and-Drop in PhotoImpact Only
Checked Only allows you to drag objects from the 

Object Library to the PhotoImpact workspace. This makes 
dragging from the Object Library to PhotoImpact faster.

Cleared Allows you to drag objects from the Object
Library to any other program that supports drag-and-drop 
and the current data type. This makes dragging from the 
Object Library more versatile.

Black & White & Grayscale Color Value

The RGB values for the pixel that the mouse is over.

Use Thumbnail
When checked Uses the actual file for the selected 

natural texture to fill or create an image. PhotoImpact first 
searches your Textures folder for the file. If the file is not 
there, PhotoImpact searches the program CD for the image.
If the CD is not installed, PhotoImpact will use the 
thumbnail.

When clear Uses the thumbnail as the source for 
filling or creating an image. The thumbnail is an 
approximation of the actual texture that can be tiled in such 
a way that the edges are not apparent.

Note: Using the thumbnail is faster, but using the actual 
texture produces better results.

Open as a New Image
Opens a new image consisting of the selected texture. If 
"Use Thumbnail" is checked, the image is the same size as 
the thumbnail in the EasyPalette. If "Use Thumbnail is not 
checked, the actual texture file is used and a bigger and 
higher quality image is created

PNG Save Options dialog box
Interlace Check to allow images to open progressively when viewed on-line. This may increase file size.
Description Assign a brief description, key words, or other text message to store with the image.
Compression method Choose Compress more for the smallest possible file. Choose Compress faster to 

enable faster opening when viewed on-line.
Background color Click the color square to choose a color that appears as a background to the image.





Title dialog box
Enter a caption to print with the image. (&f tells PhotoImpact to print the filename.)



Standard Choose a size from the drop-down list of common sizes for digital video and computer displays.
Active image Create a new image the same size as the current image.
User defined Set the size of the width, height, and unit of measure for a new image according to your own 

specifications.



    Print Preview Options Menu
Fit to Page Resize and reposition the image to 

horizontally or vertically fill the page.
Center Horizontally Center the image horizontally 

on the page.
Center Vertically Center the image vertically on 

the page.

     Print Preview View Menu
Actual View Resize the preview to the largest size 

that will fit the window.
Zoom In Take a closer look at the image.
Zoom Out View more of the page.
Ruler Show a ruler at the top and left edges of the 

page. (The ruler does not print out.)

Keep aspect ratio Check to maintain the horizontal and vertical proportions for the image when resizing.
Unit Choose Percent to change the size in proportion to the original; choose Pixels to specify the exact size 

for the image in pixels.



Path Tool
This is the Path Tool button. In the full version of 
PhotoImpact, it allows you to reshape non-text-based vector
objects. This enables you to twist and turn images with 
greater flexibility.

Note: The Path Tool is disabled in PhotoImpact SE.

Click here to learn more about upgrading to the full 
version of PhotoImpact.

GIF Save Options dialog box
Color table Displays the color palette of an image. Click on the color you wish to make transparent when 

the image is placed as an object.
Transparent color Displays the color that appears transparent when placed as an object into another 

image.
Save in Interlaced format Check to open the image progressively when viewed on-line. This may increase 

file size.



New    
Opens an empty window in the workspace for creating a 
new image.
(Hot Key -- Ctrl+N)

Creating a new image

Open    
Opens the Open dialog box for selecting files to place in the 
workspace.
(Hot Key -- Ctrl+O)

Opening Images 
Finding Files 

Restore
Returns the image to the way it was when it was last saved. 
This is essentially the same as closing the image and then 
reopening it without saving. (This command cannot be 
undone.)

Recovering from mistakes

Close
Closes the active window without ending the program. 
PhotoImpact prompts you to save changes.
(Hot Key -- Ctrl+W)

Place
Shows a submenu for opening image files to place in the 
current image:

As the Base Image Replaces the current base 
image with the selected file. If the new image has a different 
dimension, PhotoImpact resizes the base accordingly. If the 
selected image is a different data type or resolution, 
PhotoImpact converts the image before adding it.

As an Object Places an object of the image into 
the current project. If the selected image is a different data 
type or resolution, PhotoImpact converts the image before 
adding it. If the image contains a transparent background, 
that area will be transparent in the new object.

Replacing the base image 

Acquire



Shows a submenu for using a TWAIN compatible capture 
device. Use these commands to import printed photographs 
or other images into PhotoImpact.

Image accesses the selected capturing device and 
sends the captured image to a specified destination.

Select Source allows you to choose which 
scanning device to use if more than one is connected to 
your system.

Troubleshooting offers advice and guidance if you
have problems scanning.

Print    
Sends the active image to the currently selected printer for 
output.
(Hot Key -- Ctrl+P)

Printing 

Print Preview    
Allows you to see approximately how the image will appear 
on a page after printing.

Printing 
           Print Preview Mode   

Preferences
Allows you to set default settings for working on images in 
PhotoImpact and optimizing performance.
(Hot Key -- F6)

Setting PhotoImpact defaults 
Calibrating the display 
Managing memory 

Exit
Ends the current PhotoImpact session, closing all images. If 
any changed since you last saved them, PhotoImpact 
prompts you to save them again.
(Hot Key -- Ctrl+Q)

Recently Opened Files
Shows up to the last nine images opened. Clicking on a 
name in this list opens it in the workspace.

Note: You can set the maximum number of file names 



shown with the "Number of recently opened files" option in 
the PhotoImpact tab of the Preferences dialog box.

Update
Updates changes made to an image opened in the 
PhotoImpact workspace from another program, (such as 
Microsoft Word). (Only available when the image is a 
PhotoImpact OLE object.)

.

Send
Allows you to write and send electronic mail messages to an
installed e-mail system and attach images to the messages.

Save
Allows you to save your work as a new or existing image or 
Ulead (UFO) file. Saving as a UFO file preserves all objects 
in the image. Saving in any other format discards any 
objects not yet merged.

Save saves the file with its existing name and 
format. If the file has no name the Save As dialog box opens
so you can assign one.    

(Hot Key -- Ctrl+S)
Save As Opens the Save As dialog box where you 

can assign a name, format, and location.
Save Copy As Replaces the Save As command if 

the current image was opened from another program. This 
allows you to create a new file from a PhotoImpact OLE 
object.

Saving Images 



Undo Before / Redo To    
Undo Before shows a submenu of up to the last 

99 actions you performed that can be reversed. 
PhotoImpact reverses all actions above and including the 
one you choose.

Undoes your last action
(Hot Key -- Ctrl+Z)

Redo To shows a submenu of all actions you have 
undone. PhotoImpact re-applies all actions above and 
including the one you choose.

Reapplies your last undo.
(Hot Key -- Ctrl+Y)

Note: You can set the maximum number of steps shown in 
the Undo and Redo submenus changing the "Level of undo"
settings in the PhotoImpact tab of the Preferences dialog 
box.

           Recovering from mistakes   
           Setting PhotoImpact defaults   

Clear Undo/Redo History
Removes all actions currently in the Undo and Redo 
submenus. Use this command to free up memory or make 
the undo and redo submenus more manageable.

Cut    
Removes the selected area or object and places it on the 
clipboard. 

Cutting a selection: PhotoImpact fills the selection
with the current background color.

Cutting an object: Removes the object from the 
image leaving the base unchanged.

Nothing selected: Removes the base image, 
replacing it with the background color.
(Hot Key -- Ctrl+X)

Using the clipboard 

Copy    
Copies the selected area or object to the clipboard without 
removing it from the active window.
(Hot Key -- Ctrl+C)

 Using the clipboard 

Paste
Shows a submenu offering options for how to past clipboard 



data into an image. 

Note: PhotoImpact always creates an object out of the 
pasted information.

As an Object places the image in the top left 
corner of the active window. You can then drag it to the 
desired location.

(Hot Key -- Ctrl+V)
Into Selection places the image into the current 

selection. You can drag the image within the selection to the 
desired location.

Fit Into Selection resamples it to fill the current 
selection.

Under Pointer places top left corner of the image 
where you click the mouse.

As a New Image creates a new window containing
the image.

 Using the clipboard 

Clear
Permanently removes the selected area or object from the 
active window. (If you delete a selection, PhotoImpact fills 
the space with the background color.) Use this command to 
delete information without affecting the clipboard.

Note: If nothing is selected, PhotoImpact replaces the base 
image with the current background color.
(Hot Key -- Del)

Deleting data 

Clipboard
Shows a submenu for working directly with clipboard data.

Load allows you to open a file directly into the 
clipboard without displaying it.

Save allows you to save the current clipboard data 
as a file.

Display opens a new window showing the 
clipboard data. Click anywhere to close the window.

 Using the Clipboard 

Crop
Trims all unselected areas from the image and resizes it 
accordingly. If you are cropping an object, PhotoImpact first 
merges the object to the base and then crops it.

Note: You cannot crop grouped objects. 
(Hot Key -- Ctrl+R)



           Cropping an image   

Fill
Fills the selected area with a color, texture or clipboard data.
(Hot Key -- Ctrl+F)

Filling images with color 
Filling images with patterns 

Paint on Edges
Allows you to paint around the edges of a selection. You 
must create a selection and select a painting tool before you
can use this command.

           Rectangular and elliptical selections   
           Freehand selections   
           Selecting by color   
           Precision selecting   

Duplicate
Shows a submenu for creating a new image consisting of 
elements in the current image:

Base Image with Objects Copies the image and 
its objects to a new image. This may be useful for keeping a 
record of your work or to quickly create backups.

(Hot Key -- Ctrl+D)
Base Image with Objects Merged Copies the 

base image and its objects to a new image and then merges
the objects to the base. This may be useful for getting a 
good idea of what the finished project will look like without 
affecting the current image.

Base Image Only Copies the current base image 
without its objects. This may be useful for maintaining a 
"before" reference.

 Duplicating 

Stitch
Allows you to create a new image by connecting two images
together.

Joining two images 

Color Table
Allows you to change the colors in the color table for 
indexed 16- and 256-color images.



Changing Colors

Rotate & Flip 
Shows a submenu for changing the orientation of an image.

Rotate Left 90 Turns the image counterclockwise 
by 90º.

Rotate Right 90 Turns the image clockwise by 90º.
Rotate 180 Turns the image upside down.
Flip Horizontally Creates a mirror image using the

vertical axis as the reference.
Flip Vertically Creates a mirror image using the 

horizontal axis as the reference.
Use Transform Tool Selects the Transform tool 

(and shows its toolbar) so you can choose other methods for
changing image orientation. (Only shown from the Edit 
menu.)

           Transform Toolbar   
           Instant Rotating and Flipping   



Select
Accesses a submenu for creating and changing selection 
areas without the mouse. Some things you can do include 
selecting or deselecting the entire image, switching the 
selected and unselected parts of an image, using an existing
selection as the basis for a new one, and softening edges of
a selection area.

Select Commands
           Selection Procedures Contents   



Object
Accesses a submenu for working with objects. Some of the 
things you can do include adding shadows to objects, 
changing the shadow's properties, grouping objects together
or breaking groups apart, and merging objects to the base 
image.

Object Commands
           Object Procedures Contents   



Wind / Blast dialog box
These effects create a feeling of a wind blown image. Wind evokes a feeling of a mild to strong wind blowing across 
the image. Blast is more like gale force winds.

Direction Choose the direction the wind blows.
Moving offset Set a high value to create a stronger wind effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Sharpen dialog box
Makes edges stand out more distinctly in an image.

Level Choose higher to get stronger borders.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Add Noise dialog box
Produces a speckled in an image.

Distribution Choose Uniform to evenly distribute the noise through the image. Choose Varied to make parts
of the image noisier than others.

Variance Increase the variance to create a more speckled effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Mosaic dialog box
Blurs the image into blocks by averaging pixel values in each block.

X-axis size Set the width of each square in pixels.
Y-axis size Set the height for each square in pixels.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.
Square Check Square to make each block a perfect square.

Note: If the block size does evenly fit into the image, the blocks are cropped starting from the lower right corner.



Sphere dialog box
Produces a wide-angle camera lens effect on an image.

Light Direction Choose the angle for a light source on the image.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Punch / Pinch dialog box
Punch pushes out the center of an image as if it were being stretched on the outside of a Sphere. Pinch squeezes the
center of the image as if it were pushed into the inside of a sphere.

Power Set a high value to make the effect more pronounced.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Whirlpool dialog box
Twists an image into a swirling pattern.

Direction Choose a clockwise or counterclockwise swirl.
Twist degrees Set how much rotation to use. The higher the number, the greater the distortion.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Ripple dialog box
Adds waves to an image as if viewed through water.

Direction Choose Center to create waves start from the center and move out in a circular pattern. Choose 
Edge for waves that appear to be flowing across the image.

Frequency Choose a high value for more waves.
Amplitude Choose a high value for larger waves.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Watercolor dialog box
Enriches the colors in an image to simulate the appearance of a watercolor painting.

Stroke size Choose Small    for    short brush strokes. Choose Large for big strokes.
Moisture level Set higher levels to add streaking typical of paints with higher water content.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Hue & Saturation dialog box
Controls the balance and intensity of color in an image.

Hue Shift the hue value of each pixel in an image by the amount specified. For example, a yellow pixel will 
become blue if you set the hue to 180.

Saturation add or remove color to an image. Fully reducing saturation results in a grayscale image; fully 
increasing makes the color very rich.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.
Preview Click to see how the changes will affect the actual image before applying them.



Tone Map dialog box
    Map       

    Highlight Midtone Shadow

Redistributes the color distribution in an image to take advantage of the full range of available colors. This versatile 
function enables you to adjust color imbalances; add, emphasize, or remove shadows; improve contrast; and enrich 
images.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Histogram The gray graph shows the current distribution of colors in the image. The line shows how colors 

will be mapped to the image after clicking OK where the horizontal axis represents the current image color values and
the vertical axis represents the final ones. A straight line running diagonally from the bottom left to the top right means
no change. Use the Highlight, Midtone, and Shadow scroll bars to manually adjust the line.

Auto Click Auto to automatically adjust the Highlight and Shadow settings to use the full range of colors 
possible for the selected channel.

Add Add the settings for this dialog box to the My Gallery.
Highlight Remap colors in the image starting with dark colors.    Increasing the setting makes images lighter,

reducing makes them darker.
Midtone Remap colors in the image concentrating on the "in-between" colors. If the curve curves up, the 

image gets darker. If the image curves down, the image gets brighter.
Shadow Remap colors in the image starting with light colors.    Increasing the setting makes images darker, 

reducing makes them lighter.
Histogram scale factor If the peaks of the histogram are not clear, change this setting to show a more 

definitive graph.
Channel Choose a color channel to remap colors to. Choosing Master affects all channels simultaneously. 

You may adjust the master and each color channel independently.
Real-time preview Check to instantly show changes in the actual image. Even though they appear in the 

image, the change is not applied until you click OK.
Preview Click to see how the changes will affect the actual image before applying them.

 Understanding Color Mapping 



Tone Map dialog box
    Map 

    Highlight Midtone Shadow

Redistributes the color distribution in an image to take advantage of the full range of available colors. This versatile 
function enables you to adjust color imbalances; add, emphasize, or remove shadows; improve contrast; and enrich 
images.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Histogram Drag the line to remap the color distribution according to your needs. The gray graph shows the 

current distribution of colors in the image. The line shows how colors will be mapped to the image after clicking OK 
where the horizontal axis represents the current image color values and the vertical axis represents the final ones. A 
straight line running diagonally from the bottom left to the top right means no change.

Smooth Check to smooth the mapping curve after you create a freehand map. This may make the change 
to the image more natural.

Add Add the settings for this dialog box to the My Gallery.
Channel Choose which channel to edit. Master mainly affects brightness and contrast. The other channels 

specific colors.
Show control points Check to add handles to the mapping curve. This may make it easier for you to 

reassign color values.
Accumulatively Check to have each change you make to the mapping curve add on to previous changes.
Apply enhancement Choose from a list of pre-defined mapping curves or functions.
Load Use a previously saved map file to remap the colors.
Save Save the current map settings to a file for future use in another image.
Real-time preview Check to instantly show changes in the actual image. Even though they appear in the 

image, the change is not applied until you click OK.
Preview Minimize the dialog box to see how the changes will affect the actual image before applying them.



Emboss dialog box
Displays an image as a single-color imprint on a solid surface.

Light Source Choose the direction of shadows on the image and which parts should appear raised or 
indented. Light sources from above cause dark areas to look raised. From below, dark areas look indented.

Coating color  Click to select a new color for the image.
Depth Set how strong the embossed effect is. Higher settings cause a more pronounced embossed effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Gaussian Blur dialog box
Blurs an image by evaluating the color values of all pixels in the image and shifting them towards the most common 
color in the image.

Variance Choose a higher value to make the image blurrier. As the setting gets higher, the image 
approaches a single color closely matching the most prevalent color in the image.

Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Emphasize Edge dialog box
Increases contrast in an image, making edges more distinct.

Level Choose higher values to produce a clip with harder, more sharply-defined edges.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Blur dialog box
Produces an out-of-focus effect for an image.

Level Select how much you want to blur the image.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Average dialog box
Gives an image a softer look by evaluating the color values of all pixels and moving them toward the average pixel 
value.

Square size Choose a larger size for a softer picture. As the size gets bigger the focus deteriorates.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Motion Blur dialog box
Blurs an image with an effect similar to when a subject or camera moves when taking a photograph.

Light Source Choose the type of motion desired.
Camera simulates camera movement.
Natural simulates light source movement.
Object simulates subject movement.
Angle Choose the direction of motion.
Moving offset Set how strong the motion appears.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Puzzle dialog box
Breaks an image into squares and rearranges them as if they were sliding-puzzle pieces.

Background color Click to select a new color for the borders of the squares.
Square size Set the size in pixels of each square. If the size does not evenly fit in the image, squares are 

cropped from the lower right.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Tile dialog box
Breaks an image into square tiles and shifts them as if they are being placed or removed from the image.

Background color Click to select a new color for the borders of the squares.
Square size Set the size in pixels of each tile. If the size does not evenly fit in the image, squares are 

cropped from the lower right.
Shift value Set a higher value to randomize the order of the tiles more. A value of zero creates a well 

organized tiled effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Facet dialog box
Breaks an image into square tiles and shifts them to simulate the appearance of viewing the image through cut glass.

Square size Set the size in pixels of each square. If the size does not evenly fit in the image, squares are 
cropped from the lower right.

Shift value Set a higher value to randomize the order of the tiles more. This is similar to increasing the size 
of the cuts in the glass. A value of zero produces almost no change to the original image.

Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Warm / Cool dialog box
Add tint to an image producing a warmer or cooler feeling.

Color Choose the tint you wish to apply.
Level Set a higher value to apply a stronger tint. As the level increases the tint becomes more dominant.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Fat / Thin dialog box
Fat expands an image at the center. Thin squeezes compresses an image at the center.

Level Set a higher level to expand (Fat) or compress(Thin) the image more.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Preview dialog box
Shows how PhotoImpact will change the image if you accept the current filter settings. The Preview Options window 
appears at the lower right corner offering these options:

OK Accept the change and continue editing.
Cancel Don't apply this filter to the image and return to editing.
Undo / Redo Compare before and after affects on the image.
Continue Return to the filter dialog box to adjust the settings more.



Thumbnail dialog box
Allows you to choose what appears in the dialog box preview window while applying the filter. This can be useful if 
you are concerned about a particular region, or to change the magnification in the preview window. It also allows you 
to choose an image for adding filter settings to the My Gallery.

Whole Image Scale the entire image to fit in the preview window.

1x Select a portion of the image to show at full size in the preview window.

Custom Size Select any part of the image to show in the preview window. PhotoImpact automatically resizes areas 
larger than the preview window. 



Add Sample dialog box
Saves the current dialog box settings in the My Gallery of the EasyPalette for future use.

Preview Window Shows the image that will appear in the My Gallery.
Name Enter a name for this filter setting that will remind you of what it does or when to use it.



Style dialog box
    Predefined
    Custom 

Choose from a list of preset tints to create a special mood for the image. If the image is not an object, it becomes one
after applying the style.

Thumbnail Click to define a region of the image to show in the preview windows.
Choose a Style Select a style from the drop-down list or by scrolling through the choices and clicking on the

one you want. 
Preview Click to see how the changes will affect the actual image before applying them.



Style dialog box
    Predefined

    Custom

Apply a unique tint to an image based upon the characteristics of another image. 
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Reference Image Shows a thumbnail of the image the styler bases the changes on.
Load Click to select an image to show in the Reference Image frame above.
Add Add the settings for this dialog box to the My Gallery.
Choose a model Check the option that identifies the features of the reference image you want to apply to 

the current image.
Preview Click to see how the changes will affect the actual image before applying them.



Color Balance dialog box
    Smart
    Manual

Allows you to choose a color in an image as the basis for neutral tones.
Preview Image Click on an area in the image containing the color you wish to change to a neutral tone.
Zoom In Increase the magnification in the preview window so you can choose the color more accurately.
Zoom Out Reduce the magnification in the preview window so you can see more of the image.
Actual Size Resize the image so that it appears at its regular size.
Fit in Window Resize the image to the largest size that will entirely fit in the preview window.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Color Settings Choose the color to convert to grayscale based on its color values.
Real-time preview Check to instantly show changes in the actual image. Even though they appear in the 

image, the change is not applied until you click OK.
Preview Click to see how the changes will affect the actual image before applying them.



Color Balance dialog box
    Smart 

    Manual

Allows you to visually shift the prevalent tints in an image.
Preview Images The center image shows the current settings for the image. Clicking one of the others 

adjusts the settings, and places an image with those settings in the center. 
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Thumbnail variation Control how much of a change clicking on an outside preview window has on the 

image.
Reset Returns all dialog box settings to the conditions they were in when the dialog box opened.
Add Add the settings for this dialog box to the My Gallery.
Preview Click to see how the changes will affect the actual image before applying them.



Focus dialog box
Adjust the focus of an image.

Auto Adjust Check to have PhotoImpact choose the best focus setting for the image.
Blur - Sharpen Set a higher value to make borders and edges stand out. Set a low value to soften edges 

and make edges blend into each other.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Level dialog box
Changes the number of divisions for the color channels in the image. Usually this means reducing the total number of
colors used in the image and creates a poster-like result.

Level Set how many divisions of colors to allow for the selected channel. The fewer divisions, the fewer total
colors.

Channel Specify which color channel to adjust.
Real-time preview Check to instantly show changes in the actual image. Even though they appear in the 

image, the change is not applied until you click OK.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Custom Effect dialog box
Distort image data by remapping pixel locations in a plane. The easiest way to use this filter is to first select a method
by clicking on the Samples button. Then, after examining the map, fine tuning it for the effect you want.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.

 Map Drag the curve to squeeze or expand pixels. The left edge of the graph represents the center of the 
image; the right , all four edges. If the curve is steep, the image will be squeezed; if shallow, expanded.

Show control points Click to place control points on the graph. This may make it easier to draw the desired
curve. Enter the number of points you want in the points text box.

In Out Shows the current and remapped pixel assignments when the mouse is in the Map area.
Samples Click for to start with a reference map. The Smooth option takes the current map and smoothes 

out any sharp changes in the curve.
 Preview Click to see how the changes will affect the actual image before applying them.

Load Use a previously saved matrix file to remap the colors.
Save Save the current matrix settings to a file for future use in another image.

           Understanding Pixel Mapping   



Custom Filter dialog box
Create custom effects by changing the color values of pixels by weighting them against their surroundings. The 
easiest way to use this filter is to first select a method by clicking on the Method button. Then, after examining the 
matrix and other filter settings, you can fine tune it for the effect you want.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.

 Matrix Enter a value representing the relative weight a each pixel has when calculating new pixel colors. 
The center box is the pixel that will actually be changed.

Reset Returns the grid to its unchanged appearance.
Load Use a previously saved matrix file to remap the colors.
Save Save the current matrix settings to a file for future use in another image.
Test Click to see how the changes in the right preview window on the dialog box. (This is a little faster than 

pressing the Preview button but not as clear.)
 Preview Click to see how the changes will affect the actual image before applying them.

Methods Click for some sample maps to help you get started.
Symmetry Select an option to help you add factors into the proper places faster.
Divided by Enter a value that will bring the color values for all pixels down to a value that falls between 1 

and 256. For best results, this number should be equal to the sum of all factors in the matrix. (If the sum comes out to
zero, the factor should be 1.

Offset Set a value to add to each pixel after the matrix calculation. Positive values make the image lighter; 
negative, darker.

Invert Apply the complimentary colors to those calculated by the filter. For example, all black pixels would 
become white.



Warping dialog box
Distorts localized regions of an image by allowing you to drag control points.

Sample image Drag the grid to define how to warp the image.
Preview image Shows how the current warping settings will affect the image. (Press the Testing button to 

update this image.)
Grid size Choose the type of grid to place over the image. A small grid gives you finer control over the 

changes.
Show control points Check to place control points at the grid intersections. Clear to remove the points. 

Clearing the points gives you a better view of the original image.
Test See how the changes affect the image in the right preview window in the dialog box. (This is a little 

faster than pressing the Preview button but not as clear.)
Reset Returns the grid to its unchanged appearance.

 Preview Click to see how the changes will affect the actual image before applying them.



Auto-Process dialog box
Automatically fixes common problems with images. Press each desired fixes to put it in the sequence bar. If you want
to change the order, just drag the fix to the proper place. To remove a fix from the sequence bar, just drag it out or 
click on its button again.

The Auto Process dialog box offers these fixes:

Auto Straighten keys on a well defined straight line to use as the basis for rotating the image to make it horizontal or
vertical.

Auto Crop Removes white space from the edges of the image.

Remove Moiré Smoothes out undesired patterns due to dithering.

Auto Focus Sharpens the image.

Auto Brightness Makes dark images lighter and light images darker.

Auto Contrast Enhances the contrast in the image.

Auto Balance Corrects colors in the image so that the full spectrum is used.

The dialog box has these buttons:
Preview Click to see how the changes will affect the actual image before applying them.
Reset Clears the sequence bar.



The origin, (where the horizontal and vertical lines meet), represents a pixel value of 0. the top and right edges each 
represent pixel values of 256. For grayscale, or the master channel, this means the line goes from lightest to darkest. 
For colors this means the colors shift from the complimentary color to the actual color.



Unsharp Mask dialog box
Sharpens the image by subtracting an amount determined by the average pixel values in the specified cell size from 
each pixel in that cell.

Factor Set a high factor for stronger contrast.
Radius Set a low radius to reduce pixelization. 
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Choose Intensity to make the brightness of the image more like the reference. 
Choose Saturation to make the richness of the colors more like the reference.
Choose Chrominance to tint the image according to the colors of the reference.



Positive values add to the total, usually causing the image to become lighter. Negative values usually cause darker 
results.



Stagger dialog box
Creates a wobbly effect for the image.

Direction Choose which way the image wobbles.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Add Add the settings for this dialog box to the My Gallery.



Cropping an image
PhotoImpact deletes all objects in the image without merging when cropping.

Manually
1. Select the area on the base image you want to keep.
2. From the Edit menu, choose "Crop," (Ctrl+R).

Automatically

From the Format menu, choose "AutoProcess:Crop." PhotoImpact finds unneeded white space around the image and
removes it.

Quick Cropping
           General Procedures Contents   



Opening images
Single Image From the File menu, choose "Open" and select the desired image from the Open dialog box. 

Several Images From the File menu, choose "Open" and press the Shift or Ctrl keys while selecting images.
The Shift key allows you to select a range of files; the Ctrl key, several individual ones. 

           Automatic fixes   
           Creating a new image   
           Creating objects   
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           Objects Procedures Contents   
           Selections Procedures Contents   



Finding files
1. From the File menu, choose "Open." 
2. Click the Browse button in the Open dialog box.
3. Enter the path and filename or extension of the file(s) you wish to find.
4. Click Scan. All files matching your search appear in the Found list.
5. Choose the desired file from the found list and click OK.

           Creating objects   
           General Procedures Contents   
           Objects Procedures Contents   
           Selections Procedures Contents   



Saving images
New file From the File menu, choose "Save As" and assign the image a name and location.
Same file From the File menu, choose "Save." 

           Quitting PhotoImpact   
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Printing
1. From the File menu, choose Print. 
2. Enter a title in the Title box to print a caption with the image. ("&f" tells PhotoImpact to use the file name as 
the caption.)
3. Click OK.

           General Procedures Contents   



Obtaining information
Image Information From the View menu, choose "Photo Properties."
System Information From the View menu, choose "System Properties."
Editing Information Look at the status bar for information tools, the mouse location, command 

explanations, and other information.
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Setting PhotoImpact defaults
1. From the File menu, choose "Preferences."
2. Click the PhotoImpact tab.
3. Choose the settings you want for determining PhotoImpact behavior.
4. Click OK.

           Arranging the workspace   
           Showing and hiding the ruler   
           Adding plug-ins   
           Placing the toolbars   
           Viewing Procedures Contents   
           Configuring Procedures Contents   



Adding borders
1. From the Format menu, choose "Frame & Shadow." 
2. In the Frame dialog box, choose a color for the canvas, shadow, and border by clicking their associated 
color squares.
3. Set the width for each item by dragging the appropriate slider or entering a value in the related text box.
4. If using a shadow, select its direction.
5 Click OK.

Note: If a color chosen for Indexed-Color or Grayscale images is not in the current palette, PhotoImpact automatically
replaces it with the closest matching color or gray value available.

           General Procedures Contents   
           Adding Procedures Contents   



Resizing images
Without changing data or file size

From the Format menu, choose "Resolution" and set a new resolution for the image. Higher resolution makes the 
image smaller when printed; lower makes it bigger.

Resizing with the mouse
1. Select an object or create a selection.

2. Using the Transform tool, click the resize button. 
3. Drag the control points to the desired size. (Press the Shift key to preserve relationship between length and 
width.)

Scaling up or down
1. Select an image or object.
2. From the Format menu, choose "Dimensions."
3. In the new image group, enter the new size for the image. (Check "Keep aspect ratio" to preserve relationship 

between length and width.)
4. Select "Entire image" or "Selected object" and click OK.

           Dimensions or Resolution...You decide   
           Choosing the right resolution   
           Switching tools   
           Converting images   
           Transforming images   
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Converting images
1. If you want to preserve the original image and create a new one when you convert, from the Format menu, check 

"DataType:Create a New Image." If you wish to overwrite the original, clear this command.    
2. From the Format menu, choose "Data Type."
3. Choose the desired data type from the resulting submenu.
4. Depending on the original and final data types, a dialog box may open offering choices for fine-tuning the 
conversion. Set the desired conversion options and click OK.

           Why convert data types?   
           Converting to CMYK   
           Converting from CMYK   
           File Management Procedures Contents   



Repeating actions on multiple images
1. From the Window menu, choose "Batch Manager."
2. Select the command you want to repeat.
3. Drag the mouse or use the Ctrl and Shift keys with your mouse to select files from the Files List.
4. Click OK.

Note: Choosing Close Quickly closes all selected files without saving.
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Managing memory
1. From the File menu, choose "Preferences."
2. Click the Memory tab.
3. Enter folder names for storing temporary information. (Do not specify two temporary folders in the same drive or 

partition.)
4. Check Limit hard disk usage to:, and set a value to have Ulead programs limit disk space used while running. 

Leave it unchecked to use Windows defaults.
5. Check Limit RAM usage to: and set a value to have Ulead programs limit RAM used while running. Leave it 

unchecked to use Windows defaults.
6. Click OK.

Why manage memory?
           Configuring Procedures Contents   



Calibrating the display
1. From the File menu, choose "Preferences."
2. Click the Display tab.
3. Check Monitor gamma.
4. Raise or lower the gamma value until the gray box looks something like this:

Note: Increase your distance from the monitor to about six feet, (2 m), to make the pattern in the upper rectangle less
apparent.
5.  Click OK.

Why calibrate my display?
           Configuring Procedures Contents   



Zooming in or out
Tool

Select the Zoom tool and click on the image where you want to zoom in or press the Shift key as you click to zoom 
out. Right click to change the magnification to 1x. 
For a really quick zoom in on an area, drag the mouse over the area you want to see. PhotoImpact automatically 
changes to the highest magnification possible that will fit the area.
Menu
From the View menu, choose "Zoom In" or "Zoom Out" and select the desired magnification from the list.

Hot keys: The + and - keys increase or reduce the magnification sequentially. 
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Quitting PhotoImpact
From the File menu, choose "Exit."
Click the Exit button on the top right corner of the PhotoImpact Title Bar.
Double-click the top left corner of the PhotoImpact Title Bar.

PhotoImpact prompts you to save any images that were changed since you last saved them.

           Saving images   
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Copying
1. Select the portion of the image you want to copy.

2. From the Edit menu, choose "Copy" 
3. Open the program you want to copy the image to and follow its procedures for inserting data from the 
clipboard.

Note: You may also use drag and drop to copy images by pressing the Ctrl key as you drag.

           Using the Clipboard   
           Creating objects   
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Placing the toolbars
Docked Drag a toolbar or panel to the top, bottom, left, or right edges of the workspace.
Floating Drag a toolbar or panel to where you want it on your desktop. Floating items may be placed 

outside the workspace.
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Transforming images

All the tools for resizing, reshaping and rotating images are on the Transform Attribute toolbar. To use these tools:
1. Select the object you want to transform. (Some tools, such as the rotate tools, may not require a selected object.)
2. Select the Transform tool in the Tool panel.
3 Select the tool you want to use. Depending on the tool, the effect may be immediate or you may need to perform 

additional actions to complete the task.
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Reshaping images
1. Select or create an object for reshaping.

2. Select the Transform tool. 
3. Choose the desired Reshaping tool from the Attribute toolbar. These tools are available:

Resize Enlarges or shrinks the object.
Slant Moves the left and right or top and bottom edges equally.
Distort Moves a single control point independently of any others.
Perspective Moves two adjacent control points equally towards or away from each other.
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Instant rotating and flipping
1. Select the object you wish to flip or rotate and from the Edit menu, choose "Rotate & Flip."    A submenu with these 

choices shows:
Flip Horizontal
Flip Vertical
Rotate 90º Right
Rotate 90º Left
Rotate 180º

2. Choose the desired command.

Notes:
If nothing is selected, PhotoImpact rotates or flips the base image.

These commands are also available from the Options menu in the Attribute toolbar of the Transform tool.    ( )
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Straightening images
1. Select the image or object to rotate. If nothing is selected, PhotoImpact rotates the base image.

2. Select the Transform tool. 
3. Select the Rotate Horizontal  or Rotate Vertical 

 tool.
4. Drag the control points on the line that appears in the image so that the line identifies a section you want to 
be horizontal or vertical.
5. Double-click on either control point to accept the setting.

Note: This is a particularly useful way to straighten an image that was improperly aligned when scanned.
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Rotating with the mouse
1. Select the image or object to rotate.

2. Select the Transform tool. 
3. Select the Free Rotate tool .
4. Drag the control points to the desired rotation.
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Rotating by degree
1. Select the image or object to rotate. If nothing is selected, PhotoImpact rotates the base image, resizing the image

if necessary.

2. Select the Transform tool. 
3. Enter the desired rotation in degrees and select the Rotate Clockwise  or Rotate Counterclockwise 

 button. 
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Creating objects
From a selection

Right click on a selection and choose "Convert to Object."
Move a selection to a new location.
Apply an effect, filter, or transformation to a selection.

Independently

From the File menu, choose "Place:As an Object" and select an image to insert in the current image as an object. 
(The selected image must be smaller than the current one.)
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Rectangular and elliptical selections
1. Select the Standard Selection tool in the Tool panel. 
2. Select the desired shape for the selection from the Shape drop-down list.
3. Drag the mouse over the area you want to select.

Turn a selection into an object by moving it, applying a filter or effect to it, or choosing "Convert to Object" 
from the Select menu.

To add to an existing selection, press "A" as you select. To remove part of a selection, press "S" as you 
define the section to remove. (You may also select Add or Subtract from the Mode drop-down list.)
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Selecting by color
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Freehand selections
1. Select the Lasso tool in the Tool panel. 
2. Drag the mouse around the edge of the area you wish to select

      - and / or -
click and release the mouse button at different points for a series of connected straight line segments.

3. Double-click to complete the selection.
Turn a selection into an object by moving it, applying a filter or effect to it, or choosing "Convert to Object" 

from the Select menu.
To add to an existing selection, press "A" as you select. To remove part of a selection, press "S" as you 

define the section to remove. (You may also select Add or Subtract from the Mode drop-down list.)
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Selecting by color
1. Select the Magic Wand tool in the Tool panel. 
2. Set the color similarity to determine the range of colors to select relative to the reference color.
3. Click on or drag over the base image to select reference colors and a starting area.
4. To expand the selection to include all pixels in the image matching the selection criteria, right click on the 
image and choose "Similar."
4a. In the Similar dialog box, set the range of similar colors to add to the selection. (If you only want other pixels of 

the same colors as those selected, set the value to 0.)
4b. To include pixels not physically connected to currently selected ones, clear "Expand from current selection."
4c. Click OK

Turn a selection into an object by moving it, applying a filter or effect to it, or choosing "Convert to Object" 
from the Select menu.

To add to an existing selection, press "A" as you select. To remove part of a selection, press "S" as you 
define the section to remove. (You may also select Add or Subtract from the Mode drop-down list.)
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Creating a grayscale mask
1. If the image you want to make into a mask is not already a grayscale image, convert it.
2. Open the Object Library and from the Object Library menu, choose "Store Image as a Selection."
3. Select the part of the image you want for a mask and drag it to the Object Library.

Converting images 
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Moving a selection
1. Select any of the selection tools and select an object or create a selection.     

    

2. Click anywhere inside the selection and drag it to a new location.
Drag the object to an empty spot in the workspace to create a new image.
Drag it to the Object Library to save it for use in multiple images.
Click the Options button and check Preserve Base Image, (Toggle Hot key -- F5),to move a selection without

affecting the base image. (Objects can always be moved without affecting the base image.)    

To move the marquee without any image data, check "Move Selection Marquee." The base image is 
unaffected by the move.    
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Creating smooth edges for blending
Depending on the selected tool and type of object you are working on, these features enable you to smoothly blend 
an object into the base image:

Anti-alias Smoothes curves so they do not appear jagged due to pixelization.
Soft Edge Fades the edges of the object gradually so that it blends into the background more smoothly.
Blur Tool Blends adjacent pixels to make the colors more similar and make edges less apparent.
Smudge Tool Smears the image making borders less clear.
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Creating a border on a selection
1. Use any of the selection tools to create a selection.     

    

2. Right click on the selection and choose "Border."
3. In the Border dialog box, set the border width and click OK.
4. Fill, paint, or add an effect to the new selection to create an object.
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Creating frames and shadows
To the base image

1. From the Format menu, choose "Frame & Shadow." 
2. Choose a color or texture for the frame and set its width.
3. Choose a color and direction for the shadow.
4. Set the x offset to adjust the horizontal distance of the shadow from the image. Higher is further away.
5. Set the y offset to adjust the vertical distance of the shadow from the image. Higher is further away.
6. Choose a color and size for the canvas.
7. Click Test to see how the current settings will affect the image.
8. Click OK.

PhotoImpact resizes the base image to include the added items.

To an object

You may only add a shadow to an object.
1. Right click on the object and choose "Add Shadow Object."
2. Choose a color and direction for the shadow.
3. Increase the x offset to make the shadow larger horizontally. Reduce it to make the shadow smaller.
4. Increase the y offset to make the shadow larger vertically. Reduce it to make the shadow smaller.
5. Click Preview to check the results.
6. Click OK.

PhotoImpact adds a shadow object, grouping it with the original object.
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Object Library basics
Use the Object Library to store images and selections that you might need for several images. This makes them 
instantly available for multiple uses. By grouping objects, you can classify the objects to make them easier to find.

Menu

Click to reveal the Object Library menu. Here you can create, delete, and add object groups, obtain information, 
determine the default behavior for adding objects, and set other parameters.

Working with groups
Create remove and add groups by choosing the appropriate command from the Object Library menu.
Switch between object groups by clicking the tabs running along the top.
Protect the current group against having objects accidentally removed by checking "Read Only (For 

Sharing)" in the Object Library menu. (You cannot add new objects to the group either.)

Networks

You can load Object Library groups from other connected machines into your own Object Library with the "Import 
Group" command in the Object Library menu. 

Note: Remember, others can import yours as well. Protect your groups by making them read only as described 
above.
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Adding images to the Object Library
Make sure the "Store Image" command is checked in the Object Library menu and drag an object from an 

image to the Object Library.
Right click on an object and choose "Copy to Object Library."
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Adding selections to the Object Library
Make sure the "Store Selection" command is checked in the Object Library menu and then simply drag an 

object from an image to the Object Library. PhotoImpact adds a transparent Selection matching the size and shape of
the object.

Press "M" as you drag a selection to the Object Library. It does not matter whether "Store Selection" is 
checked or not.

To create a grayscale selection from a grayscale image, in the Object Library menu, check "Store Image as 
Selection" and drag the image to the Object Library.
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Placing objects from the Object Library into images
Drag an item from the Object Library to the image you want to insert it into.

Note: If you drag an object to an empty spot in the workspace, PhotoImpact creates a new image with the object.
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Managing objects basics
PhotoImpact has four resources for managing objects:

Object buttons

All the selection tools contain four buttons to make switching object layers easier. Objects on higher numbered layers 
appear behind lower numbered layers.

Brings the selected object to the top layer.
Brings the selected object up one layer.
Sends the selected object down one layer.
Sends the selected object to the lowest layer above the base image.

Object Menu

Right clicking on an object shows the Object menu. From the object menu you can group, duplicate, modify, delete, 
and merge objects.

Layer Manager

The Layer Manager shows thumbnails of all objects in the current image. If you are having trouble finding an object in
image, click on it in the Layer Manager. Besides the commands in the Object menu, the Layer Manager menu adds 
three more for arranging objects: Sort by Depth, Sort by Name, and Sort by Group.

Object Library

The Object Library keeps an independent collection of objects. By storing objects in there, they become available for 
multiple images.
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Grouping and ungrouping objects
Grouping
1. Press the Ctrl key as you click on each object you want to put in a group.
2. Right click on any selected object and choose "Group." 

Note: When you add a shadow to an object, PhotoImpact automatically creates a group of the object and the created
shadow.

Ungrouping
1. Select any object in the group you want to break apart.
2. Right click on any object and choose "Ungroup."

Why group objects?
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Moving objects
Changing the location
1. Select any selection tool.
2. In the base image or Layer Manager, click on the object you want to move.
3. Drag the object to its new location.

Changing the layer
1. Select any selection tool.
2. In the base image or in the Layer Manager, click on the object you want to move.

3. Click     to put the object on the top layer.
Click     to move the object up one layer.
Click     to move the object down one layer.
Click     to put the object on the lowest layer above the base image.
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Finding objects
1. Select the image to search for objects in.
2. Open the EasyPalette and select the Layer Manager.
3. Right click anywhere in the Layer Manager and choose one of the sort commands.
4. Scroll through the object thumbnails to find the one you are looking for.
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Duplicating
Objects

Duplicating an object places an exact copy of the selected object or group in the same image. To duplicate an object:
1. Select the object or group.
2. Right click on any object and choose "Duplicate."

Images

From the Edit menu, choose Duplicate. Then choose the appropriate command from the submenu. You have three 
options:

Base Image with Objects Copies the base image and objects as they are to the new image. (Ctrl+D)
Base Image with Objects Merged Merges all objects to the base image in the new image.
Base Image Only Ignores all objects that have not been merged.
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Hiding and showing objects
1. Select the object you want to hide or show. (Hidden objects can only be selected from the Layer Manager.)
2. Right click on the object and choose "Properties."
3. To hide an object in the image, clear Show. To make it visible, check Show.
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Editing objects
1. Select the object or group you want to edit.
2. Right click on the object and choose "Properties."
3. Set the transparency level for the object and how the transparency should be determined. (A high transparency 

setting allows more of the base image or any underlying objects to show through.)
4. Click Preview to check your settings.
5. Click OK.
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Recovering from mistakes
Undoing

From the Edit menu, choose "Undo Before" and select the last step you want to recover. (The number of undo steps 
you can perform depends on the PhotoImpact preferences settings.) 
Redoing
From the Edit menu, choose "Redo To" to reapply commands you undid with "Undo Before." 
Starting over
If you want to undo more than what appears in the Undo to list, or can't remember where you went astray, from the 
File menu, choose "Restore." This effectively closes and reopens the current image discarding all objects and 
changes made since the last save.
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Merging objects to the base image
1. Select the object you want to apply to the base image.
2. Right click on the object and choose "Merge." To apply all objects in the image at one time, choose "Merge All."

Note: Once an object has been merged, it is no longer an object. If any edge blending or transparency features were 
used prior to merging, reselecting the objects may be very difficult.

           Creating smooth edges for blending   
           Blending images   
           Adding Procedures Contents   
           Objects Procedures Contents   



Applying filters and effects
Instantly

Drag the desired effect, filter, or texture from a gallery in the EasyPalette to the image.
or

Double-click on the desired effect, filter, or texture in the EasyPalette.

Automatically
1. Select the image to apply an effect or filter to.
2. From the Format or Effect menu, choose the desired command.
3. Choose the thumbnail that shows the best example of how you want to change the image.
4. If none of thumbnails look right, click Options and continue at step 3 of the Custom Setting procedure below.

Notes:
The Display quick samples option in the PhotoImpact Preferences tab must be checked to apply filters and effects 
visually.
Some effects and filters may not offer quick samples.

Custom Setting
1. Select the image to apply an effect or filter to.
2. From the Format or Effect menu, choose the desired command.
3. Adjust the settings so that the preview image appears the way you want.
4. Click Preview.
5. Click OK to accept the settings, Continue to return to the dialog box and adjust them some more, Undo and Redo 

to toggle before and after views, or Cancel to return to editing without applying the filter. 

Editing by eye 
 Stylizing your images 

Basing one image on another 
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Changing the desktop wallpaper
1. From the Effect menu, choose "Set as Wallpaper."
2. Choose "Tile" to fill the desktop with repeated copies of the image. Choose "Center" to place one copy in the 

middle of the screen. (Windows uses the last saved copy of the selected image for the wallpaper.)
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Automatic fixes
1. From the Format menu, choose "Auto Process." 
2. If you want to do just a single fix, choose the one you want from the submenu and you're finished. 
3. If you want to perform several fixes, choose "Batch."
4. Press the buttons for the fixes you want to apply. The sequence that they are performed in appears along 
the bottom of the dialog box.
5. To change the sequence, drag the button at the bottom of the dialog box to the desired spot in the order.
6. To remove an item from the sequence, click its button to raise it.
7. Click Preview to check the results in the actual image before applying them.
8. Click OK to accept the settings.
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Stylizing your images
1. Open the EasyPalette and select the Style Gallery or Texture Gallery.
2. Find the feeling you want to create and drag it to the image.

Note: You can also apply styles from the Style dialog box by choosing "Style" from the Format menu. 

Editing by eye 
Basing one image on another 
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Fixing the color balance
1. Select the part of the image you want to correct.

2. From the Format menu, choose "Color Balance." (Hot key -- Ctrl+L)    
3. Choose the Smart tab to choose a color that should be a neutral gray, pure white, or pure black. Choose 
Manual to shift the colors of the image to a desired shade.

If you chose the Smart Tab, click in the preview image or enter a color value for the neutral shade. (Look at 
the RGB values below the preview window. neutral grays have the same value for each component.)

If you chose Manual, click on the thumbnail that shows the desired shift. You may repeat this action to 
emphasize the effect.
4. Click OK.
Note: For finer control of the color balance use the "Tone Map" command in the Format menu.
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Using the true color spectrum most effectively
1. Select the image you want to correct.
2. From the Format menu, choose "Tone Map." (Hot key -- F8).
3. Select the Highlight Midtone Shadow tab.
4. Adjust the graph so that the curve best represents the most prevalent colors or shades in the image. Adjusting the 

master channel affects brightness. Adjusting the other channels affects colors related to the selected color and its 
compliment.

5. Click OK.

Note: For quick fixes, or visual feedback on your changes, try using the Color Balance command in the Format 
menu. 
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Replacing the base image
1. From the File menu, choose "Place:As Base Image."
2. Select the desired image and click OK.
Note: Replacing the current base image with one of a different size changes the image size accordingly. If the new 
image is smaller, objects may be repositioned. If the new image is a different data type or resolution, PhotoImpact 
changes it to match that of the original. 
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Converting to CMYK
1. Select the image to convert.

2. From the Format menu, choose "Data Type: Split to CMYK." 
3. PhotoImpact creates four new grayscale images; one for each color channel. Save each to a grayscale 
format, making sure you can recall which color channel each represents.
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Converting from CMYK
1. Make sure you have four compatible images to combine open in the PhotoImpact workspace.
2. Select one of the grayscale images you want to combine.

3. From the Format menu, choose "Data Type: Combine from CMYK." 
4. In the Combine CMYK Images to RGB Image dialog box, select an image for each color channel from those 
available in the workspace.
5. Click OK.
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Arranging the workspace
EasyPalette

From the Window menu, choose "Tile EasyPalette" and select the icon representing your preferred working 
arrangement. 
PhotoImpact Album
From the Window menu, Choose "Tile with Album" and select where you wish Album to appear in relation to 
PhotoImpact. 
Maximizing the workspace
From the View menu, choose "Remove Menu Bar." If there are menu commands you want to keep handy, customize 
the Quick Command window to include them. Press Escape to restore the menu.

Note: You may also choose "Full Screen" from the View menu, but some menu commands are disabled and you 
must first undock any toolbars and panels if you want them to be available.

Hiding undesired components

From the View menu, choose "Toolbars and Panels." Clear any checked boxes to remove the undesired items from 
the workspace. (You can also click the Layout button (  ) or right click on any toolbar or panel to bring up a quick 
menu for showing and hiding screen components.)
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Showing and hiding the ruler
From the View menu, check "Ruler."

Note: To change the ruler settings, select the Unit button at the right side of the Status bar and choose a new 
measurement. 
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Blending images
Painting

Many of the painting tools have a Soft Edge setting that allows you to smoothly blend newly drawn shapes into the 
base image. The higher the value the larger the blending area. 

Objects
1. Right click on the object and choose "Properties."
2. In the Object Properties dialog box, set a value for Edge blending. The higher the value, the larger the blending 

area.
3. Click OK.
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Basing one image on another
1. From the Format menu, choose "Style."
2. Select the Custom tab.
3. Click the Load button and select the reference image.
4. Select a model as the basis for changing the image.

Intensity changes the brightness of the image to be more like the reference. 
Saturation Changes the richness of the colors to be more like the reference.
Chrominance tints the image according to the more prevalent colors in the reference.

5. Click OK.
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Editing by eye
Several tools and commands have dialog boxes that offer thumbnail images to help you decide how to apply a 
change. To apply a change based on a thumbnail, just click the desired thumbnail and click OK.

Special cases
Effects have a Quick Samples dialog box that appears before their associated dialog boxes. If you decide 

you want finer control, the Options button allows you to access the dialog box with all the controls. If you do not wish 
to use the Quick Samples dialog box, check the "Don't show these quick samples next time" box or clear "Display 
quick samples" in the PhotoImpact tab of the Preferences dialog box.

Some commands such as "Brightness and Contrast" offer cumulative changes. Clicking on a thumbnail 
applies that change and allows you to continuously add changes until you close the dialog box.
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Modifying My Gallery
Saving effect settings

Several Effect and Format commands' dialog boxes have an Add button that allows you to save favorite settings to 
the My Gallery in the EasyPalette:
1. In the command's dialog box, click Thumbnail to customize the thumbnail image for the effect.
2. Return to the original dialog box and click Add.
3. Enter a name for the effect and click OK.
4. PhotoImpact automatically places the effect in the proper tab of the My Gallery.

Note: Some commands, such as Tone Mapper, do not allow you to use a thumbnail image. Rather they use the 
graph or other command attributes to create a unique visual reminder for their settings.

Tools settings

Click the Add button at the right end of the Attribute toolbar and enter a name for the tool setting. PhotoImpact 
automatically places it in the proper tab of the "My Gallery." 
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Using the clipboard
Besides the standard clipboard features available in all Windows programs, here are some other unique aspects to 
using the clipboard with PhotoImpact:

Pasting PhotoImpact offers five ways of pasting the clipboard contents. In all cases, once pasted, the 
clipboard data becomes an object.

As an Object Inserts the clipboard data into the selected image at the top left corner as a floating object. 

Into Selection If a selection exists in the image, the clipboard data goes inside it. You can drag the data to 
the desired position in the selection. Once placed, the selection becomes an object.

Fit Into Selection Automatically resizes the clipboard data to exactly fit the selection. The selection 
becomes an object.

Under Pointer Places the center of the clipboard data into the image where you click your left mouse 
button. 

As a New Image Creates a new image with the clipboard data as an object. (If the clipboard is irregularly 
shaped, PhotoImpact "squares off" the dimensions.)

Clipboard Submenu Behaves similar to the Windows Clipboard Viewer except it only accepts image data.
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Deleting data
Delete key

Pressing delete on a selection removes data from the base image, filling it with the current background color.

Delete command

Right click on the object and choose "Delete."

Erasing

Select the eraser tools to delete data from the base image and replace it with the background color.
All Erases everything the mouse covers.
Selected Color Erases only pixels matching the color values selected in the Attribute toolbar.
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Color fills
Flat fills

1. Choose the Bucket Fill tool. 
2. Right click on the color square to select the fill color.
3. Choose the Merge to determine how to apply the fill color.

Always Uses all the color values
Hue & Saturation Tints the image based on the color
Hue Only Tints the image based on the richness of the colors

4. Set the Similarity to determine how PhotoImpact determines what region to fill.
5. Click on an object, selection, or region where you want to start the fill.

Gradient Fills

1. Choose any of the Gradient Fill tools. , 
, 

2. Right click on the beginning and ending color squares to select the fill colors.
3. Choose the Merge to determine how the fill color is applied.

Always Uses all the color values
Hue & Saturation Tints the image based on the color
Hue Only Tints the image based on the richness of the colors

5. Click on an object, selection, or region where you want to start the fill and drag to where you want the ending color 
to be reached. Eligible areas beyond these points will be filled with the start or end colors.

Note: You can also do color fills using the Fill command from the Edit menu.
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Pattern fills
1. Select an object or area for filling. If nothing is selected, the base image is filled.
2. From the Edit menu, choose "Fill."
3. Select the pattern or color you want for the fill and click OK.

Note: For gradient fills, use the Fill tools. You can also use the Bucket Fill tool for a solid color fill.
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Joining two images
1. Make sure both images you want to join are grayscale or RGB True Color images and open in the PhotoImpact 

workspace.
2. Select one of the images to join. (It doesn't matter which.)
3. From the Edit menu, choose "Stitch."
4. Select the other image for stitching.
5. Drag the images so that they are in the right order.
6. Select the Manually option and check "Auto fine tune."
7. Press the Shift key and click on a reference point in the original image.
8. Press the Shift key and click on a point in the other image that should be close to the point you clicked on in step 

7.
9. Click OK.
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Changing indexed image colors
Changing individual colors
1. From the Format menu, choose "Color Table."
2. In the Color Table dialog box, click the color square showing the color you want to change.
3. In the Cell Color dialog box select the desired color and click OK.
4. When the color table is as you want it, click OK to return to the image.

Changing the entire palette

From the Format menu, choose "Color Table." Then click Load to replace the existing color palette with a previously 
saved one.
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Creating a new image
1. From the File menu, choose "New." 
2. Choose a data type, image size, and resolution.
3. Click OK.

Note: You can also create new images by converting or duplicating existing images.
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           General Procedures Contents   



Adjusting color on-screen
Adjust the brightness, contrast, and color balance in images similar to the way you do with many modern television 
sets with the dynamic color controls.

Adjusts the contrast.
Adjusts the brightness.
Adjusts the Red channel.
Adjusts the Green channel.
Adjusts the Blue channel.

           Using the true color spectrum most effectively   
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Finding part of an image
1. Click on the Global Viewer icon. 
2. Drag the Global Viewer frame to where you want to focus.

Note: The Global Viewer is only available when horizontal and/or vertical scroll bars appear in the active window.

           Zooming in or out   
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Precision selecting
1. Create a rough selection area using any of the selection tools.  

 

2. Select the Mask Brush tool. A tinted mask covers the image except where a selection exists. 
3. If the current color of the mask is too close to the image colors, right click the color square in the Attribute 
toolbar to select a more appropriate one.
4. Use the left mouse button to draw over the image to add to the selection. Use the right mouse button to 
draw over the selection to remove it. (Or select Add or Subtract from the Mode drop-down list in the Attribute toolbar.)
5. When you complete your selection, select another tool for further action.

Notes:
 PhotoImpact disables most menu commands while the mask brush is active. They become available as soon as 
you select another tool.
You cannot undo any actions performed prior to clicking the mask brush tool.

           Switching tools   
           Rectangular and elliptical selections   

Freehand selections
Selecting by color 
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Dragging and Dropping
Use Drag and drop to enhance the speed and ease of editing:

From one place to another Drag objects from images or the Object Library to the PhotoImpact workspace 
or another image. The object moves to the new destination. To preserve the object in its original place when dragging
to another, press the Ctrl Key as you drag.

Tile Fill Press T as you drag and drop an object to an image. PhotoImpact tile fills the target image with the 
object.

Selection Marquee Press M as you drag and drop an object to an image. PhotoImpact tile fills the target 
image with the object.

EasyPalette Effects and Textures Drag an effect or texture from the EasyPalette to an image to apply it to 
the image.
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Curving text
1. Select the Text tool. 
2. Select the text object you want to curve.
3. In the Attribute toolbar, select Path from the Mode drop-down list.
4. Drag the control points until you obtain the shape you want.
5. Select the Object or Selection from the Mode drop-down list to add the curved text to the image.

Note: If you make any changes to a text object when the Text tool is not selected, the text loses its text quality and 
becomes a regular object.
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EasyPalette basics
Click the Tile EasyPalette button in the Standard toolbar to automatically resize the current image window 

and EasyPalette to fill the workspace
Press the Show EasyPalette button to show the EasyPalette. Press again to hide it.
Several items have tabs to classify their contents.
Dragging items from galleries to an image causes that item's settings to take effect on the current selection.
Depending on the data type, some items in the EasyPalette may not be available for all images.
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Painting
1. Select a Paint tool.     

 
    
 
 

2. Set the brush shape, size, and other characteristics from the Attribute toolbar.
3. Choose a painting color from the color panel. Right click on a color square to change its current color.
4. Drag the mouse over the base image where you want to paint.
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Painting as an object
1. Position the objects where you want them in the image.

2. Select the Mask Brush tool.    
3. Draw a selection in the shape and size of the item you wish to paint.
4. Select any Selection tool.  

 

5. Right click on the image and choose "Convert to Object."
6. Move the new object so that is above any objects you wish it to cover.        

7. Paint the image you wish to add into the new object.
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Cloning
1. Select the Clone tool. 
2. Press the Shift key and click on the image or object where you want to clone from.
3. Click and drag    the mouse where you want to clone the image to.
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Painting an effect
This is best done immediately after merging objects to the base image or near the end of your editing session to 
complete final touch-ups.

1. Select a Retouch tool.  
 
 
 

2. Set the brush shape, size, and other characteristics from the attribute toolbar.
3. Drag the mouse over the base image where you want to paint.
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Changing modes
You may quickly arrange the workspace to suit your editing needs by switching modes. From the Standard toolbar, 
click the Layout button and choose the desired mode or screen components.    

Basic Mode Only shows the Standard toolbar. This may be the perfect mode for quickly scanning and fixing 
images without requiring any thought. All the essential tools are in the Standard toolbar for refining the image.

Intermediate Mode Adds the Tool panel and Attribute toolbar to the workspace. You can complete most 
editing tasks in this mode, but may lack some of the fine tuning ease.

Advanced Mode Shows all PhotoImpact items except the Quick Command palette. This allows you to 
control color, filters, and special effects with greater ease.

You may also select workspace items individually and access the Toolbars and Panels dialog box to control 
ToolTips and button appearance from this menu.

           Placing the toolbars   
           Showing and hiding the ruler   
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Six steps to sensational images
If you need a finished image quickly, use the Standard toolbar to guide you through all the essential steps to complete
your task:

Click Acquire to scan an image into the workspace.
Click AutoProcess to fix any initial scanning problems such as Moiré patterns or skewed images.
Adjust the color to the perfect shade.
Adjust the brightness and contrast to make the image more vivid.
Open the EasyPalette and drag an effect or filter to the image.
Add a frame and shadow around the image.

Your image is finished! Now click Print (  ) or Save ( 
 ).

           Quick Procedures Contents   



Any black pixels in the selection are opaque. White pixels are clear. Grays are partially transparent according to how 
close to white or black their values are.



In the RGB color model, a neutral color is one that has the same R, G, and B values. Look below the preview window
for the current RGB values in the image and click when the mouse is over a color (pixel) you want to be perfectly 
neutral.



The manual tab shifts the colors in the image according to the HSB cone. The thumbnail immediately to the right of 
the reference thumbnail shifts the image towards red. Going clockwise, the other key colors are magenta (lower right 
corner), blue (lower left corner), cyan (across from red), green (top left corner), and yellow (top right corner). By 
progressively clicking on the squares, you can shift the colors to the desired hue.



For example, if you installed Kai's Power Tools in your system at C:\KPT, here is what you would add to the end of 
your ULEAD32.INI

[PLUG IN]
PLUGINDIR1 = C:\KPT



Zoom In / Zoom Out
Shows submenus for zooming in or out on the current 
image. The submenus offer magnifications ranging from 
1/16 x to 16x.

 Zooming in or out 

Fit In Window / Fit In Window by
Fit In Window resizes the current image to fit the 

largest window that can be displayed in the workspace.
Fit In Window by offers a choice of    window sizes

that can fit in the workspace and resizes the image 
accordingly.

Full Screen
Hides the Windows interface, filling the screen with the 
current image and any floating PhotoImpact toolbars and 
panels. This enables you to edit or view an image without 
the distractions of other open windows or programs. To 
return to Windows, press Escape.
(Hot Key -- Ctrl+U)

Photo Properties
Opens the Properties dialog box with statistics about the 
current file. This dialog box has two major sections:

Attributes shows the data type, image and file 
size, and resolution.

File shows the name, format, compression method,
and other information about the file.
Hot Key -- Alt-Enter

Obtaining Information 

Actual View
Resizes the image to 1x magnification

System Properties
Opens the System Properties dialog box with tabs showing 
memory, hard disk, display, and plug-in information.

Obtaining Information 



Remove Menu Bar
Hides the title and menu bars from the workspace. All 
currently displayed toolbars and panels remain visible. This 
is an alternative to full screen mode for maximizing screen 
space for editing. It differs from full screen mode in that the 
all menu commands remain available by using the 
keyboard. (For example, press Alt-O to access the Format 
menu.)

 Arranging the workspace 

Toolbars & Panels
Allows you to customize which features PhotoImpact shows 
to help you work more efficiently. Here you can turn ToolTips
on and off, choose between small and large icons for the 
tool bars, and decide which tool bars and panels appear.

Note: You may also access most of the options in the 
Toolbars and Panels dialog box from a submenu by clicking 
the Layout commands button in the toolbar.

 Arranging the workspace 

Ruler
When checked, shows a ruler along the top and left sides of 
the current image as a reference to determine image size or 
align objects.

Note: You may also show the ruler or switch between 
inches, cm, and pixels by clicking the ruler button in the 
Status bar.    

 Showing and hiding the ruler 



Ulead PhotoImpact Help
Starts the on-line help.
You can also access help topics by:

Clicking the help button and then clicking on the 
item of interest

Placing the mouse over an item of interest and 
pressing F1.

About Ulead Products
Opens the About Ulead help, providing insight into Ulead 
Systems and its products.

Switch
Opens a menu listing other Ulead programs for quick 
access.

Switch Menu
Workspace
Menu commands
Dialog boxes
Advice

The Switch menu opens a menu listing other Ulead 
programs for easy access. 
Click Menu commands on the left for help on other menus.

About PhotoImpact
Shows copyright and other information about this version of 
PhotoImpact.

Help
Allows you to use your mouse to access the on-line help 
about a command, button, or workspace item.

 

Internet Imaging
Opens a help document containing useful information and 
tips on using PhotoImpact to enhance your productivity 
when reading and writing for the World Wide Web.



Cascade
Arranges all open windows diagonally in the workspace from
left to right and top to bottom.
(Hot Key -- Shift+F5)

Tile Horizontally & Tile Vertically
Evenly distributes all open windows in the workspace.
(Tile Vertically Hot Key -- Shift+F4)

Arrange Icons
Arranges icons for all minimized windows in the workspace 
neatly along the bottom of the workspace.

Currently Open Images
Lists the names of all currently open images in the 
workspace. Clicking on a file name activates its window

Tile with Album    
Opens or resizes the PhotoImpact Album and PhotoImpact 
workspaces to fill the desktop more efficiently A submenu 
offers these choices:

Tile Album to the left of PhotoImpact.

Tile Album to the right of PhotoImpact.

Tile Album above PhotoImpact

 Tile Album below PhotoImpact

Tile EasyPalette    
Rearranges the workspace showing only the current image 
and the EasyPalette. Choose from these options:

Place the EasyPalette on the left and the image on the right.



Place the EasyPalette on the right and the image on the left.

Place the EasyPalette above the image.

Place the EasyPalette below the image.

PhotoImpact Explorer    
Starts PhotoImpact Explorer where you can quickly and 
conveniently scan your system for multimedia files.

PhotoImpact CD Browser    
Starts PhotoImpact CD Browser. This is an Album-like 
program that automatically scans the installed CD-ROM for 
Kodak Photo CD images and portrays them as thumbnails in
an album.

Album / Browsers    
Shows a menu for starting Ulead PhotoImpact Explorer, 
Album, or Photo CD Browser to help you find images for 
editing. You have four choices for how to open Album:

Tile Album to the left of PhotoImpact.

Tile Album to the right of PhotoImpact.

Tile Album above PhotoImpact

 Tile Album below PhotoImpact



Quick cropping
If your image had a clearly defined white edge, you can 
quickly remove it with the "Auto Process:Crop" command in 
the Format menu. PhotoImpact will delete the unwanted 
edge and resize the image accordingly.

Why convert data types?
There are several reasons for converting images to different 
data types. The most prevalent ones are:

Space savings Use the smallest sized data type 
that can produce the desired output. For example, true color
images are roughly three times larger than their grayscale 
equivalents.

Editing An image may have been scanned using 
the wrong settings. Perhaps you scanned as grayscale 
when you wanted indexed color. By converting, you can edit 
the image instead of re-scanning.

Compatibility Perhaps the current image data type
will not appear properly in the intended output device. Or 
maybe the format you want to save the image as does not 
support a particular data type.

Choosing the right resolution
The best resolution for an image displayed on screen may 
be quite different than that for printing. When an image is 
intended for displaying on screen, there is little advantage to 
assigning a resolution greater than the highest intended 
screen resolution. Further, when scanning, higher 
resolutions come at a significant cost in file size and 
memory requirements. (Changing the resolution of an 
existing file changes the physical size, not the file size.)

For printing, choose a resolution matching that of your 
printer for best results.

           Background: Images - Resolution   

Why calibrate my display?
Calibrating your display ensures the most accurate image 
reproduction. Each monitor is a little different, and 
temperature and environment can also play a role in 
determining how color appears. The Ulead calibration 
process takes a dithered black-and-white image and 
compares it with the color it is trying to approximate. Since 
black and white represent the extremes for your monitor, 
and the compared color is a set value, you can adjust your 
monitor to produce the best results.

Note: Calibrating your monitor works great for Ulead 
programs, but will not affect how images appear in other 
programs.

Why manage memory?



Working with graphics can require large amounts of system 
resources. Sometimes the standard way that Windows 
controls your memory is not efficient enough, so Ulead 
programs allow you to optimize it for your purposes. For 
example, if you work on a network, perhaps the network 
drive has more room for temporary storage than your local 
drive. So Ulead programs allow you to specify temporary file
locations other than the standard Windows locations. 
Similarly, you may want to reserve some memory for other 
purposes. Typically, Windows grabs all the memory it can 
get, by using Ulead memory management you can limit how 
Windows uses memory for Ulead programs.

Dimensions or Resolution...You decide
The Dimensions command adds or removes, (resamples), 
data in an image to achieve the new size. Here are some 
reasons to resample:

Reduce file size.
Give several images the same dimensions without 

changing their resolutions.
Change the scale of an image or object to make it 

appear suitable for placing into another.

Changing resolution changes the physical size of an image 
when printed. The resolution can also affect how an image 
appears on screen depending on the display device. Here 
are some reasons to resample:

Change image size when printed
Optimize the image appearance for on-line 

presentations.

Why Group Objects?
If you have several objects that you want to keep together, 
group them. That way, when you move or change one, all 
will be affected the same way.

Drag-and-drop editing
You can quickly apply preset filters, effects, textures, and 
styles to images by simply dragging them from the 
EasyPalette to the desired image.

Who needs the standard menus?
When you become familiar with the commands on the tool 
bar, choose "Remove Menu Bar" from the View menu. This 
gives you    a larger working area so you can edit more 
easily. If you ever need the menu bar, just press Escape to 
make it visible again.

Quick zooming
To zoom in on an area    exactly where you want at the 



maximum view that will fit the area, just select the zoom tool 
and drag over the area you want to see more closely. 

Creating a mask from a color image
You can use the brightness values of color images to create 
a mask by converting it to grayscale and then saving the 
image to the object pool as a mask.

Switching tools

A quick way to switch tools without taking your mouse off the
image is pressing the " ` " key in the top left corner of your 
keyboard, (below the Esc. key). A popup menu listing the 
PhotoImpact tools appears for you to choose from.



Original Image

This is the original image. Notice how everything appears somewhat washed out. The black horse does not appear 
black enough, the clearing is barely noticeable, and the hay feeder fades into the background.



Corrected Image

By remapping the colors in the image we have made the darkest color in the original pure black. Similarly, the lightest
color is now pure white. All colors in between have been reassigned proportionally between the two extremes. Now 
the horse is more clear, the clearing is more obvious, and the hay feeder looks more inviting.



Darker

This illustrates what happens if the midtone settings are shifted to the left. More of the original pixels are shifted to 
darker shades than to lighter shades. This makes the image appear as if the photo was taken later in the day. If this 
had been done to a color channel, say the green channel, the grass would be less green. This image might look like it
were taken in early autumn.



Lighter

This illustrates what happens if the midtone settings are shifted to the right. More of the original pixels are shifted to 
lighter shades than to darker shades. This makes the image appear as if the photo was taken earlier in the day. If this
had been done to a color channel, say the green channel, the grass and background would be greener.



Original Image

This is the same adjusted image you saw earlier when the graph was introduced. Notice that the graph looks different
now. That is because we saved the changes to the tone map earlier. This graphs shows the new color distribution.



Example 1

In this example the slope oscillates. Similarly the image seems to oscillate. This is a way you can create an effect 
similar to the ripples from throwing a pebble into water. The greater the number of oscillations, the more ripples. 



Standard Curve

This is the uncorrected grid described earlier. Each pixel is remapped to the same location as its original.



Example 2

In this example the slope starts and ends large but is small in the center. Similarly, the center and edges of the image 
are pinched while the intermediate areas are punched.



Example 3

This example probably best illustrates the impact of slope on the image. Where the angle is steep, the image is 
pinched. Where the line is shallow it is punched.



Using Objects

Base Image Object 1 Object 2

First we took the base image and made an object out of the Ferris wheel. Then we copied the object of the parachute
into the project. Finally we dragged the parachute to where we wanted it to be in the image and merged all the 
objects to the base image. 



Anti-aliasing

The process of smoothing jagged edges of curved shapes in
bitmap images. 

Aspect ratio

The relationship of length to width in an image or selection.

Bitmap / Raster

An image created by arranging pixels (or dots) in rows and 
columns.

Brightness

Brightness describes how much light appears to be coming 
from an image. A pure white image would be considered to 
have maximum brightness while a black one would have no 
brightness.

Burn

A term from photography that refers to the process of 
making areas in a photograph that are too light darker. 

Channel

The color components of a color model. By combining 
channels the final color is achieved. For example, the RGB 
color model has three channels, Red, Green, and Blue. By 
combining the color values from each of these channels the 
intended color can be created.

Imaging Essentials: Color

CMYK

A popular color model for post-process printing. It uses 
subtractive colors (Cyan, Magenta, and Yellow) to create all 
the other colors. A fourth channel, Black is added to create 
varying shades of gray and black.

           Imaging Essentials: CMYK color model   

Color model

A method of describing the colors that can be shown in an 
image.

Imaging Essentials: Color

Complimentary color

The color opposite in value to the currently displayed color. 
Examples of colors and their compliments are Red and 
Cyan, Blue and Yellow, and Green and Magenta. In 



PhotoImpact, if you paint a color onto its compliment using 
the Pigment option in the Merge Control, the resulting color 
will be black.    

Imaging Essentials: Color

Compression

A method of reducing file size for more efficient storage. In 
general, there are two types of compression methods: lossy 
and lossless. Lossy compression usually produces smaller 
file sizes, but some details may be lost. 

           Imaging Essentials: Compression   

Contrast

The distinction between light and dark portions of an image. 
An image with low or poor contrast consists of many closely 
related shades. A high contrast image has clearly 
distinguishable transitions between light and dark areas.

Data type

Similar to color model, data type describes how colors are 
defined in digital images.

           Imaging Essentials: Data type   

Dithering

A method of creating new shades or colors from a pattern of 
other shades or colors. This is most useful in black and 
white images when you want to create gray or when trying 
to expand the number of colors in an indexed color palette.

           Imaging Essentials: Black and White data type    
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Dodge

A term from photography that refers to the process of 
making areas in a photograph that are too dark lighter.

DPI / PPI

A unit of measure for determining the density of pixels in a 
bitmap image. Fro printing and displaying, this also 
determines the physical size of the image.

           Imaging Essentials: Resolution   

Halftoning

A method of creating shades of gray or other colors by 
varying the size of each pixel in an image when printed. This
is another form of dithering.



HSB

A color model for images base upon the color's hue, 
saturation and brightness. Hue determines the actual color, 
Saturation determines how strong the color is. Brightness 
determines the color's intensity.

           Imaging Essentials: HSB color model   

Hue

The quality of a color that enables you to set it apart from 
other colors. For example Yellow and Orange are different 
hues.

           Imaging Essentials: About color   

Mask

A selection area that isolates a portion of an image for 
editing. By placing the mask on an image, you can protect 
areas you do not want to alter.

           Understanding Masks   

NTSC

National Television Standards Committee, an organization 
that defines the standards for television in the United States 
and other parts of the world. These standards include 
restrictions on the range of colors available for displaying on
television. 

PAL

Phase Alteration Line, a standard for television in the UK 
and most Commonwealth nations. This standard includes 
restrictions on the range of colors available for displaying on
television. 

RGB

A color model that defines all colors based upon how much 
of the three primary colors, (Red, Green, and Blue) is 
present in each pixel.

Saturation

A way of describing how pure a color is. If a color is 
saturated, it appears very strong. For example, fire trucks 
and pink carnations are both red. But the red in the fire-truck
is saturated while that of the carnation is not.

Ruby Mask

A term from conventional commercial art that refers to the 



color of a mask placed over an image to isolate areas to be 
modified.

           Understanding Masks   

YIQ / YUV

Variations of the RGB color model used for television. YIQ is
the color model for NTSC and YUV is the standard for PAL.

           Imaging Essentials: YUV / YIQ color model   

ColorTable / Color Palette

For indexed color images, the color table (or palette) lists 
and arranges all the available colors for that image as a 
reference. All pixels in the image refer to this list to 
determine how they appear.

           Imaging Essentials: Indexed color   

True Color

A data type that provides almost real-life accuracy in 
reproducing color. True Color images are at least 24-bit data
types which means that at least 16.7 million colors are 
possible.

           Imaging Essentials: About color   

Indexed Color

A data type that limits the number of available colors for an 
image to those it can fit is a lookup table. A four-bit indexed 
color image allows 16 colors. An eight-bit image allows 256 
colors.

           Imaging Essentials: About color   

Black and White

The simplest data type for images. It consists only of black 
and white pixels. To create shading, dithering or halftoning is
required.

           Imaging Essentials: Black and White data type    
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Vector graphics

Images created based on actual shapes rather than 
individual pixels.

    Imaging Essentials: Vector graphics 

Textures

Uniquely patterned bitmaps that can seamlessly be tiled 
together in an image to serve as a background or fill. 
PhotoImpact has three categories of textures that you can 



add to images:
Natural Textures simulate real-world material such 

as wood grains and rocks.
Magic Textures create seemingly random color 

patterns.
Custom Textures allow you to modify Magic 

Textures to change the hue or patterns.

Plug-in

Plug-ins are additions to the program that are not part of the 
standard package. They ad to the tools, filters, or effects to 
enhance or expand the image editing options available.

Canvas

The canvas is the base upon which the image is drawn.

Moiré patterns

Patterns in images due to poor dithering.

TWAIN device

An industry standard that enables image input devices, 
(such as scanners) and imaging software, (such as 
PhotoImpact) to communicate with each other. That way you
can scan your images directly into the workspace of the 
program you want to edit it in.

Chrominance

Chrominance describes the combination of hue and 
saturation in a color.
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About images
Overview
Computer graphics
Images
Color

Images, when mentioned in the context of computer 
graphics, are usually considered to be bitmaps. They are 
composed up of many dots (called "pixels") arranged on a 
grid. If the pixels are small and close enough, you will not be
able to see them as individual dots. Rather, they will form 
patterns of colors and shapes. It is this arrangement that 
forms recognizable pictures for us to see.

The simplest images only contain black or white pixels. 
Shades and "grays" are formed by combining them in 
patterns that the human eye has trouble noticing. For 
example, the gray rectangle below is actually a pattern of 
black and white pixels. The inset shows the actual pattern 
used to create that shade.

More complex images can contain over 16 million different 
colors. However, these additional colors come at the cost of 
increased file size.

When thinking about computer images, there are three 
things to consider:

           Data type   — for dealing with color and shading.
File Format — to determine how the computer 

stores and reproduces information.
Resolution — to determine the size.

While the number of colors a computer can display may be tremendous, that does not mean you can tell them all 
apart. It is commonly accepted that the human eye can only distinguish between 10,000 or fewer colors at any given 
time. For further details, read About     Color  



Data type
Overview
Computer graphics
Images
Color

The data type determines how many colors an image can 
contain and how they are determined. Although most 
computers can display almost any data type, how it appears 
may vary. For example, a black and white monitor can 
portray color images, but the colors appear in black, white, 
and shades of gray. Similarly, a true color image can be 
shown on a 16-color display, but many of the colors will be 
dithered, (patterns of other colors).

No discussion of data type is complete without mentioning 
the number of bits it is composed of. It is this number that 
determines how many colors can exist in a single file. By 
raising two to the power of bits you can find out the 
maximum number of colors possible. For example, a black 
and white image data type is a one-bit data type. Thus you 
can only have two colors: black or white. Alternatively, an 
eight-bit data type allows 2 to the 8 (256) different colors. 
The amount of memory needed is directly related to the 
number of bits, so an image with a 16-bit data type would be
four times larger than the same image with a four-bit data 
type.

Currently, there are six widely accepted data types used in 
PCs today. In order of the amount of memory required, 
(least to most), they are:

Black and White    (1-bit)
Indexed 16-color    (4-bit)
Grayscale    (8-bit)
Indexed 256- color    (8-bit)
RGB HiColor    (15- or 16-bit)
RGB True Color    (24-bit)

Black and White
Black and White is a one-bit data type. That does not mean
that shades of gray are impossible though. By combining 
black and white pixels in special patterns, an illusion of 
lighter or darker shades can be created. For example, the 
gray square below is actually a pattern of black and white. 
The inset shows the actual pattern:

Grayscale
Grayscale images are eight-bit data type images. They 
contain black, white, and 254 different shades of gray. If you 
are working on images for black and white printing, this is a 
good format to work with. You can easily draw and modify 
images to create the shading and accents you want. When it
is time to print out, you will have a very good idea about the 
appearance of the actual printout.

Indexed Color

Indexed color images have color tables    to define which 
colors can be used. The Indexed 16-color data type is a 4-
bit data type while the 256-color data type is an 8-bit data 



type. Just like black and white images, additional colors can 
be simulated by combining existing colors in a pattern. For 
example, the 16-color image below creates purple by using 
a pattern of red and blue pixels:

Since each image can have its own unique table, the 
choices of available colors for two different images may be 
completely different.

 RGB
RGB stands for Red, Green, and Blue, the three colors your 
monitor uses to create all its colors. There are currently two 
popular RGB data types; HiColor and True Color. HiColor is 
a 15- or 16-bit data type and can produce 32,268 or 65,536 
different colors respectively. RGB True Color is a 24-bit data 
type and can produce over 16.7 million colors. Both of these
data types are particularly useful if you are working with 
photographic quality images on your computer.

To understand how the RGB data types work, lets look at 
the True Color version. RGB True color divides its 24 bits 
between Red, Green, and Blue so that each color has eight 
bits. Thus, there can be 256 shades of each color ranging 
from 0, (none), to 255, (intense). By combining shades of 
each color together, other colors in the visible spectrum can 
be created.

 The problem with RGB True Color is that it demands huge 
amounts of memory. To limit this problem, RGB HiColor was 
developed. There are two forms of RGB HiColor and they 
each work a little differently: 15-bit RGB HiColor, rather than 
devoting eight bits to each color, only assigns five. Thus 
Red, Green, and Blue each have only 32 shades. 16-Bit 
RGB usually devotes an extra bit to one of the primary 
colors.

A color table is a list of the allowable colors for a given image. By defining the Red, Green, and Blue values for each 
space in the table you can determine which colors that image can contain. For more detailed information, read About
Colors



As a rule, green is usually allocated the extra bit because the human eye is more sensitive to it.
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Almost every computer program has its own unique way to 
store information for later retrieval. The way programs 
organize this information is what makes up the file format. 
There are probably over 100 different file formats for 
graphics files alone. Some of these files are unique to 
specific programs while others are general formats that 
extend over several platforms. The two things to consider 
when discussing file formats are

Representation Scheme – how the computer 
interprets data to reproduce it.

Compression Scheme – how the computer 
utilizes memory to store the image.

Representation Scheme
Bitmap files may be broken down into two or more sections. 
Each section has a unique function to tell the computer how 
to reproduce the file. The simplest bitmap image files will 
have two or three parts: the header, bitmap data, and 
optionally, the footer.

The header contains important information to prepare the 
computer for the data that follows. It may include some or all
of the following items:

Bitmap data makes up the bulk of the file. It contains the 
“meat” of the information. It consists of values for each pixel 
in the image. The computer reads these values, and using 
the information from the header reproduces them in the 
proper place in the image.

The footer is an optional addition to the format. In many 
cases, information in the footer consists of data that was 
omitted from the header because of version changes.
 
Compression
There is an unwritten law that states, "No matter how big 
your hard disk is, you always need 10 MB more." Depending
on the size and data type, images can be major contributors 
to this problem. For example an uncompressed, low-
resolution, (100 dpi), one-page, black and white fax would 
occupy about 935 KB. Imagine how much more space 
would be required for full color images! That is where 
compression comes in, it manages the image data so that 
less space is required to store the image.

Most compression schemes fall into one of two categories: 
lossless and lossy. Lossless compression means that no 
data is irreparably altered in the process of "shrinking" and 
"expanding" a file. Lossy compression, however, does 
change the original data. In most cases, the changes are 
insignificant, and rarely can the naked eye make them out 
even when magnified to sixteen times normal size. The 
advantage of lossy over lossless is that lossy schemes 
usually offer much better compression ratios. Thus, files are 
smaller.

Think about the compression method when saving images. 
If you have a True Color or other high quality image where 
there are few similarities from pixel to pixel, using lossless 
compression can actually result in a larger file! On the other 



hand, if you work on an image with a large solid background
or one-color regions, you can save valuable disk space. 
Similarly, don't be put off by lossy compression schemes. 
Usually, the depreciation of the data is too small for most to 
see. Click below to see if you can tell the difference between
compression methods:

Can you tell the difference between compression methods? 

The most common compression methods are:
Pixel Packing — More a memory management 

scheme than compression method, it shifts data to fill every 
available memory register instead of isolating each piece of 
date in its own byte register. Using pixel packing often slows
down performance when opening and closing files.

Run Length Encoding (RLE) — A compression 
method that looks for continuous occurrences of the same 
information. It then stores that occurrence in two bytes. The 
first byte defines the number of repetitions; the second what 
is to be repeated. For example, the string "AAAAAAAAA" 
would    become "9A" (9 bytes becomes 2 bytes) This type of
compression is good for simple images with large 
continuous color areas. But if a file has few or very small 
continuous region, it could cause the file to grow in size 
instead of shrink. The best way to demonstrate this is to use
a simple sentence: "Reading books is good." This sentence 
is 21 bytes long, (including spaces and the period). Using 
RLE compression, it would be 38 bytes long, almost double 
the size! 

CCITT — A .compression method that uses a 
predefined look-up table to identify and replace expected 
patterns in the actual data. Think of this as shorthand for 
computers.

 LZW — A proprietary compression method that 
uses a look-up table called a dictionary. The difference is 
that it creates its own dictionary from the original data. So 
the dictionaries in LZW files tend to be smaller and more 
well suited to the specific data they represent. Similar to 
RLE compression, images with few regular patterns would 
likely grow instead of shrink using this compression.

JPEG    A was developed to create a standard for 
sending images over digital communication lines. Although it
is a lossy compression method, most high and true color 
images compressed with it show little or no degradation, 
thus it is becoming one of the most popular ones in use 
today. The methods used to achieve JPEG compression 
vary and are and difficult to explain.

Here are two eight gallon barrels. The first one is half full of red sand; the second of green. To save barrels, we are 
going to put the green sand on top of the red sand, making sure neither color mixes.





This image contains 121 red, green, blue, brown, or white pixels. The picture below shows a possible way of coding 
the bitmap where R means Red, G means Green, B means Blue, N means Brown, and W means White. When we 
store this image without compression, it might look like: BBBBBBBBBBBBBGGBBB.....BBBBBRRRRRBBB. The total 
amount of memory used would be 121 bytes. Using RLE compression, this might become 13B2G3B.....5B5R3B. The 
total memory used would be 82 bytes, a 25% reduction in size.



What kind of compression is being used?
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The resolution is the number of pixels in each inch of an 
image and is measured in ppi, (pixels per inch) or dpi, (dots 
per inch). At first, it can be a little confusing because it can 
have different significance depending on what you are 
doing. When scanning an image resolution affects its clarity;
higher resolution scans are more precise. Once an image is 
in the computer, it takes on a whole new meaning. Now it 
represents image size. If you change resolution, the number
of pixels remains the same, but their individual sizes and 
proximity to each other changes. So, If you scan an image 
at one resolution, and then increase the scanned image's 
resolution to a higher one, the resulting image, when 
printed, will be smaller. However, if you look at it on your 
monitor, you will see no changes in the size because your 
monitor's resolution and the total number of pixels did not 
change.

About computer graphics
Overview
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There are three general formatting methods for representing
graphics on a computer:

Bitmap – Images are defined as a series of dots, 
each having its own assignment in a grid.

Vector – Drawings are composed of shapes 
defined by starting and ending points for lines to make each 
shape.

Metafile – Pictures combine both bitmap and 
vector characteristics, using the vector format to define 
shapes, outlines, and fills but the bitmap format to do 
complex shading and coloring.

Bitmap graphics
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Files that use a bitmap format are often referred to as 
images. They define the picture with an assignment for each
pixel in the picture. Most images produced by scanners, fax 
machines, and other optical input devices produce bitmap 
images. An other popular use for bitmap files is photographs
and other images requiring a wide array of colors or filled 
regions. 
Bitmap Plusses and Minuses
The advantages of bitmaps are:

They are easy to create and store
They are easy to reproduce on several different 

types of output devices
Bitmaps offer tremendous flexibility in displaying a 

range of colors
It is easier to create solid colors with bitmaps

The disadvantages to bitmaps are:
Files tend to be very large when compared with 



other formats
Editing shapes can be very difficult, especially if an 

image is composed of many similar colors.
Resizing bitmap images often results in noticeable 

distortion to the original data.

Vector graphics
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Computer graphics began with the vector format. This is 
because many of the devices used to display and print were 
not pixel based, but line based. The displays were modeled 
after the oscilloscope, and drawings were printed on devices
called plotters.

Vector graphics do not concern themselves with each pixel 
in the drawing. They are shape-based formats composed of 
one or more objects. Each object is defined by two (or more)
points that define its shape. For example, a straight line 
would have two points marking the start and end. A square 
might consist of two or four points to mark the line segments
or shape. 

The vector format is most useful for drawings where high 
levels of accuracy and smooth, well defined lines are most 
important. Some examples include blueprints, exploded 
view drawings, and poster art.
Vector Plusses and Minuses
The main advantages of vector formats are:

They can easily be scaled up or down with 
marginal loss in accuracy.

They are well suited for creating three dimensional 
drawings.

Vector file sizes are usually much smaller than 
similar looking bitmaps.

The disadvantages to vector formats are
They can be highly dependent on the device that 

displays or prints them. 
The detailed attention to shading and color 

required for photographic quality is practically impossible.
Detailed vector files may take longer to draw on 

screen or print out since each object is independent of 
others in the file.

Metafile graphics
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At first glance, metafiles would seem to be the ideal file 
format because they combine both vector and bitmap 
characteristics. While the format may be nice in its final 
form, there are many complications associated with 
designing software that can create and work on metafiles 
effectively. For this reason, many programmers avoid using 
this format. The primary use for metafiles is for transferring 
files over different hardware platforms.



Metafile Plusses and Minuses
The advantages to metafiles are:

They are usually extremely portable.
Uncompressed, they tend to be smaller than a 

similar bitmap.
They compress well.

The primary disadvantage to metafiles is
They are very complex and difficult to edit.

For a more complete explanation of the issues involving images and computers, see Images.
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 Colors are formed by light reflected off a surface. Although 
there are an infinite number of colors in the world, there is a 
limit to how many we can see. Without considering a 
person's age or health, the first limitation comes from the 
visible spectrum. Only light between 380 (red) to 770 
(purple) nanometers in wavelength is visible by the human 
eye. We can see any color in this range, but it is generally 
believed that people can only distinguish between 10 to 16-
million different colors. Further, even under the best lighting 
conditions, in any single moment, the range is limited to 
somewhere around 10,000. And under poor or colored 
lighting, this number is further reduced.    

It is important to remember this when working with digital 
color because there is a very real limit on the number of 
colors you can display or produce depending on the format, 
available memory, and your equipment. On the PC platform,
the fewest is two, Black and White, while the most 
sophisticated color formats may allow over 68 billion colors 
at one time!

Depending on your needs, there are several different ways 
for generating colors. Each has its own strengths and 
weaknesses. The most common models are:

RGB Cube — Generally used with light emitting 
devices like TV's and monitors

CMYK Color Model — Usually used for printed 
media like books

HSB Cone — A popular format for photographers 
and painters

YUV / YIQ Color Model — A variation of the RGB 
Cube used for sending images over digital networks.

RGB color model
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Computer graphics
Images
Color

The RGB model is an additive color model. By that we mean
color is added to black to create the new ones. The more 
color you add, the closer to white you can get. This color 
model is built around the three primary colors of Red, 
Green, and Blue.



This picture of an RGB cube illustrates how the system 
works. The color red starts from nothing and gradually 
increases along one horizontal (x) axis. Along a second 
horizontal (y) axis the same thing is done for green. The 
vertical (z) axis uses blue. At the point where all three axes 
meet, there is no color, hence black. Diagonally through the 
cube, across from this point, Red, Green, and Blue are fully 
represented, creating white. If you could see the line 
connecting these two points, you would see shades of gray. 
As you move away from the origin along each axis, the 
value for that color increases. New colors result from 
combining the primary colors in proportion to the distance 
from the origin.

This color model is most popular in luminous media such as 
computer monitors and televisions. The reason is that when 
these devices are off, the display goes dark (black). So, 
adding colors to the existing black is easiest.



notused



HSB color model
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The HSB cone is a completely different concept from the 
RGB and CMYK models. Rather than using three primary 
colors to create new ones, it treats every color of the 
spectrum as its own unique entity (Hue). Then black is used 
to control the brightness and white the purity (Saturation).

The colors of the spectrum are arranged in a circle around 
the top of the cone and identified according to their position 
relative to red. The three primary colors are arranged 120° 
apart with their complements directly opposite. Pure white is
at the top center of the cone and black at the apex. If you 
follow a line from the outer edge to the center, you will see 
color getting brighter until the bright white is achieved. 
Similarly, if you follow a line from the outer edge to the apex,
color darkens until only black is visible.

The best example of how the HSB model works is shown in 
painting. Generally speaking, artists will pick pure colors to 
work with. Then to tint the color, they add white. To shade, 
they add black. Finally, to create a tone, they will combine 
black and white with the pure color.

YUV / YIQ color model
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These models are variations of the RGB model. Their 
primary uses are for sending television signals, (YUV for 
PAL and YIQ for NTSC), but is also of interest because of its
application in JPEG compression. This model interprets 
colors in terms of the luminance (Y), and two degrees of 
chrominance or color (U,V). The biggest downside to this 
model is that it actually changes some data during the 
conversion.

Try looking at a picture of the bright blue sky under a fluorescent white light and then under a yellow light. In the 
second case, the sky will take on a green tint. Under these conditions, some colors you might otherwise easily 
distinguish may be masked by the environment.



Don't be too discouraged by the implied limitations of Black and White. By combining these two colors smartly, 
several other shades can be simulated in many types of images. For more about how to create more colors from a 
small palette, see Images - Data Type.



At first, you might think slides and film would use the RGB color model. Actually, CMYK is more popular. This is 
because the media upon which we are viewing is not the light that projects the images; it is the wall or film where it is 
projected.



This is an uncompressed image. It is about 65 KB.



This image was saved using JPEG compression. This lossy compression scheme reduced the total file size from 65 
KB to a little more than 9 KB! 



This image is compressed with a lossless compression method. But when the file was saved the size increased from 
65 KB to 66 KB! The reason for this is that there are so many dissimilar colors and no easily recognizable patterns.



This picture illustrates three types of vector shapes. Using the upper left corner as the reference, image A shows the 
simplest vector shape, the line. Two points identify the ends and a straight line connects the points. In a file, this 
might look like "line,1,1,6,8" Image B is a square. One possible way to represent it could be "Square,11,2,17,8", 
which identifies the shape an two diagonal corners. Image C is a curved line. It might be represented as 
"Arc,3,15,8,12,13,18,16,18" The program would calculate the curvature for a line to connect those points in 
sequence. 
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There are over one hundred different graphics file formats 
currently in use on computers. It would be impossible to 
cover them all here. Click below for details about the formats
supported by Ulead programs:
BMP PCX PSD UFO
CUR PCD TGA
JPG PNG TIF

Key

Key

This is a key to the symbols appearing to the left of each 
format description.

Full Supported Ulead programs can open and save them.

Partial Support Ulead programs can open these files but 
can only save them as bitmaps.

Read Only Ulead programs can read these files, but cannot 
save to the same format.

PC Paintbrush (PCX)

Originally developed by ZSoft Corporation for their PC 
Paintbrush program, this format gained early popularity. 
Shortly after its development, ZSoft entered into several 
OEM agreements with early fax board and scanner 
manufactures. As a result, this format has become an 
important standard on the PC and other desktop platforms. 
It supports all data types. 

Some PCX images do not include resolution information in 
their headers. If a Ulead program opens such an image, it 
will automatically match the image resolution with the 
current display resolution.

Bitmap (BMP)

This is a widely recognized format made popular by 
Microsoft Windows and IBM OS/2. It supports several data 
types ranging from black and white all the way up to 24-bit 
True Color. It is good for images you want for your Windows 
wallpaper or to distribute to others who you know have 
Windows, but are not sure of what else. Although the BMP 
format supports RLE compression, most programs 
(including Ulead) do not take advantage of it.



Microsoft Windows Cursor (CUR)

You mouse pointer likely uses (or at one time used) 
the .CUR format. The features that set apart from most other
file formats are:
1. It can only be 32 x 32 pixels in size.
2. It is a 2-bit data type, using Black, white, transparent, and

inverse.

When Ulead programs open .CUR files, the transparent 
color appears as white and the inverse color as black.

JPEG File Interchange Format (JPG)

The JPEG format is best suited for digital photographs and 
other natural-looking images. It is not as good for precise 
artwork such as line-art. This is because some "averaging" 
takes place during compression, and edges may be blurred. 
In photographs, this is not so noticeable because such 
sharp edges are rare.

It uses a lossy compression method to achieve compression
ratios of up to 100 to 1. This is far better than 10 to 1 which 
may be the best most other compression methods might 
produce. This format supports grayscale and True Color 
data types; because it uses a lossy compression method, 
indexed and black and white data types do not reproduce 
well and are not supported. One interesting feature of this 
format is that you can vary the degree of compression. So 
you can decide what level of data retention vs. space 
savings is best for your needs.

Kodak Photo CD (PCD)

When the prospect of using computers to save images 
became a reality, Eastman Kodak developed this format to 
store photographs digitally. This proprietary format is used 
by images in Kodak CDs. To support multiple display modes,
each PCD file contains image data in 5 resolutions, and 
allows you to choose between viewing the image in True 
Color, indexed 256 color, or grayscale.

Adobe PhotoShop (PSD)

This format was created by Adobe Systems Inc. for use with 
their high-end image enhancement program. It supports all 
data types and is one the most popular formats for 



professional photographers who use desktop computers to 
touch up their work.

Targa (TGA)

This format, one of the principal true color image formats, 
can store image data with up to 32 bits per pixel. Compared 
to TIF and JPEG which are other options for true color 
images, TGA is relatively simple and therefore widely used 
in imaging programs. The only drawback to this format is 
that it lacks a good compression scheme.

Tagged Image File Format (TIF)

This is a standard file format for most imaging programs 
which supports all data types from monochrome up to 24-bit 
true color, as well as many color models and compression 
schemes. An even more powerful aspect of TIF is that its 
files can move easily between platforms, making it an ideal 
format for storing image data.

    About images 
    Data type 
      File format   
    Resolution 



    About computer graphics 
    Bitmap graphics 
    Vector graphics 
    Metafile graphics 
    Ulead supported file formats 



Ulead File for Objects (UFO)

This proprietary file format was designed by Ulead Systems 
for use in PhotoImpact. It is the only format supported by 
Ulead programs that allows objects that have not been 
merged to the base image to be retained. UFO files use 
RLE or no compression when saved.

Portable Network Graphics (PNG)

PNG, pronounced "Ping," was developed to replace the GIF 
format which lost popularity due to proprietary concerns. It is
designed primarily for sharing image data on line. Perhaps 
one of the most fascinating aspects of this format is how it 
opens images. Unlike most other file formats, this one is 
designed to show a representation of the image as fast as 
possible. When opening a PNG image, it first appears out of
focus and gradually becomes more clear. In this way, you 
gain a better idea of the entire image faster, (and can cancel
a download sooner if you see that you don't want it). Another
feature, especially designed for on-line concerns, is easy file
checking for transmission accuracy and against file 
corruption.    PNG supports indexed 256 color, true color, 
and grayscale data types.

CMYK color model
Overview
Computer graphics
Images
Color

The CMYK color model is a subtractive color model. By that 
we mean that new colors come from the removal of color 
from white.

Like the RGB cube, the CMYK model is based on three 
primary colors — Cyan, Magenta, and Yellow. If you look for 
these colors on the RGB cube, you will see they are 
complements (opposites) of the RGB colors. (Cyan is 
complement of Red, Magenta of Green, and Yellow of Blue.)
These colors differ from the RGB primary colors in that they 
absorb instead of reflect light.

At the origin, (0,0,0), no color would be removed and white 
would result. Similarly, if sufficient amounts of all three 
colors were blended, all red, blue, and green would be 
absorbed, hence black.

So we see what C, M, and Y mean in CMYK, what about K? 
K represents a fourth channel added to the model for Black 
and Grays. In an ideal environment, this channel should not 
be necessary, but in the real world, blending cyan, magenta,
and yellow rarely produces a rich, dark black; it usually 
creates a dark muddy brown. This is due to subtle impurities
in the colors when they are blended. To overcome this 
problem, a pure black (and gray) channel is added for when 
those colors are needed.

The CMYK color model is used primarily in the printed 
media. This is because printed surfaces are reflective, (that 



is they allow us to see colors not absorbed by the surface). 
By using colors from the CMYK model, we can influence 
which colors are absorbed and which are reflected.

    About color 
    RGB color model 
    CMYK color model 
    HSB color model 
    YUV / YIQ color model 



Technical support
Technical support
How to contact us

Please prepare the following information before contacting 
us so we can offer you the best possible support:

The program name and serial number.
Nature of the problem.
Any error messages or dialog boxes that appear 

when the problem occurs.
System information including CPU, operating 

system, and any other programs running when the problem 
occurs.

If you write or fax us, please add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD32.INI

Note: You can open most of these files at once by running 
SYSEDIT.EXE, found in your Windows program directory.

How to contact us
Technical support
How to contact us

Click below for more information on contacting us.
North and South America  

International

. Phone .

. Fax .

. Mail .

. BBS .

. E-Mail .

Call 

+886-2-764-8599 



Send a fax to

+886-2-764-9599



Send a letter to

Ulead Systems, Inc.
10 F, 111 Tung Hsing St,
Taipei, Taiwan, R.O.C.



WWW

http://www.ulead.com
E-Mail

mkt@ulead.com.tw
Dial up the Ulead BBS at

+886-2-764-7585 19200 bps (N,8,1)

Compuserve

GO ULEAD



Call

(310)-523-9391 



Send a fax to 

(310)-523-9399



Send a letter to

Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502



WWW

http://www.ulead.com
E-Mail

mkt@ulead.com
Dial up the Ulead BBS at

(310)-523-9389 19200 bps (N,8,1)

Compuserve
GO ULEAD



Send E-Mail to

support@ulead.com
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This section contains detailed explanations of concepts you 
will work with in PhotoImpact. By understanding these ideas,
you will be able to work more effectively and choose the 
commands, tools, and effects you need with better accuracy.

Most of the topics in this section are fairly long and require 
some thought. Try reading them when you have some spare
time and want to develop your skills rather than when you 
have an important job to complete quickly.

Object-based editing
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Object-based image editing is a powerful editing method 
that adds versatility and ease to detailed image editing 
tasks. Its primary advantage is that you can make several 
changes and enhancements to an image without 
permanently changing the original until you are ready. This 
enables you to experiment more freely with shapes, 
backgrounds, frames, and other objects in an image.

You can mix, match, move, and modify objects in an image 
until you find the perfect arrangement. Once everything 
looks right, just merge the objects to the image and save.

Objects
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Objects are the foundation of editing images in PhotoImpact.
They are images or selections that float above the image (or
base). As long as they remain objects, you can move and 
change them without affecting the original image. Once you 
complete all your changes to an object, you can merge them
to the base image. Then they become part of the base.

Each object occupies its own layer above the base image. 
By changing the layers you can place objects above and 
below each other. In this way you can hide parts of one 
object behind another. Click below for an example.

Reference -- Layer Manager

Masks
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Masks are selections that isolate a portion of an image so 
you can edit it without affecting the rest of the image. In 
PhotoImpact, you can create two types of masks: a regular 
mask, (marquee), or a grayscale mask.

A regular mask is a simple transparent shape. Any part of 
the base image under the shape can be changed. Anything 
not covered by the shape is "masked" or protected. These 
types of masks are generally referred to as marquees.

A grayscale mask is similar to a regular mask except the 
area is covered by a grayscale pattern. Depending on the 
grayscale value of each pixel in the mask, changes you 
apply to the image may be more or less significant. If the 
mask is white, then it is clear and the base image may be 
changed; if it is black, the mask is opaque and the base is 
protected. In between values produce in between results. 
For example, if the value is a middle gray, then the change 
to the base image will be 50% of the applied change 
blended with 50% of the original image data.

Some uses for masks include protecting parts of your image
when painting, creating, shading, and colorizing black and 
white or grayscale images.

 Creating a grayscale mask
 Precision selecting 
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A good understanding of color mapping can go a long way 
to making your final images better. That's because you can 
quickly and easily optimize your images to use the colors or 
shades that are most important for your image.

PhotoImpact offers you two ways to remap the colors in 
images. Both are available from the Tone Map command in 
the Format Menu. For best understanding, let's look at the 
histogram in the Highlight Midtone Shadow tab of the Adjust 
Map dialog box:

The gray shape in this graph shows the distribution of colors
in the image where the darkest shades are to the left and 
the lightest shades to the right. This image uses a lot of mid 
tones but no very dark or very light ones. As a result it looks 
washed out. If we can increase the dynamic range, perhaps 
it will look better. Click on the graph to see the image for this
graph.



By increasing the Highlight setting the top of the graph 
moves to the left; by reducing the Shadow setting, the 
bottom of the graph moves right. This reassigns the original 
pixel values (horizontal axis) of    the image to new values 
based on the new curve. In this example, we have    made 
the lightest color in the original image pure white, and the 
darkest pure black. Thus we have increased the dynamic 
range, (range of colors available), for the image. Click on the
graph to see how the image looks now.

But dynamic range is rarely the only problem images 
encounter. Many times the brightest and darkest areas are 
fine, but the image seems to dark, too light, or too rich (i.e. 
too red). That's where adjusting the mid-tones come in. 
While adjusting the shadow or highlight changes the full 
range of colors, changing the midtone adjusts how the range
is distributed. By changing the shape of the curve, you can 
lighten or darken an image; or emphasize or reduce the 
impact of a particular color in the image. Click on the graphs
below to see how shifting the midtone curve affected the 
image.
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This is probably one of the most complex concepts    to 
understand in PhotoImpact. But it is one of the simplest to 
apply. All    pixel mapping does is give you a high level of 
control for adding and combining sphere-like effects such as
Pinch and Punch.

The best way to see what is happening is to use a grid such 
as the image on the left. The red pixel in the middle 
represents the center of the grid. This is an important spot 



Pixel mapping because everything the Custom Effect does is symmetrical 
to that point. 

Here is the graph the Custom Effect uses to redistribute 
image pixels. The origin, (bottom left corner represents the 
center of the red dot in the image above. The horizontal axis
represents the placement of all pixels in the image. The 
slope of the curve determines the new location for the 
pixels.

If the slope of the curve at a given point is between -1 and 1,
(not including 1,-1, and 0), the image will be punched. If the 
slope is greater than 1 or less than -1, it will be pinched. If it 
is -1, 0, or 1 it will be unchanged.

This means, if you change the slope near the left side of the 
graph, you affect the pixels closest to the center of the 
image the most. If you change the slope near the right side, 
pixels near the image edges are most affected.

Experiment with the Custom Effect. In the beginning it may 
be confusing. And you probably won't have occasion to use 
it often. But when you do want it, it is a powerful aide to 
editing. Click below to see some examples of how changing 
the curve affects the image:
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Simply merging an object to the base of an image can often 
produce unwanted results. Often edges of the merged 
object stand out from the image and you can clearly see 
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where changes were made. There are a couple of ways you 
can prevent these kinds of unwanted results:

Apply a soft edge to your object. This causes the 
edge to gradually blend into the background.

Use the Blur (        ) or Smudge (        ) tools to
mix or smear the edges of the objects with the base after 
you merge them.

There are also other things you can do when merging 
objects. For example, you can use different merge options 
to change how the colors blend with the base image. 
Depending on the image's data type and the current tool or 
dialog box these are the options available for merge control 
and what they do. Click the button before each option to see
an example of what each does:

Base Image Object to be merged
Always Replaces the original data with the painted

color.
Hue and Saturation Bases the blend on the color 

and its richness.
Hue Only Bases the blend on the nature of the 

color only, ignoring brightness and saturation.
Saturation Only Bases the blend on the purity of 

the color pixels in the object.
Luminosity Only Blends only the lightness values 

of the colors.    
If Lighter Paints over the image only if the painted 

color is lighter than the background.
If Darker Paints over the image only if the painted 

color is darker than the background.
Lighting This merge control is only available in the 

Object Properties dialog box. It enhances the base image 
based on the grayscale equivalent values of the object. If 
the grayscale values are below 128 (neutral gray), 
PhotoImpact darkens the image slightly. Otherwise 
PhotoImpact lightens the image slightly. This might be useful
for subtle highlighting.

Difference Uses the absolute value of the 
difference between the RGB values for the base image and 
those of the object. For example, if the base color is    
10,210,125 and the object is 30,100,100 the resulting color, 
when merged, will be 20,110,115. This is useful for 
comparing two images with similar backgrounds. The parts 
that are significantly different will appear clearly while the 
rest will disappear.

Addition      Adds the RGB values of the base 
image and the object together. For example, if the base 
color is 10,210,125 and the object is 30,100,100 the 
resulting color, when merged, will be 40,255,235. (Note that 
sums greater than 255 are rounded down to 255.) You might
use this method to lighten areas where your images overlap.

Subtraction    Subtracts the RGB values of the 
base image from those of the object. For example, if the 
base color is 10,210,125 and the object is 30,100,100 the 
resulting color, when merged, will be 20,0,0. Note that 
values less than 0 are rounded up to 0.) You might use this 
method to darken where your images overlap.



Multiplication Multiplies the RGB values of the 
base image by those of the object and then divides the 
result by 255, rounding to the closest integer value for each 
color channel. For example, if the base color is    10,210,125
and the object is 30,100,100 the resulting color, when 
merged, will be 1,82,49. This might be a good way to darken
and highlight where your images overlap.

Division    Multiplies the RGB values of the base 
image by those of the object and then divides the result by 
255, rounding to the closest integer value for each color 
channel. Then PhotoImpact subtracts the value from 255 
and uses this result for the image. For example, if the base 
color is    10,210,125 and the object is 30,100,100 the 
resulting color, when merged, will be 254,173,206. This is a 
good way to make the image much lighter where you merge,
as if it were whitewashed or bleached.

Pigment This merge control is only available with 
the paint tool. It blends the painted color with the existing 
base image colors similar to the way an artist creates new 
colors by mixing paints.    (Note: White has no effect on the 
base image when using this merge control.)

Always

Notice how the object completely replaces the base image.



Hue and Saturation

Notice how colors tend to be more rich and vivid now.



Hue only

Notice how the changes only occur where the hue of
the object is stronger than that of the base image.



Saturation only

Notice that only the colors in the object that were fully saturated
affected the base image.



Luminosity only

Notice that only the brightest colors in the object affected
the base image.



If Lighter

Notice that the colors in the object replaced those in the 
base image only where the object was lighter.



If Darker

Notice that the colors in the object replaced those in the 
base image only where the object was darker.



Lighting

Notice how there is a faint outline of the object over the base.



Difference

Notice how the overlapping areas in the color squares are
the same.



Addition

Notice how all colors in this image are bright. Also notice how
distinctly different colors, when merged result in new colors
that did not exist in either original image.



Subtraction

Notice how all colors in this image are dark. Also notice how
distinctly different colors, when merged result in new colors
that did not exist in either original image.



Multiplication

Notice how this image becomes darker while still retaining
some of its original basic structure



Division

Notice how this image becomes lighter while still retaining
some of its original basic structure.



Pigment

Note: The Pigment merge control is not available 
for object merging. We created this using the
airbrush tool on the original base image.



Base Image



Object to be merged



Merge Factor

Determines how PhotoImpact blends painted colors with the
underlying image. The options you have for blending objects
depends on the color model of your image and the current 
tool or dialog box. For a complete explanation of each 
merge control feature, see About Merging Objects in the 
Understanding PhotoImpact Basics section of the help. 
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The Fill tool offers four ways to fill an area with color. 
Depending on the selected tool and its settings, the fill can 
be a solid color or gradually changing range of colors. Scroll 
down or click below to learn more about the fill tool.

    Bucket          Linear          Rectangular          
Elliptical

    Bucket
Fills the object with a solid color or pattern.

    Linear
Fills the object with gradually changing colors starting from 
one point and extending to the along a straight line another. 
Anything beyond the start and end points for the fill within 
the selected area is filled with the start and end colors.

    Rectangular
Fills the object with gradually changing colors starting from 
one point and extending outward along four lines to the 
corners of a rectangular shape. If the outer edge of the fill 
occurs before the edge of the object being filled, the 
remaining area is filled by the end color.

    Elliptical
Fills the object with gradually changing colors starting from 
one point and extending radially outward. If the outer edge 
of the circular fill occurs before the edge of the object being 
filled, the remaining area is filled by the end color.

not used
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The Select submenu appears when you right click on a 
selection or the base image. Click below for more 
information. 

    Edit Text     Similar
    Undo     Soften
    Select Base Image     Convert to Object
    Select Prev. Selection     Merge All
    None     Load Selection
    All     Save Selection
    Invert     Copy Sel. to Obj. Library 
    Border 

Click Menu commands on the left for help on other 
PhotoImpact menus.

Help Menu
Workspace
Menu commands
Dialog boxes
Advice

The Help menu contains these commands for getting 
information. Click below for more information.

    Ulead PhotoImpact Help 
 Internet Imaging
    About Ulead Products 
 On-line Registration
    About PhotoImpact 

Click Menu commands on the left for help on other 
PhotoImpact menus.

    File Menu
    Edit Menu 
    View Menu
    Format Menu 
    Effect Menu 
    Window Menu
    Help Menu
    Switch Menu
    Select Menu
    Object Menu
    EasyPalette Menu
    Object Library Menu
    Color Picker Menu
    Other Popup Menus



Brightness & Contrast dialog box
Makes an image lighter or darker and allows you to make parts of it stand out or blend in more.

Preview Images The center image shows the current settings for the image. Clicking one of the others 
adjusts the settings, and places an image with those settings in the center. 

Real-time preview Check to instantly show changes in the actual image. The change is not officially applied
until you click OK.

Thumbnail Choose a portion of the active image to show in the dialog box preview window.
Brightness Choose higher values to produce a brighter image.
Contrast Choose higher values make the midtone colors standout more.

           Gamma    Shifts the midtone colors in the image without affecting those at the extreme ends of the color 
spectrum.

Thumbnail variation Control how much of a change clicking on an outside preview window has on the 
image.

Channel Specify which color channel to adjust.
Add Add the settings for this dialog box to the My Gallery.
Reset Returns all dialog box settings to the conditions they were in when the dialog box opened.
Preview Click to see how the changes affect the actual image before applying them.



Darkest colors (black, pure red, and pure cyan, for example) and lightest colors (white) are unaffected by adjusting 
the gamma. Midtones, (grays, pinks and oranges, for example) will shift.



Frame & Shadow dialog box
Applies a border, background, and shadow to the base image.

Frame Choose the width and color or pattern for the border. (The border immediately surrounds the image.) 
You may choose any of these types of frames for the image:

Color A single color border matching that of the color square. To choose a different color, right click on the 
color square and choose the desired command for selecting a new color.

Magic texture Create a multi-color border matching that of the texture square. To change textures, click 
Library and choose from the samples in the Magic Texture dialog box.

Natural texture Create a natural looking multi-color border matching that of the texture square. To change 
textures, click Library and choose from the samples in the Texture Library dialog box.

Shadow Choose the size and color of a shadow to go around the border.
Color and Direction The shadow color will match that of the color square. To choose a different color, right 

click on the color square and choose the desired command for selecting a new color. Then select the option that 
shows a shadow in the direction you want.

X    and Y offset Set the size, in pixels of the shadow. (X is horizontal, Y is vertical.)
Transparency Set a higher value to allow more of the underlying image to appear through the shadow. 
Edge blending Set a higher value to have the shadow blend into the background more smoothly.
Canvas Set the size and color for the background.
Color Choose a color for the background. To choose a different color, right click on the color square and 

choose the desired command for selecting a new color.
Direction Set the size for the background. 
Lock Press to set four directions equally. Unlock to change each direction independently.
Preview window Shows an example of how the background, border, and shadow will appear.
Add Add the settings for this dialog box to the My Gallery.

           Color Picker Menu  





On-line Registration
Opens Ulead Systems Registration Wizard which allows you
register your products through our web page or the          e-
mail internet connection. Registering your software ensures 
periodic updates of all our products.

Color Picker Menu
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The Color Picker menu allows you to change the foreground
and background colors for use when painting or filling 
images. Click below for more information.
      Ulead Color Picker   
    Windows Color Picker
    Eyedropper
    Foreground / Background Color
    Swap F/B Color
    Reset
    Quick Pick Squares
    Gradient Fill
    Texture Fill 

Click Menu commands on the left for help on other menus.

Quick Pick Squares
Choose from a selection of 32 popular colors.

Reset
Restores the color squares to their default colors.

Swap F/B Color
Switches the foreground and background color settings.

Foreground / Background Color
Reminds you of the current settings and allows you to 
quickly choose them.

Eyedropper
Opens the Use Eyedropper dialog box so you can select a 
color from the current image.



Windows Color Picker
Opens the standard Windows color palette for choosing a 
color.

Ulead Color Picker
Opens the Ulead Color Picker dialog box offering colors and
special options for choosing a color.

Gradient Fill
Opens a dialog box where you can specify the starting and 
ending colors for a gradient fill in a 3D object and how the 
transition progresses.

Note: This menu command only appears when you click the
Color Square in the Path or Text Attribute toolbar or Options 
dialog box.

Texture Fill
Opens the Texture Library dialog box where you can choose
a texture to fill a 3D object with.

Note: This menu command only appears when you click the
Color Square in the Path or Text Attribute toolbar or Options 
dialog box.

Adding third party plug-ins
1. Install the plug-ins according to their documentation. Make sure you note the name and path for the folder where 

you install them.
2. Make a backup copy of your ULEAD32 configuration file (ULEAD32.INI)    located in your default Windows folder. 

(Note: The .INI extension may not appear in Windows Explorer.)
3. Open the original ULEAD32.INI file and create a PLUG IN section in it if it does not already exist by adding the 

following:
[PLUG IN]

4. For each folder containing plug-ins add a line as follows:
PLUGINDIRn = drive:\foldername

where n changes sequentially, starting with 1 for the first folder.
           Example  
           If you can't find ULEAD32.INI   

           General Procedures Contents   
           Configuring Procedures Contents   



If you can't find ULEAD32.INI in your Windows folder, do the following steps:
1. From your Windows Explorer, choose "Options" from the View menu.
2. From the Options dialog box, clear the "Hide MS-DOS file extension for file types that are registered" option to 

display the .INI extension.
3. Click OK when done.



Preferences dialog box
    PhotoImpact
    Associate

    Memory

    Display

    Photo CD

The PhotoImpact tab enables and disables PhotoImpact features affecting overall program performance.
Measurement unit Choose how to determine new image sizes and display them in the workspace. 
Enable undo Check to enable the Undo command in the File menu. Then enter the number of commands 

PhotoImpact should retain for undoing.
Number of recently opened files Specify the maximum number of files to show at the bottom of the File 

Menu.
           Generation quality    Choose Best for PhotoImpact to calculate changes to images when applying certain 

transform tools or image filters and effects. Choose Fair for fastest operation.
Highlight inactive selections and objects Check to show borders around selections and objects even 

when they are not active. This may help you to find objects more easily and keep track of your image better.
 Display a confirmation message when saving Check to have PhotoImpact warn you when saving images

where data may be lost during the save.
Display quick samples Check you want quick visual advice for applying an effect or filter instead of directly 

setting the options. Leave unchecked to directly open the filter/effect dialog box for fine control over the settings. 
Note: You may still access the filter/effect dialog boxes from the visual selection box.

Show marquees of active objects Check to display the outline boundaries of each of the selected objects.



Generation quality for 3D objects
For fastest performance when creating 3D objects, change 
your "Preferences: Generation quality" settings in the File 
Menu to fair or good. This can increase rendering speed by 
as much as ten times.

Adding text
1. Select the Text tool.    
2. Click where you want to add the text.
3. Enter the desired text in the Text Entry box.
4. Select a font, size and style from the Attribute toolbar.
5. Click the color square to access the Ulead Color Picker to change the text color. (Right click for the Color 
Picker menu.)
6. Click OK.
Note: To edit existing text, select the Text tool and double-click on the text object you want to change.

           Switching tools   
           Curving text   
           Transforming Procedures Contents   



Import/Export
Shows a submenu containing Adobe Photoshop Plug in 
modules for adding additional file formats and opening or 
saving methods.

Combine to Single Object
Creates a single object from all currently selected objects. 
This is similar to the Group command except that combined 
objects can only be split if the Undo command is available.

Gradient Fill dialog box
Allows you to choose the starting and ending colors to fill a path object with and how the gradient should progress.

Fill type Click the button that illustrates the desired direction for the fill.
Color Squares Click to select the desired starting and ending colors for the fill.
Transpose button Click to switch the starting and ending colors.






